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Introduction to D50 Documentation

Introduction D50 documentation provides complete detailed instructions on how to install, test, and 
commission a D50. This documentation complies with all requirements in Telcordia 
Technologies Technical Reference documents GR-454 Generic Requirements for 
Supplier-Provided Documentation, and IP-10260 Standards for Task Oriented 
Practices (TOPS).

Target Audience D50 documentation volumes are written at different levels of detail based on the 
reader’s needs. Below is a list of the various volumes and the intended target audience 
for each.

Information 
Mapping Style

All documents are written in Information Mapping style, which presents information in 
small units or blocks. Each information block is identified by a subject label in the left 
margin and is separated from the next information block by a horizontal line. Subject 
labels make it easy for the reader to scan the document and to find information on a 
specific subject.

Each DLP lists the required equipment and tools to perform the job, and provides step 
by step instructions (supported by graphics where appropriate) to help the reader 
perform each task.

Number Title Target Audience

Volume 1 General Information Anyone with a need to understand more 
about the D50 System and planning 
requirements.

Volume 2 Installation Installation and Testing Technicians, and 
Engineers (Detailed Level Procedures, or 
DLPs).

Volume 3 Commissioning Testing Technicians and Engineers (DLPs).

Volume 4 Provisioning Provisioning Technicians and Engineers 
(DLPs).

Volume 5 Maintenance and 
Testing

Maintenance and Testing Technicians and 
Engineers (DLPs).

Volume 6 Craft Terminal Testing and Installation Technicians and 
Engineers (Reference manual for Craft 
Terminal).
Release 11.0 Page iii
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SECTION 1O VERVIEW AND INSTALLATION

Chapter 1
Craft Terminal Overview

Introduction Craft Terminal is a stand-alone craft interface application which operates on a desktop 
personal computer, laptop, or notebook using the Microsoft® Windows NT® or the 
Windows 2000® operating system. Craft Terminal communicates directly with the D50, 
using Simple Network Management Protocol (SNMP) through either a serial 
communications port using Point-to-Point Protocol (PPP) or a 10BaseT Ethernet 
connection using IP protocol.

Craft Terminal communicates over the serial or Ethernet connection to the Network 
Management Processor (NMP) card.

References for 
Craft Terminal

The Craft Terminal document includes the following external references:

Table 1-1: References

Reference 
Volume

Functional 
Area(s)

Referencing 
Object(s) Reference Detail

Commissioning Installation, 
Testing and 
Commissioning

n/a Section 5—Commissioning, 
Chapter 2—“Using Craft 
Terminal for 
Commissioning,” and 
Chapter 3—“Craft Terminal 
Direct Ethernet Connection”

Maintenance 
and Testing

Alarm 
Conditions

MCS, LCS; 
Trunk, MLA, 
Broadband 
Tributary, 
LSM, and Line 
Cards

Section 1—System 
Monitoring, 
Chapter 2—“Conditions”

Maintenance 
and Testing

System 
Performance 
Monitoring

MLA2, 
MLAT1, 
MLAT3,  
LSMT1, 
LSMT3, and 
Line Cards

Section 1—System 
Monitoring, 
Chapter 3—“Performance 
Monitoring”
Release 11.0 Page 1-1
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Volume 6, Section 1: Overview and Installation
When to Use Craft Terminal
When to Use 
Craft Terminal

Craft Terminal is used to perform the following functions:
� Installation of a D50.
� Troubleshooting of a D50.

For additional information on commissioning procedures using Craft Terminal, see the 
volume titled Commissioning.

For details on troubleshooting procedures using Craft Terminal, see the volume titled 
Maintenance and Testing, Section 1—System Monitoring, Chapter 2—“Conditions.”

For Craft Terminal software installation and execution troubleshooting tips, see 
Appendix A—“Craft Terminal Troubleshooting Tips,” page 7-1.

Compatibility A lower version of Craft Terminal (Release 10.0 and lower) can be loaded on the same 
platform with Craft Terminal Release 11.0 to manage a previous release of D50 system 
software. The lower version of Craft Terminal must be loaded into a different directory 
from the Craft Terminal Release 11.0 software.

Maintenance 
and Testing

Card 
Replacement 
Procedures

MCS and LCS Section 2—Card 
Replacement, 
Chapter 1—“Replace 
Identical Cards,” page 2-1, 
OR Chapter 2—“Replace an 
Existing Card with Different 
Card Type,” page 2-5, OR 
Chapter 3—“Correct an 
Attribute Mismatch 
Condition,” page 2-19

Provisioning Provisioning 
Parameters, 
Ranges, and 
Values

Trunk, MLA, 
Broadband 
Tributary, and 
Line Cards

Section 4—Appendices, 
Appendix A—“Provisioning 
Parameters”

Provisioning General 
Provisioning 
Concepts

Trunk and Line 
Cards

Section 1—Provisioning 
Concepts (See Chapter for 
specific referencing object)

Table 1-1: References (continued)

Reference 
Volume

Functional 
Area(s)

Referencing 
Object(s)

Reference Detail
Page 1-2 Release 11.0
© 2002 Nokia. Proprietary Data.



Chapter 1 Craft Terminal Overview
Serial Port Connections
D50 System 
Installation

� When you initially install a D50 system, use Craft Terminal to commission the D50 
system.

Every effort is made to ensure that the D50 system is a reliable, ready-to-run product. 
However, commissioning of the D50 system is required to verify the following system 
functions:
� The D50 Master Control Shelf (MCS) must be able to communicate with all the 

parts of the multiplexer.
� All cards must operate correctly.

After you complete commissioning of the D50 system, the Network Operations Center 
(NOC) will take on the primary responsibility for managing the system.

Diagnosing D50 
Communication 
Problems

Craft Terminal is the appropriate tool for troubleshooting a D50 system problem in 
certain situations, for example:
� The Local Area Network (LAN) connection fails, and a serial connection is needed.
� A technician is trying to troubleshoot a problem in the field.
� The D50 system loses its IP address, losing the ability to communicate over the 

LAN.
� A network element with the same IP address as the D50 system is inadvertently 

added to the LAN.
� The D50 system’s LAN transceiver fails.

Installing Craft 
Terminal

Craft Terminal connects to the MCS in two distinct ways: either through a serial port 
connection, or an Ethernet connection. The subsequent chapters provide the necessary 
instructions for installing Craft Terminal on a computer running Microsoft 
Windows NT or Windows 2000 with a serial port connection.

Serial Port 
Connections

The followig procedure describes the installation instructions required for a serial 
connection.
� Set serial communications port parameters.
� Add a modem.
� Windows NT only:

– Install Remote Access Service (RAS).
– Install Simple Network Management Protocol (SNMP) services.
– Install Dial-Up networking.

Install the Craft Terminal application software.

Note: Procedure tables that outline the installation process in detail for both the 
serial port and Ethernet connection can be found in the volume, Commissioning, 
Section 5—Commissioning, Chapter 2—“Using Craft Terminal for 
Commissioning,” and Chapter 3—“Craft Terminal Direct Ethernet Connection,”  
respectively.

Before you begin installing Craft Terminal software, Microsoft Windows NT or 
Windows 2000 should be installed on your computer. For additional information about 
Release 11.0 Page 1-3
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Check Port Settings on Windows NT
completing any options in the Setup and Protocols windows, see your Microsoft 
Windows documentation.

Note: Setup and configuration for earlier versions of Microsoft Windows NT may 
differ from the descriptions provided in the Craft Terminal documentation.

Before you begin installation, make sure that you have the following components:

Your computer must meet the following minimum requirements:

Check Port 
Settings on 
Windows NT

Before proceeding with installation, use the following steps to check the serial 
communication port settings:

1 On the Start menu on the taskbar, select Settings, then select Control Panel.
2 In the Control Panel window, click the Ports icon to display the Ports dialog box.

Table 1-2: Before You Begin Installation

Installation Components for Serial Connection

� Craft Terminal software installation media (CD-ROM).
� Serial cable for connecting your computer to the MCS (if connect-

ing serially).
� Serial cable adapter (depending on the connection interface).

Table 1-3: Minimum System Requirements

Craft Terminal System

� 486 or Pentium computer capable of running Microsoft Windows 
NT or Windows 2000 (Pentium recommended).

� 6 MB of available hard disk space.
� 32 MB of available system memory (RAM).
� CD-ROM Drive.
� Microsoft Windows NT 4.0 or Microsoft Windows 2000 operating 

system software.
� Pointing device (mouse).

Figure 1-1: Control Panel, Ports Icon
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Check Port Settings on Windows NT
3 Use COM1 to connect to Craft Terminal.

4 Click the Settings button to display the port Settings for COM# dialog box.

5 Verify the parameters are set as follows:
– Baud rate set to 38400.
– Data bits set to 8.
– Parity set to none.
– Stops bits set to 1.
– Flow control set to none.
Click the OK button to return to the Windows desktop.

Figure 1-2: (Serial Communications) Ports Dialog Box

Figure 1-3: Port Settings Dialog Box
Release 11.0 Page 1-5
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Check Port 
Settings on 
Windows 2000

Before proceeding with installation, use the following steps to check the serial 
communication port settings:

1 On the Start menu on the taskbar, select Settings, then select Control Panel. Select 
the Administrative Tools icon to display the Administrative Tools window.

2 In the Administrative Tools window, click the Computer Management icon to dis-
play the Computer Management dialog box.

3 Select Device Manager from the left pane, and then expand the Ports menu from 
the right pane by clicking Ports.

Figure 1-4: Administrative Tools Icon

Figure 1-5: Computer Management Icon

Figure 1-6: (Serial Communications) Ports Dialog Box
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Check Port Settings on Windows 2000
4 Double-click COM1 to display the COM port properties.

5 Verify the parameters are set as follows:
– Baud rate set to 38400.
– Data bits set to 8.
– Parity set to none.
– Stops bits set to 1.
– Flow control set to none.
Click the OK button to return to the Windows desktop.

Figure 1-7: (Serial Communications) Ports Dialog Box
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SECTION 1OVERVIEW AND INSTALLATION

Chapter 2
Add a Modem

Introduction When using a serial connection, Craft Terminal communicates with the D50 using 
Point-to-Point Protocol (PPP). For Craft Terminal to communicate with the D50 
through a serial port connection, you must set certain parameters in the Modems 
control panel, and also set up Dial-Up Networking.

Note: Dial-Up Networking requires that a modem be configured, although you will 
not actually use a modem to communicate with the D50.

Depending on how Windows NT or Windows 2000 is configured on your workstation, 
the windows and dialog boxes that display during installation may vary from those 
described in the following installation sections. Installing a modem in Windows 2000 is 
very similar to installing a modem in Windows NT1. See your Windows documentation 
for more details.

Procedure On the taskbar, click the Start button (usually located at the lower left corner of your 
PC screen). Point to Settings, click Control Panel, and double-click the Modems icon.

1 Any significant differences between installing a modem in Windows NT and installing a modem in 
Windows 2000 are noted in this procedure.

Figure 1-8: Modems Icon

Windows
NT

Windows
2000
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Procedure
In Windows 2000 only, the Dialing Rules tab on the Phone and Modem Options dialog 
box is displayed.

1 Click New to create a new location or Edit to change an existing location.

2 Click OK to continue.

Figure 1-9: Install New Modem Dialog Box
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Procedure
The Modems tab on the Phone and Modem Options dialog box is displayed.

Note: If there is no modem installed on the PC, this procedure will skip to 
Figure 1-11:  Install New Modem Dialog Box.  

Click Add.

Figure 1-10: Modem Properties Dialog Box

Windows
NT

Windows
2000
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Procedure
The Install New Modem dialog box appears.

3 Select the Don’t detect my modem ... check box.

4 Click the Next button.

The second Install New Modem dialog box appears.

5 In the Manufacturers list box, select Standard Modem Types.

6 In the Models list box, select Dial-Up Networking Serial Cable between 2 PCs.

7 Click the Next button.

Figure 1-11: Install New Modem Dialog Box

Figure 1-12: Modem Selection View
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Procedure
The third Install New Modem dialog box appears.

8 Click the Selected Ports radio button.

9 Select a COM port (dependent upon availability of serial ports on your computer).

10 Click the Next button.

The Install New Modem dialog box displays a message indicating that the modem has 
been set up successfully.

11 Click the Finish button.

Figure 1-13: Com Port Selection View

Figure 1-14: Final View
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Procedure
After the modem/serial connection has been set up, you must configure the connection 
speed rate and preferences.

12 There may be more than one modem listed. Select the Serial Cable between 2 PCs 
dialup adapter.

13 Click the Properties button.

Figure 1-15: Modem Properties Dialog Box
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Procedure
The Dial-Up Networking Serial Cable… dialog box will appear, with the General tab 
page on top.From the Maximum Speed list, select 38400.

14 In Windows NT, click the Connection tab. 

15 In Windows 2000, click the Advanced tab, click the Change Default Preferences 
button, then click the Advanced tab.

Figure 1-16: General Tab, Properties Selection View

Windows
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Windows
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Procedure
Clicking the Connection tab displays the following tab page, where you can set the 
following parameters:

From the Data bits list, select 8.

16 From the Parity list, select None.

17 From the Stop bits list, select 1.

After setting the parameters, click the OK button.

Note: The modem installation procedure is complete for Windows 2000. The next 
two dialog boxes will appear in Windows NT if RAS (Remote Access Service) is 
currently installed.

The Modems Properties dialog box displays.

Note: The next two dialog boxes will appear only if RAS (Remote Access Service) 
is currently installed.

Figure 1-17: Connection Tab
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Procedure
After you have set up the dial-up networking, the Modem Setup dialog box will 
appear. Click the Yes button.

18  Click the Close button to finish.

The Remote Access Setup dialog box will appear.

19 Click the Continue button.

You can now install RAS and Simple Network Management Protocol (SNMP) Service.

Figure 1-18: Modem Setup, Confirm Configuration Message

Figure 1-19: Remote Access Setup Dialog Box
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Chapter 3
Add Remote Access Service (RAS)

Introduction If Remote Access Service (RAS) and Simple Network Management Protocol (SNMP) 
services are already installed, you can go to the chapter on installing SNMP and set the 
properties, then go to the chapter on Adding Dial-Up Networking.

Note: If using an Ethernet connection only, RAS does not need to be installed.

Installing RAS in 
Windows NT

From the taskbar, click the Start button (located at the lower left corner of your PC 
screen). Point to Settings, click Control Panel, and double-click the Network icon.

In Windows 2000, a Welcome screen is displayed. Click Next to continue.

Figure 1-20: Network Icon
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Installing RAS in Windows NT
The Network dialog box appears. Select the Services tab.

1 Click the Add button.

Figure 1-21: Network Dialog Box, Services Tab
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Installing RAS in Windows NT
The Select Network Service dialog box appears.

2 From the Network Service list, select Remote Access Service.

3 Click the OK button.

The Windows NT Setup dialog box appears.

4 A default path will be shown. Enter a new path if necessary.

Note: You may need to insert the Windows NT operating system CD-ROM if the 
RAS service drivers are not already on the system.

5 Click the Continue button.

Figure 1-22: Select Network Service Dialog Box

Figure 1-23: Windows NT Setup Message
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Installing RAS in Windows NT
The Add RAS Device dialog box appears.

6 From the RAS Capable Devices list, select the device that you configured in the 
Add a Modem section.

7 Click the OK button.

The Remote Access Setup dialog box appears. Select the port/device/type that you 
configured in the Add a Modem section, then click the Continue button.

Figure 1-24: Add RAS Device Dialog Box
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Installing RAS in Windows 2000
Installing RAS in 
Windows 2000

Remote Access Service (RAS) is installed through the Network Connection Wizard.

From the task bar, click Start > Programs > Accessories > Communications > 
Network and Dial-up Connections.

1 Select Make New Connection.

Figure 1-25: Network and Dial-up Connections Window
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Installing RAS in Windows 2000
The Network Connection Wizard dialog box appears.

2 Select the Connect directly to another computer option, then click Next.

The second Network Connection Wizard dialog box appears.

Figure 1-26: Network and Dial-up Connections Window

Figure 1-27: Network and Dial-up Connections Window
Page 1-24 Release 11.0
© 2002 Nokia. Proprietary Data.



Chapter 3 Add Remote Access Service (RAS)
Installing RAS in Windows 2000
3 Select the Guest option, and then click Next.

The third Network Connection Wizard dialog box appears.

4 Select Communications cable between two computers (COM1) from the pull 
down list, then select Next.

Note: If the Communications cable between two computers (COM1) device is 
not listed, refer to Chapter 2—“Add a Modem,” page 1-9 for instructions on how to 
create it.

Figure 1-28: Network and Dial-up Connections Window
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Installing RAS in Windows 2000
The fourth Network Connection Wizard dialog box appears.

5 Select the For all users option, and then click Next.

The final Network Connection Wizard dialog box appears.

Figure 1-29: Network and Dial-up Connections Window

Figure 1-30: Network and Dial-up Connections Window
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Installing RAS in Windows 2000
6 Enter Craft Terminal into the text box, and then click Finish.

RAS is now installed on the system, and the connection is created for Craft Terminal. 
See Chapter 5—“Add Dial-Up Networking,” page 1-37 for instructions on how to set 
up this connection.
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© 2002 Nokia. Proprietary Data.



Volume 6, Section 1: Overview and Installation
Installing RAS in Windows 2000
Page 1-28 Release 11.0
© 2002 Nokia. Proprietary Data.



SECTION 1OVERVIEW AND INSTALLATION

Chapter 4
Install SNMP

Installing SNMP 
in Windows NT

If Simple Network Management Protocol (SNMP) Services appears in the Services tab 
page (as shown in the following example), then SNMP is already installed. You must 
still check the SNMP Properties to ensure they are set correctly. See the SNMP 
Properties dialog box, Agent tab under the Procedure heading in this chapter. Click the 
OK button, then go to the chapter on Dial-Up Networking. 

If the Network Services list does not include SNMP Services, install them now:

1 Click the Add button to install SNMP services.

Figure 1-31: Network Dialog Box, Services Tab
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Installing SNMP in Windows NT
The Select Network Service dialog box appears, which includes a list of available 
network services.

2 From the Network Service list, select SNMP Service.

3 Click the OK button.

Figure 1-32: Select Network Service Dialog Box
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Installing SNMP in Windows NT
The Windows NT Setup dialog box displays.

4 A default path will be shown. Enter a new path if necessary.

Note: You may need to insert the Windows NT operating system CD-ROM if the 
SNMP service drivers are not already on the system.

5 Click the Continue button.

Figure 1-33: Windows NT Setup Dialog Box
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Installing SNMP in Windows NT
The Microsoft SNMP Properties dialog box appears, with the Agent tab on top.

6 Both the Contact and Location boxes can be left blank.

7 In the Service group, select the Applications, Internet, and End-to-End check 
boxes.

8 Click the OK button.

9 After the Network dialog box reappears, click the Close button.

Note: The OK button shown above will be replaced by a Close button.

Figure 1-34: SNMP Properties Dialog Box, Agent Tab
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Installing SNMP in Windows NT
A message displays prompting you to reboot your computer so that the settings will 
take effect.

10 Click the Yes button to reboot immediately.

A Setup status message displays showing the progress as the services are set up. When 
your computer finishes rebooting, RAS and SNMP Services installation is complete.

Figure 1-35: RAS/SNMP Services Setup message
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Installing SNMP in Windows 2000
Installing SNMP 
in Windows 
2000

Follow the steps below to install SNMP in Windows 2000.

1 To install Simple Network Management Protocol (SNMP) Services in Windows 
2000, click Start > Programs > Accessories > Communications > Network and 
Dial-up Connections.

2 Click Add Network Components from the left side of the window. If there are no 
options shown on the left side of the window, an icon is probably selected. Click in 
an empty area of the window to de-select the icon.

Figure 1-36: Network and Dial-up Connections Window
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Installing SNMP in Windows 2000
The Windows Optional Networking Components Wizard appears.

3 Select the Management and Monitoring Tools checkbox, then click Details.

The Management and Monitoring Tools dialog box appears.

4 Select the Simple Network Management Protocol check box, then click OK.

SNMP services will be active after the system is restarted.

Figure 1-37: Windows Optional Networking Components Wizard

Figure 1-38: Management and Monitoring Tools Dialog Box
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Chapter 5
Add Dial-Up Networking

Adding Dialup 
Networking for 
Windows NT

This chapter describes how to add dial-up networking for a serial connection. Dial-up 
networking provides a simple method for setting up connections in Microsoft Windows 
NT and Windows 2000.

Note: In Windows 2000, Dial-Up Networking is installed during the RAS 
installation procedure shown in Installing RAS in Windows 2000, page 1-23. To 
configure the Dial-Up Networking service in Windows 2000, see Configuring 
Dialup Networking For Windows 2000, page 1-46.

On the taskbar, click the Start > Programs > Accessories > Dial-Up Networking.

If the phonebook is empty, or if this is the first time opening this utility, a Dial-Up 
Networking message displays indicating that the phonebook is empty. Click the OK 
button and skip to the New Phone Book Entry Wizard screen on page 1-39.

Figure 1-39: Dial-Up Networking Message
Release 11.0 Page 1-37
© 2002 Nokia. Proprietary Data.



Volume 6, Section 1: Overview and Installation
Adding Dialup Networking for Windows NT
The Dial-Up Networking dialog box appears.

1 Click the New button.

Figure 1-40: Dial-Up Networking Dialog Box
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Adding Dialup Networking for Windows NT
The New Phonebook Entry Wizard dialog box appears.

2 You should use the single-screen method instead of the Wizard by clicking the I 
know all about phonebook entries... check box. After this option is selected, the 
Wizard will not appear when making subsequent entries.

3 Click Finish.

Figure 1-41: New Phonebook Entry Wizard Dialog Box
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Adding Dialup Networking for Windows NT
The New Phonebook Entry dialog box appears, with the Basic tab page on top.

4 In the Entry name box, enter DiamondCraft.

5 From the Dial Using list, select Dial-Up Networking Serial Cable between 2 PCs 
(COM1).

6 Click the Configure button.

Figure 1-42: New Phonebook Entry Dialog Box, Basic Tab
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Adding Dialup Networking for Windows NT
The Modem Configuration dialog box appears.

7 Select 38400 from the Initial speed list.

8 Make sure that all options in the Hardware Features list are disabled (as in the fig-
ure above).

9 Click the OK button.

Figure 1-43: Modem Configuration Dialog Box
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Adding Dialup Networking for Windows NT
The Modem configuration dialog box disappears and the New Phonebook Entry dialog 
box becomes active again. Click the Server tab.

10 In the Dial-up server type list, select PPP. 

11 In the Network protocols group, select TCP/IP and disable all the following 
options:
– IPX/SPX compatible.
– NetBEUI.
– Enable software compression.
– Enable PPP LCP extensions.

12 Click the TCP/IP Settings button.

Figure 1-44: New Phonebook Entry Dialog Box, Server Tab
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Adding Dialup Networking for Windows NT
The PPP TCP/IP Settings dialog box appears.

13 Enable the following options:
– Server assigned IP address.
– Server assigned name server addresses.
– Use IP header compression.

14 Make sure the Use default gateway on remote network option is disabled.

15 Click the OK button.

Figure 1-45: PPP TCP/IP Settings Dialog Box
Release 11.0 Page 1-43
© 2002 Nokia. Proprietary Data.



Volume 6, Section 1: Overview and Installation
Adding Dialup Networking for Windows NT
The PPP TCP/IP Settings dialog box disappears and the New Phonebook Entry dialog 
box becomes active again. Click the Security tab.

16 In the Authentication and encryption policy group, select the Accept any 
authentication... option.

17 Click the OK button.

Figure 1-46: New Phonebook Entry Dialog Box, Security Tab
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Adding Dialup Networking for Windows NT
The Dial-Up Networking dialog box appears.

18 Click the Close button.

The setup for Dial-Up networking is complete.

Figure 1-47: Dial-Up Networking Dialog Box, Confirmation View
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Configuring 
Dialup 
Networking For 
Windows 2000

From the task bar, click Start > Programs > Accessories > Communications > 
Network and Dial-up Connections.

1 Double-click the DiamondCraft icon.

The Connect DiamondCraft window appears.

2 Click Properties.

Note: The User Name and Password fields should be left blank.

Figure 1-48: Network and Dial-up Connections Dialog Box

Figure 1-49: Connect DiamondCraft Dialog Box
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Configuring Dialup Networking For Windows 2000
The DiamondCraft window appears showing the General tab.

3 Select the Communications cable between two computers (COM1) device from the 
drop down menu.

4 Click Configure to set the parameters for this device.

Figure 1-50: DiamondCraft Properties, General Tab
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Configuring Dialup Networking For Windows 2000
The Modem Configuration dialog box appears. 

5 From the Maximum speed (bps) pull down menu, select 38400.

6 Click OK.

Figure 1-51: Modem Configuration Dialog Box
Page 1-48 Release 11.0
© 2002 Nokia. Proprietary Data.



Chapter 5 Add Dial-Up Networking
Configuring Dialup Networking For Windows 2000
From the DiamondCraft Properties dialog box (Figure 1-50:  DiamondCraft Properties, 
General Tab) select the Networking tab. 

7 Select Internet Protocol (TCP/IP), then click Properties.

Figure 1-52: DiamondCraft Properties, Networking Tab
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Configuring Dialup Networking For Windows 2000
The Internet Protocol (TCP/IP) Properties dialog box appears.

8 Select Obtain an IP address automatically.

9 Select Obtain DNS server address automatically.

Figure 1-53: Internet Protocol (TCP/IP) Properties Dialog Box
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Configuring Dialup Networking For Windows 2000
10 Click the Advanced button to display the Advanced TCP/IP Settings dialog box, 
General tab.

11 Deselect Use default Gateway on remote network.

12 Select Use IP header compression.

13 Click OK in the Advanced TCP/IP Settings dialog box.

14 Click OK in the Internet Protocol (TCP/IP) Properties dialog box.

Figure 1-54: Internet Protocol (TCP/IP) Properties Dialog Box
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From the DiamondCraft Properties dialog box (Figure 1-50:  DiamondCraft Properties, 
General Tab) select the Security tab. 

15 Select the Typical (recommended settings) option.

16 From the Validate my identity pull-down menu, select Allow unsecured password.

17 Click OK.

The DiamondCraft connection is now configured for use with Craft Terminal.

Figure 1-55: DiamondCraft Properties, Security Tab
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Chapter 6
Installing/Removing Craft Terminal Software

Introduction Craft Terminal is a standard Microsoft Windows application. Use the procedures in this 
chapter to install Craft Terminal software on a PC (desktop, laptop or notebook), and to 
remove the software if necessary.

As for any installation, ensure that there are no software applications running before 
beginning the installation process.

Installing Craft 
Terminal 
Software

Insert the Craft Terminal installation CD into the CD drive.

On the taskbar, click the Start button (usually located at the lower left corner of your 
PC screen). From the Start menu, select Run. The Run dialog box appears.

Type the path name or Browse for the Craft Terminal Setup.exe file, then click the OK 
button.There are three installation packages included. The three installation packages 
are preset to a privilege level:
� Full-write installation. This version will install Craft Terminal with the ability to 

modify all system initialization settings or provision any cards in the MCS and LCS.
� Read-only installation. This version will install Craft Terminal with no write 

access to the system
� Line Card Write Installation. This version will install Craft Terminal with access 

to only write to the line cards, but without access to modify the system initialization 
settings or provision any cards in the MCS.

Figure 1-56: Run (Application) Dialog Box
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Installing Craft Terminal Software
The InstallShield Wizard dialog box appears, providing instructions for completing the 
setup process. If installation fails before completion, start the installation process over 
from the beginning. If the PC has previously had a version of Craft Terminal installed 
on it, the Setup program will require you to delete the old version first. Refer to 
Removing Craft Terminal Software, page 1-58.

The Setup dialog box will be displayed.

Click Next to continue.

Figure 1-57: InstallShield Wizard

Figure 1-58: Setup Dialog Box
Page 1-54 Release 11.0
© 2002 Nokia. Proprietary Data.



Chapter 6 Installing/Removing Craft Terminal Software
Installing Craft Terminal Software
A default destination folder will be displayed. Click Browse to choose a different 
destination. Click Next to continue.

Figure 1-59: Setup Dialog Box Destination Folder
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Installing Craft Terminal Software
 

A Setup status message displays the progress as Craft Terminal is installed on your 
machine. When Craft Terminal is completely loaded, the InstallShield Wizard 
Complete dialog box will be displayed.

Figure 1-60: Setup Dialog Box Progress Guage
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Installing Craft Terminal Software
Click Finish to close the Setup application.

Craft Terminal software is now installed to the specified drive. The installation 
automatically adds Craft Terminal to the Windows programs list. To start Craft 
Terminal, click Start > Programs > Craft Terminal.

You can also install the Craft Terminal program icon on your desktop. Use the 
following procedure.

1 Open Windows Explorer and navigate to the Craft Terminal folder.

2 Click on the Setup.exe file, hold down the left mouse button, and drag the file to the 
Windows desktop.
Windows creates a shortcut icon for Craft Terminal. You can now start Craft Termi-
nal by double-clicking the Shortcut to Craft Terminal icon.

Figure 1-61: InstallShield Wizard Complete Dialog Box

Figure 1-62: Craft Terminal Icon
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Removing Craft Terminal Software
Note: If you are using Windows NT, you must reinstall any Windows NT service 
packs that were installed at the time Craft Terminal was installed. For details, see 
your Windows documentation. For troubleshooting tips, see the volume titled 
Commissioning.

Removing Craft 
Terminal 
Software

If Craft Terminal exists on the system, the Craft Terminal setup program will prompt 
you to remove it before continuing. On the taskbar, click the Start button (usually 
located at the lower left corner of your PC screen). From the Start menu, select Run. 
The Run dialog box appears.

Type the path name for the Craft Terminal Setup.exe file as shown in Figure 1-56:  Run 
(Application) Dialog Box, page 1-53, then click the OK button.

The InstallShield Wizard appears.

Ensure that the Remove option is selected, and then click Next.

You will be prompted to confirm your choice in the dialog box below.

Click OK.

Figure 1-63: InstallShield Wizard

Figure 1-64: Confirm File Deletion Dialog Box
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Removing Craft Terminal Software
The InstallShield Wizard appears.

The Maintenance Complete window appears when the procedure is complete.

Click Finish.

Figure 1-65: Install Shield Setup Status Dialog Box

Figure 1-66: InstallShield Maintenance Complete Dialog Box
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Serial Port Connection
Serial Port 
Connection

The D50 Master Control Shelf (MCS) includes a serial port connection (J2) located on 
the left side of the MCS. This port corresponds to the Network Management Processor 
(NMP) slot in the MCS. For details on how to connect Craft Terminal to the D50 
system through a serial port, see the volume titled Commissioning.
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SECTION 2CRAFT TERMINAL USER INTERFACE

Chapter 1
General Description of the User Interface

Introduction Craft Terminal provides a standard Windows Graphical User Interface (GUI) and 
Simple Network Management Protocol (SNMP) to provide the user with an interface to 
the D50.

User Interface 
Object Naming 
Convention

The following table provides you with the ability to map the Craft Terminal user 
interface object names to the D50 equipment names.

Table 2-1: D50 Equipment/Object Naming Conventions

D50 Equipment Names  User Interface Names

MCS - Master Control Shelf MCS

LCS - Line Card Shelf LCS

RLCS - Remote Line Card Shelf LCS

D50 RAM - Remote Access Module LCS

NMP - Network Management Processor NMP

MCP - Master Control Processor MCP

DS3 Trunk Card DS3T

DS3T2 Trunk Card DS3T2

DS3TQ Trunk Card DS3TQ

OC3 Trunk Card OC3T

OC3T2 Trunk Card OC3T2

OC3T2M Trunk Card OC3T2

OC3T2L Trunk Card OC3T2

OC3TQS Trunk Card OC3TQ

OC3TQL Trunk Card OC3TQ

OC3TQM Trunk Card OC3TQ

MLA2 - Master Line Card Adapter MLA2

MLA2S - Master Line Card Adapter MLA2
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Objects in the Craft Terminal GUI
Objects in the 
Craft Terminal 
GUI

The Craft Terminal GUI consists of various objects that represent the D50’s physical 
components on the screen. Each component is represented as an object in the D50 GUI. 
For example, the Master Control Shelf (MCS), Line Card Shelf (LCS), and individual 
cards look like the physical components of a D50 system.

The following types of objects are included in the Craft Terminal user interface.

D50 Node. Allows you to work with an entire D50 system and its support data. For 
example, the name of the node and the save function looks like the physical D50, 
showing an MCS and LCSs mounted in a rack.

Shelf. Allows you to work with basic configuration and status information for the MCS 
or an LCS. In the interface, a shelf looks like a physical shelf, showing all the card slots 
and representations of the cards provisioned in the shelf.

Card. Allows you to work with configuration and status information for the card. The 
card interfaces consist of sets of tab pages, and include address information at the top of 
the display.

MLA2L - Master Line Card Adapter MLA2

MLAT3 - Master Line Card Adapter MLAT3

MLAT1 - Master Line Card Adapter MLAT1

OC3L - Broadband Tributary Card OC3L

DS3L - Broadband Tributary Card DS3L

LSM - Line Card Shelf Multiplexer LSM

LSM2 - Line Card Shelf Multiplexer LSM2

LSMT3 - Line Card Shelf Multiplexer LSMT3

LSMT1 - Line Card Shelf Multiplexer LSMT1

DS1 - Line Card DS1

DMT8a-3 - Line Card DMT8A3

DMT8a-4 - Line Card DMT8A4

SDSL8 - Line Card SDSL

SDSL8+ - Line Card SDSL8+

SHDSL8 - Line card SHDSL

IDSL8 - Line Card IDSL

Table 2-1: D50 Equipment/Object Naming Conventions (continued)

D50 Equipment Names  User Interface Names
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Objects in the Craft Terminal GUI
Ports. Allows you to work with configuration, status, and performance monitoring 
information for individual ports. Port data is separate from card data. The port 
interfaces consist of sets of tab pages.

Connection. Allows you to work with status and configuration information for a 
virtual connection setup between a line card and the trunk protection group. The 
connection interface includes sets of tab pages as well as dialog boxes.

Link. Allows you to work with status and configuration information for the Link A and 
Link Z that make up a connection. Link A is always on a line card and Link Z is always 
on a trunk or tributary card. The link interface consists of a set of dialog boxes.

You can also display the following optional items:
� Toolbar. Located directly below the menu bar, provides quick access to commonly 

used system functions.
� Status bar. Located at the bottom of the window, displays system status messages.
� Error bar. Located above the Status bar, displays system error messages.

Craft Terminal provides some control over the components that display in the Craft 
Terminal window, and the appearance of those components. You can perform the 
following actions to change the appearance of the Craft Terminal window:
� Hide or display the toolbar, status bar, and error bar by making selections on the 

View menu.
� Hide or display a D50 rack, MCS, or any of the LCSs by making selections on the 

View menu.
� Size the window by clicking with the left mouse button on the edges of the window 

and dragging the edges of the object.
� Size any object views to accommodate the size of your screen, just as you would 

size the window.
� Move equipment locator group objects to different locations in the Craft Terminal 

window, by clicking on them with the left mouse button and dragging them with the 
mouse button held down; release the mouse button to “drop” the object in its new 
position.
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Objects in the Craft Terminal GUI
The following example shows the Craft Terminal user interface with the various 
components labeled.

 

Figure 2-1: Craft Terminal User Interface

Menu Bar

Toolbar

Master Control Shelf

Line Card Shelf (LCS)

Tab Pages (for LCS1)

Status Bar

Error Bar

Rack

            (MCS)
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An Example D50 System
Displaying 
Equipment 
Locator Groups

To display the equipment locator groups for the D50 rack, the MCS, and the LCSs, 
select the object you want to view from the View menu, as shown in the following 
example.

Objects with checks next to them are selected for display.

An Example D50 
System

When you view a D50 using Craft Terminal, you won’t always see the same set of 
objects displayed in the same way. What objects you do see depends on several factors:
� The individual D50 you are viewing; how many shelves are provisioned, how the 

slots in the shelves are provisioned, and the state of the individual cards (for exam-
ple, whether they are alarmed or not).

� What objects were displayed the last time the D50 was viewed. When you exit from 
Craft Terminal, it saves the last view for that specific D50. The same objects are 
presented the next time you view the same D50 system. The View menu allows you 
to specify which objects are displayed.

Figure 2-2: View Menu
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An Example D50 System
The following example shows a typical view of a D50 system.

The example system shows the rack at upper left, the MCS at upper right, and an LCS 
below. System components that are unprovisioned are shown in gray. Note that this 
example does not show the error or status bars, or any detailed sets of tab pages for the 
shelves, cards, or ports.

The rack for this system contains four provisioned LCSs: LCS1, LCS6, LCS10, and 
LCS11. The rest of the LCSs are not provisioned.

The MCS is provisioned for the following cards:
� One NMP (Network Management Processor) card.
� Two MCP (Master Control Processor) cards out of the two possible in the 1:1 pro-

tection group.
� One trunk card, which provides connection to the ATM backbone.
� One MLA (Master Line Card Adapter) card providing a broadband interface 

between the MCS and one LCS. The different types of MLA cards provide inter-
faces for different signals.

� Broadband tributary cards (OC3L, DS3L and MLAT1), each providing a broadband 
interface to standard ATM network equipment.

The MCS shown still has slots available for several more MLA-type cards.

The LCS, in the example, is provisioned for the following cards:
� DMT8A3 (4), SDSL8+, SDSL (3), SHDSL (2), and IDSL line cards, providing var-

ious types of DSL (Digital Subscriber Line) facilities for the D50.
� An LSM (Line Card Shelf Multiplexer) card. The LSM-type cards provide a broad-

band interface between the LCS and the MCS. The LSM2 card in the example sys-
tem shown communicates with an MLA2 card in the MCS using an OC3 interface. 
This means that LCS1 must be connected to the MLA2 card in first MLA slot of the 
MCS.

Figure 2-3: Sample D50 Display in Craft Terminal
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Displaying Tab Pages
Displaying Tab 
Pages

Detail information for the system is displayed and modified using sets of tab pages. The 
following objects in the Craft Terminal interface display sets of tab pages:
� Each shelf in the rack.
� Each card in a shelf (MCS or LCS).
� Each port on a card.

To display the set of tab pages for a shelf, click that shelf (the MCS or any of the LCSs) 
in the rack object with the left mouse button.

To display the set of tab pages for a card, click that card in the shelf object (either the 
MCS or one of the LCSs) with the left mouse button.    

Note: Before you can display the set of tab pages for an object, the rack or shelf 
containing that object must be displayed by selecting it on the View menu.

For information on the tab pages for each card, see the chapter on that card; for 
example, for information on the tab pages for the MCP card, see the MCP chapter.

Figure 2-4: Rack Object

Figure 2-5: MCS Object

Figure 2-6: LCS Object

Click to display
tab pages for a shelf

Click to display
tab pages for a card

Click to display
tab pages for a card
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Tab Page Controls
Port detail information is accessed by clicking the port indicator on a card. Click the 
port indicator on a line card to display a bar that contains the individual ports—the 
number of ports depends on the type of line card. If a card has only one port, click on 
the port indicator to open the port object view. This applies only to some of the cards on 
the MCS. All line cards have multiple ports.

The following example shows the eight ports of a DS1SDSL8+ line card located in 
slot 5 of an LCS.

The color of each individual port indicates its status. Click any port to view and work 
with provisioning information for the port.

Information for the selected port is displayed as a set of tab pages. The number of tab 
pages, and the information included on them, depends on which card is being viewed. 
For details on the port tab pages for each type of card, see the chapter on that card type. 
For example, the tab pages for the SHDSL port are described in the SHDSL Card and 
Ports chapter.

Tab Page 
Controls

On each tab page, Craft Terminal displays both system data and controls that allow you 
to work with the system. Some of the data is read-only, which means that it is strictly 
informational and not editable. Some of the data can be configured by the user. The 

Figure 2-7: Port Indicator and Individual Ports

port indicators

individual ports
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Tab Page Controls
following table summarizes display and control features found on the Craft Terminal 
tab pages.

Table 2-2: Tab Page Controls

Name Purpose Example

Radio button Select only one of two or 
more mutually exclusive 
options. Click to 
select/deselect.

Check box Select one or more 
non-exclusive options. 
Click to select/deselect.

Non-scrolling 
list box

Display read-only 
information, for example 
condition messages.

Command 
buttons

Perform an action, for 
example create a new card; 
display other controls such 
as dialog boxes. Click to 
perform the action.

Edit box Allow alphanumeric input. 
Click in the box to type new 
values.

Spin box Scroll through a set of fixed 
values to select a value. 
Click the up or down buttons 
to scroll.

Combo box Select an option from a 
scrollable list. Click the 
down arrow to display the 
list and click an option to 
select it.
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Show Connections
Many of the tab page controls are displayed in functional groups with descriptive titles. 
The radio buttons shown in the table of examples allow you to select various loopback 
testing modes, and so are contained in a group titled Test Mode.

Show 
Connections

Connection data is displayed by clicking Show Connections from the Tools menu, 
selecting a connection ID, then clicking Show Connection.

Enable the Dismiss on Show checkbox to make the Connections dialog box disappear 
when the Show Connection button is clicked.

A connection may also be displayed by selecting the Connection tab for a line card port 
and double-clicking a connection ID. A new connection can be created by selecting 
New Connection from the Tools menu, or by clicking the New Connection command 
button in the Connection dialog box. A line card must be configured before you can use 
it to create a connection. For details see Chapter 9—“Connection Dialog Boxes,” 
page 6-143.

Figure 2-8: Show Connections Dialog Box
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Chapter 2
Menus, Toolbars, and Object Views

Introduction This chapter describes the different commands and displays in Craft Terminal. This 
chapter includes the following categories of information:
� Menus and toolbars.
� All object views (shelves, trunk cards, line cards, and ports).
� How to use online help.

Menus and 
Toolbars

The Craft Terminal user interface includes a menu bar and a toolbar located near the top 
of the window. The toolbar may be displayed or hidden by selecting Toolbar on the 
View menu.

An Error bar and Status bar are displayed at the bottom of the window; these features 
may also be displayed or hidden by selecting them on the View menu. The toolbar and 
the error bar can be moved anywhere in the Craft Terminal window by clicking the bar 
with the left mouse button, then holding the button down and dragging the bar to a new 
location.

The following tables summarize the menu options available on each Craft Terminal 
menu.

Figure 2-9: Craft Terminal Menu Bar and Toolbar

Table 2-3: File Menu Commands and Functions

Command
Toolbar 

Icon
Keyboard 
Shortcut Function

New None Ctrl + N Planned for future release.

Open Again Ctrl + O Opens a new object view 
addressing the same object as 
the currently selected object 
view.
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Menus and Toolbars
Close None Closes the currently selected 
object view.

Save None Ctrl + S Saves the new settings to 
non-volatile memory.

Exit None None Exits the application.

Table 2-4: Edit Menu Commands and Functions

Command
Toolbar 

Icon
Keyboard 
Shortcut Function

Undo None Ctrl + Z Planned for future release.

Cut None Ctrl + X Planned for future release.

Copy None Ctrl + C Planned for future release.

Paste None Ctrl + V Planned for future release.

Table 2-5: View Menu Commands and Functions

Command
Toolbar 

Icon
Keyboard 
Shortcut Function

Toolbar None None Controls whether to display 
the toolbar or not.

Status Bar None None Controls whether to display 
the status bar or not.

Error Bar None None Controls whether to display 
the error bar or not.

Next Ctrl + Right 
arrow

View the next object. For 
example, the next line card 
(dialog box) in the line card 
shelf. 

Previous Ctrl + Left 
arrow

View the previous object. For 
example, the previous line 
card (dialog box) in the line 
card shelf.

Table 2-3: File Menu Commands and Functions (continued)

Command Toolbar 
Icon

Keyboard 
Shortcut

Function
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Menus and Toolbars
Up Ctrl + Up 
arrow

View the higher level 
component’s (or object) 
dialog box.

Down Ctrl + Down 
arrow

View the lower level 
component’s (or object) 
dialog box.

Rack1 None Displays the D50 Rack object 
view.

MCS None Displays the MCS object 
view.

LCS (1–12) None Displays the selected LCS 
object views. This option will 
be disabled if there is a 
broadband card (DS3L or 
OC3L) in the matching slot, 
since broadband cards cannot 
connect to LCSs.

1 Right-clicking with the mouse pointer on the MCS or an LCS in the rack view displays the selected 
item.

Table 2-6: Tools Menu Commands and Functions

Command Toolbar Icon Function

Show 
Connections…

Displays all connections on this D50.

New 
Connection

Creates a new connection. The new 
connection defaults to the first LCS, card, and 
port.

Traffic 
Descriptors...

None Show all reserved and user-defined traffic 
descriptors.

Trap 
Destinations

None Displays a table of existing trap destinations. 
You can add new trap destinations, or edit 
existing ones.

Event Viewer None View the currently existing traps.

Table 2-5: View Menu Commands and Functions (continued)

Command Toolbar 
Icon

Keyboard 
Shortcut

Function
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Menus and Toolbars
Active Alarms Displays the Active Alarms dialog box.

Trap Serverity None Displays the severity of the traps, and allows 
you to modify them.

Options… None Displays a window that lets you set the 
application timeout and polling intervals. It 
also provides the ability to set certain dialog 
display options.

Initialize 
System…

None Initializes the D50. Use this command to set 
the system’s IP address, IP Mask and 
Gateway.

Edit Trap 
Destinations

None Editor to add managed interface IP 
destinations to receive trap information.

Event Viewer None View traps (see Edit Trap Destinations).

Table 2-7: Window Menu Commands and Functions

Command Toolbar 
Icon

Function

Cascade None Makes a Windows cascade of the object 
views.

Tile None Puts all the object views on the screen at once, 
shrinking each of them to a uniform size.

Arrange 
Icons

None Arranges all object view icons on the screen in 
a regular format.

Refresh Refreshes the data in the active dialog box. 

Refresh All Requests an immediate “poll” for all of the 
currently visible objects. The data is refreshed 
in the active dialog boxes.

Close All None Closes all application windows.

Table 2-6: Tools Menu Commands and Functions (continued)

Command Toolbar Icon Function
Page 2-14 Release 11.0
© 2002 Nokia. Proprietary Data.



Chapter 2 Menus, Toolbars, and Object Views
Active Alarms List
Active Alarms 
List

The Active Alarms List allows you to view active alarms. Select Active Alarms from 
the Tools menu (or click the Active Alarm button on the toolbar) to display the 
following dialog box.

The Active Alarms list includes the following information for each alarm:
� Index number for the alarm.
� Timestamp (when the alarm was reported).
� ID for the alarm type, for example Environmental Alarm.
� Severity of the alarm, for example Minor.
� Resource affected, for example Port.
� Address for the shelf reporting the alarm (if applicable).
� Address for the slot reporting the alarm (if applicable).
� Address for the port reporting the alarm (if applicable).

Table 2-8: Help Menu Commands and Functions

Command Toolbar 
Icon

Function

Help Topics None Displays the Craft Terminal help system.

About 
application…

Displays the version of Craft Terminal you are 
using.

Figure 2-10: Active Alarms Dialog Box
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Trap Severity
Select an alarm from the list and click the Alarm Details button (or double-click an 
alarm) to display the following details window. Click the Refresh button to manually 
refresh the list. Click the Close button to close the dialog box.

The Active Alarms detail dialog box displays information detail for the selected alarm. 
The information included in this dialog box is dependent on the type of alarm.

Click the Show List button to return to the list dialog box. Click the Refresh button to 
manually refresh the alarm information. Click the Close button to close the dialog box.

Trap Severity The Trap Severity dialog box allows the user to change the severity of a trap to 
Critical, Major, or Minor.

To make any changes, select a trap from the Trap Number column, select one of the 
Severity values (Critical, Major, Minor, or None), then click Apply.

Figure 2-11: Active Alarms Detail

Figure 2-12: Trap Severity
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Color Code for Graphical Elements
Color Code for 
Graphical 
Elements

The graphical elements in the Craft Terminal user interface display in different colors, 
depending on their status. The colors used to indicate each status are described in the 
following table.

Table 2-9: Graphical Element Colors as Status Indicators

Color Condition/status

Green Enabled, operable

Red Alarmed, inoperable1

1 For descriptions of alarm conditions, see the volume titled Maintenance and Testing, 
Section 1—System Monitoring, Chapter 2—“Conditions.”

Yellow Alarmed2

2 Yellow may be set as the Alarmed condition status indicator, instead of red.

Black Disabled, inoperable (locked)

Gray Not configured

Orange Degraded

Dark blue Configured, unlocked, no alarms

Light blue Configured, unequipped
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Online Help
Online Help Windows-style online help is available for Craft Terminal by selecting Help Topics on 
the Help menu. The Contents tab page displays initially.

The Contents tab includes all the chapters and topics in the Craft Terminal help system, 
arranged in a hierarchy like the chapters of the Craft Terminal documentation user 
guide. Click any chapter to display the topics within it.

Figure 2-13: Craft Terminal Help Dialog Box, Contents Tab
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Color Code for Graphical Elements
Click the Index tab to display the following tab page.

The Index tab includes all the indexed terms in the help system. Type a term in the box 
at the top of the tab, and the system will scroll to that term in the list (or the nearest 
matching term). You can also scroll down the list to search for terms. Select a term, 
then click the Display button. You can also double-click the term from the list to 
display the help topic.

Figure 2-14: Craft Terminal Help Dialog Box, Index Tab
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Click the Find tab to display the following dialog box.

The Find tab provides the capability to perform a full-text search of every word in the 
help system; first, however, it must build the database. This usually takes just a few 
moments. Select an option and click the Next button to continue.

Figure 2-15: Find setup Wizard Dialog Box

Figure 2-16: Find Setup Wizard Dialog Box, Finish View
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Click the Finish button to finish creating the database.

Type the term you want to find in the text box at the top of the tab. The list in the 
middle of the tab displays all matching terms, and the list at the bottom of the tab 
displays all the topics that contain the term. You can also scroll down the list to search 
for terms, then click the Display button to display the help topic for the selected term. 
You can also double-click a term to display the topic for it. Click the Options button to 
set various search options for the database.

Figure 2-17: Craft Terminal Help Dialog Box, Find Tab
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Chapter 1
Network Element

Introduction To display the tab pages for the D50 network element, click the rack object anywhere 
except on a shelf.

Click the rack to display the following set of tab pages.

Note: The D50 accepts commands from Craft Terminal on a real-time basis. 
However, changes are not applied to the D50’s non-volatile memory (the MIB) until 
you issue the save command.

The Save button allows you to save all transactions in the MIB in case the NMP or 
MCP cards fail, or in case of a power failure. Use the Save command periodically 
during your Craft Terminal session.

Figure 3-1: Display system tabs from the rack

Figure 3-2: D50 System Tab Page

Click
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Introduction
The D50 immediately accepts commands from Craft Terminal, but until the transaction 
is committed by issuing the Save command (by clicking the Save button or selecting 
Save from the File menu) these changes are not permanently saved to the multiplexer’s 
MIB.

Note: Changes that have been saved to a D50’s MIB will be recoverable even if the 
system loses power, however settings that have not been saved to the MIB will be 
lost.

After you click the Save button, a confirmation dialog box displays. Click the Yes 
button to save the changes to the D50 (to the MIB).

When you click the Save button, then click the Yes button in the confirmation dialog 
box, MIB changes are stored in permanent memory. If you exit without saving, you can 
still start Craft Terminal again and then save. However, if you exit without saving the 
changes, and the D50 loses power, changes made since the last save will be lost.

Click the Config tab to display the system Configuration tab page.

The Configuration tab page displays the name of the system, its location, and the 
release number for the D50 software. This tab also displays the node name for the D50.

Figure 3-3: D50 Network Element, Configuration Tab Page
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Initializing the 
System

To initialize the D50, select Initialize System from the Tools menu.

The System Initialization dialog box will display, as shown in the following example.

Using the System Initialization dialog box, you can set up network management in two 
different ways:
� In-Band Management.
� Ethernet connection.

Both of these options may be used with Craft Terminal.

Figure 3-4: Tools Menu

Figure 3-5: System Initialization Dialog Box
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In-Band Management Channel over ATM Trunk
For details on how to connect Craft Terminal to a D50 through a serial port, see the 
volume titled Commissioning.

When you initially start the system by double-clicking the Craft Terminal icon on your 
desktop, you must specify whether to connect using a serial cable or Ethernet 
connection. The D50 Craft Terminal Connection Dialog box prompts you for the 
connection type.

Use the radio buttons to select either serial cable or Ethernet connection. For an 
ethernet connection, select an IP address from the drop-down list. You can also 
manually enter a new IP address in the IP Address box.

Whether you connect using a serial cable connection or an Ethernet connection, you 
use the System Initialization dialog box (Figure 3-5:  System Initialization Dialog Box) 
to set the In-Band Management parameters. Both methods are described in the 
following sections.

In-Band 
Management 
Channel over 
ATM Trunk

In-Band Management provides a communications interface between Craft Terminal, 
and the D50. This interface is defined as “In-Band” because the user communicates 
with the D50 over a provisioned permanent virtual circuit (PVC) terminated at the 
trunk interface. Setup for In-Band Management requires the entry of an IP Address and 
VPI/VCI information.

Enter the IP Address, IP Mask, VPI, VCI, and Traffic Descriptor (TrDesc) in the 
In Band Management section of the System Initialization dialog box. Click the Create 
Connection command button. A number will appear in the Connection ID box. Click 
OK.

BB-MLA. Select this option to enable a Broadband MLA card to be used for In-Band 
Management. With this option selected, select a BB-MLA card from the drop down 
list.

Traffic Descriptor (TrDesc). Select a traffic descriptor type within bandwidth limits. 
The VPI/VCI bandwidth configuration does not exceed a maximum of 128 Kbps for 
D50 with DS3T2 or OC3T2 trunk cards. The VPI/VCI bandwidth configuration does 
not exceed a maximum of 512 Kbps for D50 with DS3TQ, OC3TQM, OC3TQL, or 
OC3TQS trunk cards. For traffic descriptor defaults, see Traffic Descriptors, page 3-6.

Figure 3-6: D50 Craft Terminal Connection Dialog Box
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In-Band 
Management 
over Ethernet 
Trunk

To setup Network Management over an Ethernet 10Base-T connection, enter the IP 
Address, IP Mask, and Gateway IP Address for Ethernet and NMP Slot 4. Click the 
OK command button. Return to the System tab page of the System dialog box. Click 
the Yes option button in the MCP Synchronization dialog box and click the SAVE 
command button to permanently save the IP address information in the D50 
Management Information Base (MIB).

Note: The NMP slot 3 card is for a future release. IP Address, IP Mask and Gateway 
information are not required for slot 3 until the card is installed. The IP Address 
must be established via Craft Terminal so Craft Terminal can communicate with the 
D50 over a TCP/IP data network. IP address information is provided by the local 
Network Administrator. Before you can set up the In Band Management 
connection, you must verify with your Network Administrator that the network 
router or switch has been provisioned as follows:
– VPI/VCI information matches the In-Band settings to be entered through Craft 

Terminal.
– VPI/VCI bandwidth configuration does not exceed a maximum of 128 Kbps with 

DS3T, DS3T2, OC3T, and OC3T2 trunk cards.
– VPI/VCI bandwidth configuration does not exceed a maximum of 512 Kbps with 

DS3TQ, OC3TQS, OC3TQM, and OC3TQL trunk cards.

Remote Craft 
Interface

Disabled by default. This interface allows Craft Terminal access from a Remote Access 
Module (D50 RAM). For details, see the volume titled Installation.

MTU Size The In-Band Management Channel Maximum Transmission Unit (MTU) allows the 
user to configure the size of the transmission unit over the In-Band Management 
Channel. Do not modify this value unless instructed by your Network Administrator. 
The configurable range is from 68 to 1500 bytes.
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Traffic 
Descriptors

Select Traffic Descriptors from the tool menu to view a list of the pre-configured 
traffic descriptors.

Click New from the Traffic Descriptors window to create Asynchronous Transfer 
Mode Quality of Service (ATM QoS) traffic descriptors.

ATM QoS enables network and service providers to provide service differentiation over 
the network and individual digital subscriber lines (DSL). For a detailed discussion on 
ATM QoS and inherent traffic descriptors, see the volume titled Provisioning, 
Section 1—Provisioning Concepts, Chapter 12—“ATM QoS Provisioning.”

Traffic descriptors use standard traffic management parameters (e.g., cell loss ratio, cell 
transfer delay, peak cell rate, etc.) to describe characteristics for ATM connections. 
These characteristics provide criteria, along with a category of service (e.g., constant 
bit rate, variable bit rate, unspecified bit rate, etc.), for negotiating and sustaining 

Figure 3-7: Show Traffic Descriptors

Figure 3-8: New Traffic Descriptor
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permanent virtual circuit (PVC) connections. For connection details, see 
Chapter 9—“Connection Dialog Boxes,” page 6-143.

The New Traffic Descriptor dialog box allows the user to view and set new traffic 
descriptor parameters.
� Traffic Descriptor Type. The traffic descriptor type indicates a specific set of con-

nectivity characteristics based on standard traffic management contracts. Depending 
on the traffic type chosen, a distinct group of parameters display. The parameter 
group follows the standard traffic contract scheme. For details, see Table 3-1:  Traf-
fic Descriptor Types (Templates), page 3-8.

� Service Category. The traffic descriptor class of service.
� Frame Discard. Allow for frame discard (true or false). Frame discard is also 

known as Early Packet Discard (EPD).
� Param1 through Param5. The definition of these parameters vary depending on 

which QoS Service Category is selected. See Table 3-1:  Traffic Descriptor Types 
(Templates), page 3-8, for a list of the parameters for each QoS Service Category. 
The four parameter types available are: 
– Peak Cell Rate (PCR). A traffic parameter in cells per second that characterizes 

the maximum source transmission rate. The fraction 1/PCR represents the time 
between two cells over a given virtual connection. PCR is assigned to all service 
categories. It can only be set at a speed lower than the port connection speed.

Note: The Peak Cell Rate of a CBR connection must be set to 5% of the trunk or 
MLA/LSM interface rate, (whichever is lower) in cells per second. At a rate 
greater than 5%, the connection may drop cells. For more information, refer to 
Volume 4—Provisioning, Section 1—Provisioning Concepts, 
Chapter 12—“ATM QoS Provisioning,” CBR Connection Maximum Rates, 
page 1-106.

– Sustainable Cell Rate (SCR). An ATM traffic parameter in cells per second that 
characterizes a bursty source and specifies a maximum average rate at which cells 
can be sent over a given ATM virtual connection.

– Maximum Burst Size (MBS). A traffic parameter that specifies the maximum 
number of cells in a burst that can be transmitted at the peak rate assuming that, at 
the beginning of the burst, the receiving buffers are empty.

– CDVT. Cell Delay Variance Tolerance specifies the acceptable tolerance to 
cell-by-cell variations of the CDV (jitter). The CDVT is typically very low for 
CBR and VBR-rt connections, a bit higher for VBR-nrt connections and very 
high for UBR+ connections. Set the CDV value to be approximately the inverse 
of the PCR value. This is provisionable for each virtual connection.

Note: To avoid creating unsupported traffic descriptors, only create traffic 
descriptors that conform to the traffic descriptor template as shown in Table 3-1:  
Traffic Descriptor Types (Templates).

The following table presents the list of the parameters for each QoS Service Category 
as a base for creating ATM QoS traffic descriptors. The ten pre-defined traffic 
Release 11.0 Page 3-7
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descriptors shown in Figure 3-7:  Show Traffic Descriptors, page 3-6 and Figure 3-8:  
New Traffic Descriptor, page 3-6 are based on these templates.

Table 3-1: Traffic Descriptor Types (Templates)

QoS 
Service 

Category

Traffic 
Descriptor 

Type

Traffic Parameters Description

CBR ClpTransparent
NoScr (CBR.1)

Parameter 1 PCR in cells/second for 
CLP1=0+1 traffic.

Traffic 
conformance is 
based on the 
CLP-transparent 
model with no 
SCR. In a 
CLP-transparent 
model, the 
network disregards 
the CLP bit. 

Parameter 2 CDVT in tenths of 
microseconds.

Parameters 3, 4 
and 5

Not used.

VBR ClpTransparent
Scr (VBR.1)

Parameter 1 PCR in cells/second for 
CLP=0+1.

Traffic 
conformance is 
based on the 
CLP-transparent 
model with SCR. 
In a 
CLP-transparent 
model, the 
network disregards 
the CLP bit. 

Parameter 2 SCR CLP=0+1.

Parameter 3 MBS in cells.

Parameter 4 CDVT in tenths of 
microseconds.

Parameter 5 Not used.

VBR ClpNoTagging
ScrCdvt
(VBR.2)

Parameter 1 PCR in cells/second for 
CLP=0+1.

Traffic 
conformance is 
based on CLP with 
SCR without 
tagging. 

Parameter 2 SCR in cells/second for 
CLP=0 traffic.

Parameter 3 MBS in cells.

Parameter 4 CDVT in tenths of 
microseconds.

Parameter 5 Not used.

VBR ClpTaggingScr
Cdvt
(VBR.3)

Parameter 1 PCR in cells/second for 
CLP=0+1.

Traffic 
conformance is 
based on CLP with 
SCR and tagging.Parameter 2 SCR in cells/second for 

CLP=0 traffic, excess 
tagged2 as CLP=1.

Parameter 3 MBS in cells.

Parameter 4 CDVT in tenths of 
microseconds.

Parameter 5 Not used.
Page 3-8 Release 11.0
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UBR3 NoClpNoScrCdvt
(UBR.1)

Parameter 1 PCR in cells/second for 
CLP=0+1 traffic.

Traffic 
conformance is 
based on no CLP 
and no SCR.Parameter 2 CDVT in tenths of 

microseconds.

Parameters 3, 4 
and 5

Not used.

UBR NoClpTaggingNo
Scr
(UBR.2)

Parameter 1 PCR in cells/second for 
CLP=0+1 traffic.

Traffic 
conformance is 
based on no CLP 
with tagging and 
no SCR.

Parameter 2 CDVT in tenths of 
microseconds.

Parameters 3, 4 
and 5

Not used.

UBR+ ClpNoTagging
Mcr (UBR+)

Parameter 1 PCR in cells/second for 
CLP=0+1 traffic.

Traffic 
conformance is 
based on CLP with 
no tagging and 
MCR.

Parameter 2 CDVT in tenths of 
microseconds.

Parameter 3 MCR in cells/second.

Parameters 4 
and 5

Not used.

1 CLP=0 cells are a higher priority than CLP=1 cells. Lower priority (CLP=1) cells can be discarded under 
a congestion situation. CLP=0+1 refers to an aggregate cell stream.

2 Tagging is a process of setting the CLP bit of cells entering an ATM network to 1 because they do not 
conform to the subscribed traffic descriptor. These marked cells can be dropped based on the network 
congestion.

3 UBR is titled “Low” in the Element Manager and Craft Terminal GUI.

Table 3-1: Traffic Descriptor Types (Templates) (continued)

QoS 
Service 

Category

Traffic 
Descriptor 

Type

Traffic Parameters Description
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Traffic 
Management

Select Traffic Management from the Tools menu to view the current traffic 
management table, and to enable or disable CAC (Connection Admission and Control). 
The Traffic manager dialog box is shown in Figure 3-9:  Traffic Manager Dialog 
Box.CAC enables oversubscription of network bandwidth and potentially improves the 

utilization of network resources. To enable the oversubscription features, select the 
Enable ATM CAC check box.

The table in the traffic Manager dialog box shows the bandwidth of the MLA cards for 
each QoS Service Category. Select an option from the Bandwidth drop-down list to 
base the table on the following criteria:
� Effective: The bandwidth that was requested.
� Allocation: The bandwidth that the CAC is allocating.
� Actual: The bandwidth that the system is using.

This table displays the MLA card slots, the QoS service category for each MLA card, 
and the total bandwidth. Using the Actual bandwidth criteria to display the data, select 
either Ingress or Egress to display the table data for data stored in the current Bin. This 
table also contains a status column (Valid) so that the user can see if the data displayed 
is accurate.

Note: The bin number refers to the current group of data that is being shown in the 
table. Every 30 seconds the number of cells processed (ingress & egress) for a given 
service category is sampled and stored. After a 15 minute time period, the maximum 
of these 30 samples is stored in Bin #1. This bin is then moved to the Bin #2 

Figure 3-9: Traffic Manager Dialog Box

Effective and 
Allocation 
Bandwidth

Actual 
Bandwidth
Page 3-10 Release 11.0
© 2002 Nokia. Proprietary Data.



Chapter 1 Network Element
Stranded Links
position, and the information in the last bin is dumped. In this way, the current data 
is always Bin #1.

Click Refresh to update the table with data based on a different criteria and/or more 
recent data.

Click Close to exit the Traffic Manager dialog box.

Stranded Links Select Stranded Links from the Tools menu to display a table of any Link A or Link Z 
half of a connection that was not released after a connection was removed. The 
Stranded Link dialog box is shown in Figure 3-10:  Stranded Links Dialog Box.

To remove a link, select an item from the table and click Delete Link. To delete all of 
the links in the table, click Delete All Links.

Click Close to close the Stranded Links dialog box.

Figure 3-10: Stranded Links Dialog Box
Release 11.0 Page 3-11
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Setting System 
Options

You can configure the timeout period for requests to the D50. You can also configure 
the polling interval for refreshing open objects. The polling interval can be set to 0, 
which means that the window will not automatically refresh. The performance 
monitoring tabs, for example ATM PM, Queue Manager PM, and Physical PM, do not 
refresh automatically. These tabs all include a Refresh button which must be clicked to 
refresh the data manually. See the chapters on individual cards for more information on 
working with the performance monitoring tabs.

To set the Options, select Options from the Tools menu, enter the Timeout and Polling 
intervals, set the Dialog display options, then click the OK button.

The Intervals group allows you to specify timeout, polling intervals, and a retry count 
for the system. The polling interval can be overridden on individual tabs by clicking the 
Refresh command button to refresh the data manually. The default for timeout is 10 
seconds. The default for polling is 5 minutes. The polling interval can be set to 0, which 
means that the data will not refresh automatically. The default for retry count is 2.

The Dialog display group allows you to select whether or not to automatically display 
certain dialog boxes and system messages. By default, all these options are enabled. 
This group also allows you to select the number of IP addresses to store in the list that 

Figure 3-11: Options Dialog Box
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displays in the Connection dialog box. Use the spin buttons to select any number 
between 1 and 50.

Note: If you enter more than the specified number of IP addresses in the Connection 
dialog box, the system deletes existing addresses from the list (starting with the 
oldest) to make room for new addresses. The system does not issue a warning 
before deleting addresses from the list.

The Line Card Port Color group allows you to select options for displaying port 
conditions. By default all these options are enabled. The last option (If Managed 
Interface is set to no . . .) interacts with a set of option buttons, called the Managed 
Interface buttons, on each port’s Status tab. The Managed Interface buttons allow 
you to specify whether or not to actively manage the port. If the managed interface 
option is enabled (the default), conditions on the port (for example, an LOF condition) 
are reported as alarms in the alarm list. If this option is not enabled, conditions on the 
port will not be reported.

If (in the Options dialog box) the If Managed Interface is set to no . . . option is 
enabled, and the managed interface option on an individual port is disabled, any 
conditions that are reported for that port will display yellow instead of red.
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Chapter 2
Event Reporting

Introduction Craft Terminal supports multiplexer-wide event reporting based on a trap mechanism. 
A trap is a method used to isolate an abnormal condition or operation. A total of 250 
trapped events are stored and FIFO (first-in, first-out) aging occurs after 250 trapped 
event occurrences.

The event reporting function has two components:
� A Trap Destination editor that allows you to provision destination parameters for a 

particular management interface to receive D50 traps.
� An Event Viewer window that displays trapped events to the management interface 

specified via the trap destination editor.

System Setup For event reporting, the Craft Terminal host machine requires the following setup:
� SNMP Trap Service started on your host machine. This can be set to start automati-

cally each time the PC is turned on.
� Windows 2000 or Windows NT.

Trap Destination 
Editor

The trap destination editor allows the user to define to which management interfaces 
the multiplexer reports events (unless traps are disabled for a particular device).

Note: You must specify a trap destination in order to receive event reporting data. 
Otherwise, you will not get the necessary information to accurately know the state 
of the network.
Release 11.0 Page 3-15
© 2002 Nokia. Proprietary Data.



Volume 6, Section 3: D50 Multiplexer
Trap Destination Editor
Select Trap Destinations from the tools menu to display the Trap Destinations dialog 
box.

The Trap Destinations dialog box displays a table of existing trap destinations. Each 
trap is identified by IP Address, type of interface (I/F), and a Community name.

The control button definitions are as follows:
� OK. Apply any changes and close the dialog box.
� Add. Add a new trap destination entry.
� Edit. Show details of, modify, or mark to delete as necessary an existing trap desti-

nation entry. This control button is grayed-out (unselectable) until you select an 
existing trap destination entry.

� Refresh. Refresh the Trap Destinations dialog box information.

Clicking Add or Edit displays the Add/Edit Trap Destination dialog box.

The Add/Edit Trap Destination dialog box entries are as follows:
� IP Address. The IP address of the management interface to receive event reporting.

Figure 3-12: Edit Trap Destinations Dialog Box

Figure 3-13: Add/Edit Trap Destination Dialog Box
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� Interface. A radio button set that identifies the management interface connectivity 
(Ethernet or In-Band).

� Community Name (optional). The community name can be used to further iden-
tify a management interface. The default setting is “blank.”

� Delete Entry. A checkbox that indicates to delete the given trap destination entry. 
The checkbox is grayed-out (unselectable) if you are adding a new trap destination 
entry.

The control button definitions are as follows:
� OK. Apply any changes and close the dialog box.
� Cancel. Cancel the current session and close the dialog box.

Event Viewer 
Window

The event viewer window displays trapped events at the management interface 
specified via the trap destination editor. You can resize this window and the (columnar) 
fields contained within.

Select the tool menu, Event Viewer item to display the Event Viewer window.

The Event Viewer window displays a table of trapped events. The field definitions are 
as follows:
� Trap Desc (description). A general description of the trapped event.
� State. The current state of the trapped event.
� Severity. The severity associated with the trapped event (Critical, Major, Minor, 

or None).
� Detail1. An object locator description (e.g., shelf/card position).
� Detail2. A more descriptive definition of the trapped event than the general 

Trap Desc value.
� System IP. The multiplexer IP address that generated the trapped event.
� Date. The date the trapped event is received at the management interface.
� Time. The time the trapped event is received at the management interface.

Figure 3-14: Event Viewer Window
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Event Viewer Window
The control button definitions are as follows:
� Hide. Hide the window from view. The window is hidden until reception of a new 

trap event.
� Close. Close the window.

The following event reporting sample shows in the Event Viewer window an EQPTST 
(equipment status) trap description, Minor severity, departed detail descriptor event 
report for the MCS/MLA8 (MCS/8th-position MLA) object. The MCS MLA Slot16 
(MLA8) window shows that the user changed the administrative state to Unlocked for 
an unequipped card. This is an abnormal operation which calls for an event report. 

Figure 3-15: Event Reporting Sample
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SECTION 4MASTER CONTROL SHELF AND CARDS

Chapter 1
Master Control Shelf (MCS)

Introduction The MCS contains the central control and communication functions for the D50 
system, and communicates with up to 12 Line Card Shelves (LCSs) for each D50 
system, or with other standard ATM equipment. A single MCS can communicate with 
both LCSs and CPE, depending on which cards are installed. Communication with 
other standard ATM equipment requires either DS3L or OC3L cards.

Select MCS on the View menu to display the MCS object. 

The MCS can contain the following cards1:
� NMP (Network Management Processor). The MCS holds one NMP card in slot 4.
� MCP (Master Control Shelf Processor). The MCS can hold a MCP card in slots 5 

and 6.
� Trunk cards. The MCS can hold a DS3 or OC3 trunk card in a 1:1 unit protection 

group in slots 7 and 8.
� MLA (Master Line Card Adapter). The MCS can hold up to twelve MLA cards 

in logical slots MLA1 through MLA12. The physical slots are 9 through 20. The 
MCS support any combination of the various types of Master Line Card Adapter 
cards, or broadband tributary cards.

For details on the various cards, see the chapter on that card type.

Card 
Replacement 
Procedures

Card replacement may occasionally be necessary in your system. If so, please read the 
following relevant reference(s) in the volume titled Maintenance and Testing:
� Section 2—Card Replacement, Chapter 1—“Replace Identical Cards,” page 2-1, 

OR
� Section 2—Card Replacement, Chapter 2—“Replace an Existing Card with Differ-

ent Card Type,” page 2-5, OR

Figure 4-1: MCS Object (example configuration)

1 Optional MTU cards installed in slots 1 and 2 are not displayed by Craft Terminal but any MTU card 
alarms will be displayed.
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MCS Interface
� Section 2—Card Replacement, Chapter 3—“Correct an Attribute Mismatch Condi-
tion,” page 2-19.

An Attribute Mismatch condition occurs when the system recognizes one of the 
following discrepancies:
� A card is inserted into a slot that is provisioned for a different card type.
� A card software revision is more recent than that of the active MCP card (i.e., a card 

with Release 11.0 software is inserted into a system with the MCP running Release 
10.0 software).

The Attribute Mismatch condition appears in the Conditions box on the Card Status tab.

MCS Interface Click the MCS object in the multiplexer (rack) equipment locator group to display the 
following set of tabs:
� Status.
� Config.
� Environmental Alarms.

MCS Status Tab 
Page

The Status tab page displays initially.

The Conditions list box displays a summary of conditions for all the cards on the MCS. 
Data in the Conditions list box is refreshed periodically by the system. The data can 
also be updated by clicking the Refresh icon on the toolbar.

Figure 4-2: MCS Status Tab
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MCS Environmental Alarms Tab Page
MCS 
Configuration 
Tab Page

Click the Config tab to display the following tab page.

The Configuration box lists the Serial Number, Hardware Version, CLEI, and unit 
type for the shelf.

MCS 
Environmental 
Alarms Tab Page

Click the Environmental Alarms tab to display the following tab page.

The Environmental Alarms tab lists the system components for which alarms can be 
enabled. The Alarm State column displays the current state of each component. You 
can enable or disable any of the components on the screen. For Scanpoints 1 through 4 
only, you can set Alarm Logic to Active High or Active Low which relates to remote 
alarm inputs on the MCS alarm board.

Figure 4-3: MCS Configuration Tab

Figure 4-4: MCS Environmental Alarms Tab
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MCS Environmental Alarms Tab Page
After making any changes to the options, the Apply Changes button becomes active. 
Clicking this button displays a warning that asks if you want to make changes to the 
system configuration. Click the OK button to save the changes to the MIB, or the 
Cancel button to cancel the action.
Page 4-4 Release 11.0
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Chapter 2
MCP Card

Introduction The MCP (Master Control Processor) card is the central control and communications 
support for the D50 system. The MCP stores program and provisioning database 
information.

A Master Control Shelf (MCS) may contain two MCP cards. The MCP cards are 
located in slots 5 and 6 of the MCS.

MCP Card 
Interface

Click an MCP card in an MCS equipment locator group to display the following set of 
tabs:
� Status.
� Configuration.
� Versions.

MCP Card 
Status Tab Page

The Status tab page displays initially.

The Conditions list box displays conditions associated with the selected card. Data in 
the Conditions list box is refreshed by the system at user-specified intervals. The 
interval can be set to 0, which means that the data will not automatically refresh. You 
can specify the polling interval by selecting Options from the Tools menu. The data can 
also be updated by clicking the Refresh icon on the toolbar.

The Administration State group allows you to control whether or not the card is 
available for service. Unlocked makes the card available if there are no other 

Figure 4-5: MCP Card Status Tab
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MCP Card Configuration Tab Page
conditions blocking its use. Locked makes the card unavailable for service. Cards 
should be locked when being configured, when making hardware upgrades, or when 
testing.

Note: If a card is locked, any alarms for that card will not display in the Active 
Alarms list but they will display in the Conditions box on the card’s Status tab. If an 
alarm condition exists and the unlocked option is selected, an alarm will then be 
displayed in the Active Alarms list. For descriptions of alarm conditions, see the 
volume titled Maintenance and Testing, Section 1—System Monitoring, 
Chapter 2—“Conditions.”

The Create button is only enabled if you click on an unprovisioned slot. Click this 
button to create a new MCP card.

The Delete command button is only enabled if you click on a provisioned card. Click 
this button and a warning message displays that indicates the card is about to be deleted 
from the system. You can either click the OK button to proceed, or the Cancel button 
to cancel the operation.

Click the Reset Card button to physically reset the card. Click this button and a 
warning message displays asking if you are sure you want to reset the card. You can 
click the OK button to proceed or the Cancel button to cancel the operation.

MCP Card 
Configuration 
Tab Page

Click the Config tab to display the following tab page.

The Configuration list box shows the Serial Number, Hardware Version, CLEI code, 
Name, and the Actual and Configured card type.

Figure 4-6: MCP Card Configuration Tab
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MCP Card Versions Tab Page
MCP Card 
Versions Tab 
Page

Click the Versions tab to display the following tab page.

The Subsystem Versions group lists the subsystems, their version numbers, and the 
dates when they were created.

Figure 4-7: MCP Card Versions Tab
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MCP Card Versions Tab Page
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Chapter 3
NMP Card

Introduction The NMP (Network Management Processor) card controls the D50 network 
management interfaces and provides Craft Terminal with the protocol support for 
communication.

A Master Control Shelf (MCS) may contain one NMP card. The NMP card is located in 
slot 4 of the MCS.

NMP Card 
Interface

Click an NMP card in an MCS equipment locator group to display the following set of 
tabs:
� Status.
� Configuration.
� Versions.

NMP Card 
Status Tab Page

The Status tab page displays initially.

The Conditions list box displays conditions associated with the selected card. Data in 
the Conditions list box is refreshed by the system at user-specified intervals. The 
interval can be set to 0, which means that the data will not automatically refresh. You 
can specify the polling interval by selecting Options from the Tools menu. The data can 
also be updated by clicking the Refresh icon on the toolbar.

The Administration State group allows you to control whether or not the card is 
available for service. Unlocked makes the card available if there are no other 

Figure 4-8: NMP Card Status Tab
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NMP Card Configuration Tab Page
conditions blocking its use. Locked makes the card unavailable for service. Cards 
should be locked when being configured, when making hardware upgrades, or when 
testing.

Note: If a card is locked, any alarms for that card will not display in the Active 
Alarms list but they will display in the Conditions box on the card’s Status tab. If an 
alarm condition exists and the unlocked option is selected, an alarm will then be 
displayed in the Active Alarms list. For descriptions of alarm conditions, see the 
volume titled Maintenance and Testing, Section 1—System Monitoring, 
Chapter 2—“Conditions.”

The Create button is only enabled if you have clicked on an unprovisioned slot. Click 
this button to create a new NMP card.

The Delete command button is only enabled if you have clicked on a provisioned card. 
Click this button and a warning message displays indicating the card is about to be 
deleted from the system. You can either click the OK button to proceed, or the Cancel 
button to cancel the operation.

Click the Reset Card button to physically reset the card. Click this button and a 
warning message displays asking if you are sure you want to reset the card. You can 
click the OK button to proceed or the Cancel button to cancel the operation.

NMP Card 
Configuration 
Tab Page

Click the Config tab to display the following tab page.

The Configuration list box shows the Serial Number, Hardware Version, CLEI code, 
Name, and the Actual and Configured card type.

Figure 4-9: NMP Card Configuration Tab
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NMP Card Versions Tab Page
NMP Card 
Versions Tab 
Page

Click the Versions tab to display the following tab page.

The Subsystem Versions group lists the subsystems, their version numbers, and the 
dates when they were created.

Figure 4-10: NMP Card Versions Tab
Release 11.0 Page 4-11
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Chapter 4
DS3 Trunk Cards

Introduction The DS3 trunk card provides the GR-499 compliant, metallic DS-3 interface to connect 
the D50 to a DS-3 based data network. It also contains the downstream address 
translation, second level of multiplexing, and timing generation functions for the D50. 
The DS3 trunk card terminates the DS-3 formatted ATM data stream to and from the 
ATM data network. The DS-3 functions of frame formatting, cell delineation and serial 
to parallel conversion are contained in an ATM physical layer device in the DS3 trunk 
card.

The Master Control Shelf (MCS) contains two DS3 cards in a 1:1 unit protection group. 
Slot 8 in the MCS contains the working card, and slot 7 contains the protection card. 
The protection card monitors the internal data path to prevent failures.

On the downstream (egress) path, if a cell’s VPI/VCI address identifies the cell as user 
data, the VPI portion of the cell header is replaced with an internal multiplexer address 
to facilitate routing through the D50. A routing tag is also inserted, which is used by the 
DS3 card to determine the destination for the cell. The DS3 translator checks for OAM 
cells and processes them based on associated data. The translator supports Alarm 
Indication Signal (AIS), Remote Defect Indicator (RDI) and loopback Operations and 
Maintenance (OAM). All other OAM cells are discarded by the address translator.

The input path is multiplexed into twelve 8-bit parallel ports for the MLA1 (Master 
Line Card Adapter) card slots and to a queue connected to the upstream data path. The 
downstream-to-upstream path is used for routing OAM and Embedded Operations 
Channel (EOC) cells out of the DS3 trunk and for routing test cells to the 
microprocessor. The MLA ports operate at a 25 MHz rate.

On the upstream (ingress) path, cells enter the D50 with their final ATM network 
VPI/VCI addresses. Buffers are located on the individual MLA circuit cards in the 
upstream path. Flow control feedback is implemented across the interface between the 
trunk card and the MLA slots. The D50 polls the MLA slot circuit cards for buffer 
status and implements a service algorithm to ensure fairness. A service interval is 
provided for each of the 12 MLA ports and the downstream to upstream path. Cells 
with their test indicator bit set are extracted from the upstream path and placed in a 
microprocessor port queue. The remainder of the aggregated ATM cell stream is 
applied directly to the ATM physical layer device.

Fault information is stored in registers in the D50. The DS3 card uses this information 
for performance monitoring purposes.

The DS3 card uses its internal system clocks and references. The system references are 
frequency locked to the on-board DS3 carrier TCXO (20-PPM stability) on initial 

1 "MLA" is the generic name for all MLA-series cards.
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power up. The system references may also be frequency locked to the DS3 frame pulse 
(if available), or to an external office reference. The DS3 card provides an 8 kHz and a 
19.44 MHz system reference. It also provides a 25 MHz bus clock. The bus clock is not 
locked to the system reference.

Note: If a MTU card is installed, it will provide the 8 kHz timing signal to the 
DS3TQ trunk card. If the MTU signal fails, the trunk cards generate the backup 8 
kHz timing signal. 

The metallic full-duplex uni-directional DS-3 signals connect to the D50 at the 
backplane connectors. The DS-3 signal is switched on the backplane to either the main 
or protect DS3 card. The DS-3 signals enter the DS3 circuit card at the backplane 
connector. These signals are then applied to a DS3 Line Interface Module that provides 
the analog line to the digital terminal (DS3 PHY layer device) interface.

The D50 supports the following types of DS3 cards:
� DS3T. The basic DS3 card, does not support priority queueing Quality of Service 

Version 4.0 (QoSV4).
� DS3T2. The DS3T2 card provides support for QoSV4. For details, see DS3 Port 

DS3T Tab Page.
� DS3TQ. The DS3TQ card supports end-to-end ATM QoS for the different service 

categories of Constant Bit Rate (CBR), Variable Bit Rate real-time (VBR-rt), Vari-
able Bit Rate non-real-time (VBR-nrt), and Unspecified Bit Rate+ (UBR+). ATM 
QoS provisioning details for this card are available in the volume titled Provision-
ing, Section 1—Provisioning Concepts, Chapter 12—“ATM QoS Provisioning.”

Note: Additional provisioning information can be located in the volume titled 
Provisioning, Section 4—Appendices, Appendix A—“Provisioning Parameters.”

DS3 Card 
Interface

Click a DS3 card in the MCS equipment locator group to display the following set of 
tabs:
� Status.
� Configuration.
� Versions.
� Protection Group Status.
� Protection Group.
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DS3 Card Status 
Tab Page

The Status tab page displays initially.

The Conditions list box displays conditions associated with the selected card. Data in 
the Conditions list box is refreshed by the system at user-specified intervals. The 
interval can be set to 0, which means that the data will not automatically refresh. You 
can specify the polling interval by selecting Options from the Tools menu. The data can 
also be updated by clicking the Refresh icon on the toolbar.

The Administration State group allows you to control whether or not the card is 
available for service. Unlocked makes the card available if there are no other 
conditions blocking its use. Locked makes the card unavailable for service. Cards 
should be locked when being configured, when making hardware upgrades, or when 
testing.

Note: If a card is locked, any alarms for that card will not display in the Active 
Alarms list but they will display in the Conditions box on the card’s Status tab. If an 
alarm condition exists and the unlocked option is selected, an alarm will then be 
displayed in the Active Alarms list. For descriptions of alarm conditions, see the 
volume titled Maintenance and Testing, Section 1—System Monitoring, 
Chapter 2—“Conditions.”

The Create button is only enabled if you have clicked on an unprovisioned slot. Click 
this button to display a list of cards you can create.

The Delete command button is only enabled if you have clicked on a provisioned card. 
Click this button and a warning message displays indicating the card is about to be 
deleted from the system. You can either click the OK button to proceed, or the Cancel 
button to cancel the operation.

Click the Reset Card button to physically reset the card. Click this button and a 
warning message displays asking if you are sure you want to reset the card. You can 
click the OK button to proceed or the Cancel button to cancel the operation.

Figure 4-11: DS3 Card Status Tab
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DS3 Card 
Configuration 
Tab Page

Click the Config tab to display the following tab page.

The Configuration list box shows the Serial Number, Hardware Version, CLEI code, 
Name, and the Actual and Configured card type.

DS3 Card 
Versions Tab 
Page

Click the Versions tab to display the following tab page.

The Subsystem Versions group lists the subsystems, their version numbers, and the 
dates when they were created.

Figure 4-12: DS3 Card Configuration Tab

Figure 4-13: DS3 Card Versions Tab
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DS3 Card 
Protection 
Group Status 
Tab Page

Click the Prot Grp Status tab to display the following tab page.

The Conditions list box displays conditions associated with the selected card. Data in 
the Conditions list box is refreshed by the system at user-specified intervals. The 
interval can be set to 0, which means that the data will not automatically refresh. You 
can specify the polling interval by selecting Options from the Tools menu. The data can 
also be updated by clicking the Refresh icon on the toolbar.

The Administration State group allows you to control whether or not the card is 
available for service. Unlocked makes the card available if there are no other 
conditions blocking its use. Locked makes the card unavailable for service. Cards 
should be locked when being configured, when making hardware upgrades, or when 
testing.

Note: If a card is locked, any alarms for that card will not display in the Active 
Alarms list but they will display in the Conditions box on the card’s Protection 
Group Status tab. If an alarm condition exists and the unlocked option is selected, an 
alarm will then be displayed in the Active Alarms list. For descriptions of alarm 
conditions, see the volume titled Maintenance and Testing, Section 1—System 
Monitoring, Chapter 2—“Conditions.”

Figure 4-14: DS3 Card Protection Group Status Tab
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DS3 Card 
Protection 
Group Tab Page

Click the Protection Group tab to display the following tab page.

The Protection Group tab page is used to set parameters for the 1:1 protection group for 
the two trunk cards.

The Indices group displays the Unique ID for the protection group, and the numbers of 
the primary and standby slots.
� Primary Trunk Slot is the physical MCS slot of the currently active trunk card.
� Standby Trunk Slot is the inactive MCS slot. Slots 7 and 8 are reserved for trunk 

cards (either DS3 or OC3). The left slot (Slot 7) is designated the protection slot, 
and the right slot (Slot 8) is designated the working slot.

The Switching Mode group specifies the points of control for protection switching:
� Uni-Directional. Controlled by the multiplexer only.
� Bi-Directional. This feature is not supported.

In the Uni-Directional switching mode, protection switching will not consider far-end 
requests when determining whether to perform a manual switch.

The Reversion Mode group is not enabled for this card.

The Force Switch, Manual Switch, Lockout, and Clear groups allow you to select 
options for protection switching that involve both the multiplexer (near-end) and the 
ATM network (far-end) of the trunk. Protection switching considers these options in the 
following order of priority:

1 Clear. User-initiated, will clear only user-initiated protection request.

2 Lockout. User-initiated, will clear only user-initiated protection request.

3 Force. User-initiated, will clear only user-initiated protection request.

4 Signal failure. System-initiated.

5 Manual. User-initiated, will clear only user-initiated protection request.

Figure 4-15: DS3 Card Protection Group Tab
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6 Signal degrade. System-initiated.

Note: The terms Working and Protection refer to slot provisioning—not to which 
card is currently in active or standby status. The left slot (Slot 7) is designated the 
protection slot, and the right slot (Slot 8) is designated the working slot.
The Clear group allows you to clear the state of the protection switching software.
– Clear. Clears the state of the software.
– None. Enables the protection switching.
You can then proceed with a manual or forced switch selection. This procedure is 
useful if the system does not seem to be responding to selecting protection switch-
ing options.
The Lockout group controls whether trunk card protection switching is enabled.
– None. Enables protection switching (default).
– Lockout. Disables protection switching.
Forced switching causes protection switching regardless of trunk conditions. The 
Force Switch group allows you to select which trunk slot becomes active upon a 
forced switch.
– None. Disables forced protection switching (default). Always select this option 

after selecting either Working or Protection in order to allow future changes to 
the switching options.

– Working. Causes switching to the working trunk slot (Slot 8).
– Protection. Causes switching to the protection trunk slot (Slot 7).
Manual switching causes protection switching, but is dependent on trunk condi-
tions. The Manual Switch group allows you to select which trunk slot becomes 
active upon a manual switch.
– None. Disables manual protection switching (default). Always select this option 

after selecting either Working or Protection in order to allow future changes to 
the switching options.

– Working. Causes switching to working trunk slot (Slot 8), based on trunk condi-
tions. 

– Protection. Causes switching to protection trunk slot (Slot 7), based on trunk 
conditions.

DS3 Port 
Interface

Click the port connection on the DS3 card to display the DS3 port interface.

The DS3 port object view contains the following tabs:
� Status.
� Test.
� DS3T.
� DS3 Thresholds.
� Physical PM.
� ATM PM.
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DS3 Port Status 
Tab Page

The Status tab displays initially.

The Conditions list box displays conditions associated with the selected port. Data in 
the Conditions list box is refreshed by the system at user-specified intervals. The 
interval can be set to 0, which means that the data will not automatically refresh. You 
can specify the polling interval by selecting Options from the Tools menu. The data can 
also be updated by clicking the Refresh icon on the toolbar.

The Administration State group allows you to control whether or not the port is 
available for service. Unlocked makes the port available if there are no other 
conditions blocking its use. Locked makes the port unavailable for service. Ports 
should be locked when being configured, when making hardware upgrades, or when 
testing.

Note: If a port is locked, any alarms for that port will not display in the Active 
Alarms list but they will display in the Conditions box on the port’s Status tab. If an 
alarm condition exists and the unlocked option is selected, an alarm will then be 
displayed in the Active Alarms list. For descriptions of alarm conditions, see the 
volume titled Maintenance and Testing, Section 1—System Monitoring, 
Chapter 2—“Conditions.”

Figure 4-16: DS3 Port Status Tab
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DS3 Port Test 
Tab Page

Click the Test tab to display the following tab page.

The Test tab allows you to perform testing on the DS3 card.

The Test Mode group allows you to select the type of testing to perform:
� Line. Test the line to the subscriber’s network interface—no data into the system.
� Terminal. Test the line to the subscriber’s modem—no data out of the system.

Test Duration sets the interval in seconds that the system should wait before stopping 
the test. The Test Duration default is 15 seconds. Use the Test Command buttons to 
Start and Stop testing.

Important! All diagnostic tests interrupt data flow through the system. Do not 
perform on a D50 that is providing service. Only use diagnostic tests during 
commissioning procedures or in a lab environment to isolate trouble in the 
system. If using in-band management, a diagnostic test will cut off the D50’s 
control of the management station. The test duration should be set 
appropriately.

For additional information on Diagnostic Test Modes, see the volume titled 
Maintenance and Testing.

Figure 4-17: DS3 Port Test Tab
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DS3 Port DS3T 
Tab Page

Click the DS3T tab to display the following tab page.

The Addressing Mode group indicates the mode, Network Node Interface (NNI) or 
Universal Network Interface (UNI). This parameter is not provisionable by the user and 
is always set to the NNI option (as shown in the example).

The Cell Scrambling group allows you to enable cell scrambling, which prevents false 
error detection on the cell payload. Since direct mapping uses the Header Error Check 
(HEC) for cell delineation, a five-byte pattern with valid ATM cell overhead may 
appear in the payload. Enabling cell scrambling reduces the possibility of a false lock.

The Starvation Cycles2 group allows you to specify the number of QoSV4 starvation 
cycles in the ingress direction. This field allows you to allocate a specified percentage 
of service to low-priority traffic.

Note: This group is enabled only for the DS3T2 and DS3TQ cards. For the DS3T 
card, this group is not enabled.

The percentage of bandwidth available for low-priority traffic is calculated by the 
system as one divided by the value of this field plus one [1/(starvation cycles + 1)], for 
example:
� If the value for this field is set to 0 (zero), no bandwidth is guaranteed to be avail-

able for low-priority traffic.
� If the value for this field is set to 1, then 1/(1+1), or 50% of available bandwidth is 

available for low-priority traffic.
� If the value for this field is set to 2, then 1/(2+1), or 33% of available bandwidth is 

available for low-priority traffic.

The HEC Coset group:
� Allows you to enable Header Error Check (HEC) Coset, which ensures non-zero 

values for HECs in idle ATM cells.
� Is an 8-bit field and the last byte of the ATM cell header.

Figure 4-18: DS3 Port DS3T Tab

2 Priority queuing QoSV4 starvation cycles are not applicable to a D50 supporting ATM QoS.
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� Allows a receiver to detect (and possibly correct) transmission errors in the cell 
header.

� Is used for integrity checking only, and only counts HEC errors that cannot be cor-
rected.

The Line Build Out group allows you to select either Low or High buildout, which 
adjusts equalization to reflect the length of the DS3 cable. The DS3 trunk Line 
Interface Unit (LIU) supports two levels of line build out (this is the length of the coax 
cable from the MCS backplane to the other end of the DS3 connection, the router or 
ATM switch): 
� Low is used for coax cables shorter than 50 feet (default).
� High is used for coax cables between 50 and 450 feet in length.

The Line Type group allows you to select a DS3 framing format:
� Direct Mapping CBit provides the most data throughput and is the preferred oper-

ating mode. Some equipment does not support this mode, in which case one of the 
Physical Layer Convergence Protocol (PLCP) modes should be selected. For this 
mode, enable both Cell Scrambling and HEC Coset.

� Direct Mapping M23 is typically only used with older equipment. For this mode, 
enable both Cell Scrambling and HEC Coset.

� PLCP CBit (the default) is the preferable mode of the two PLCP modes, since it 
provides better performance monitoring (PM) information. For this mode, disable 
Cell Scrambling and enable HEC Coset.

� PLCP M23 is typically only used with older equipment. For this mode, disable Cell 
Scrambling and enable HEC Coset.

The Line Timing group allows you to select the type of timing resource for the signal:
� Loop. The system extracts timing from the DS-3 signal.
� Internal. The system supplies timing from an internal source.
� External. This is used to support the MTU external reference clock.
� Loop PLCP. The system extracts timing from PLCP.
� Internal PLCP. The system supplies timing from an internal PLCP source.

Note: The HEC Coset, line type, and line timing options selected must match the 
options set on the ATM router or switch at the far-end of the loop.
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DS3 Port DS3 
Thresholds Tab 
Page

Click the DS3 Thresholds tab to display the following tab page.

The Intervals group allows you to specify two error rate thresholds, for both 15-minute 
and daily intervals:
� CVCP-P. Code Violation-Path is the count of CP-bit parity errors occurring in the 

accumulation period.
� CVPLCP-P. Code Violation-PLCP-Path is the count of BIP-8 code errors in the 

accumulation period.

The BERT (Bit Error Rate Threshold) group allows you to set the threshold for the 
signal degrade condition.

Note: This group is enabled only for the DS3T2 and DS3TQ cards. For the DS3T 
card, this group is not enabled.

For provisioning parameter tables, see the volume titled Provisioning.

After making changes to any of the thresholds, the Apply Changes button becomes 
enabled. Click this button to apply the changes to the MIB.

Figure 4-19: DS3 Port DS3 Thresholds Tab
Page 4-24 Release 11.0
© 2002 Nokia. Proprietary Data.



Chapter 4 DS3 Trunk Cards
DS3 Port Physical PM Tab Page
DS3 Port 
Physical PM Tab 
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Click the Physical PM tab to display the following tab page.

The Physical PM tab page provides performance monitoring data for the DS3 port.

The Interval group allows you to select either 15-minute or Daily intervals for 
performance monitoring.

You can track up to 12 bins of performance data in 15-minute intervals. Bin number 1 
contains data for the current 15-minute interval, bin number 2 contains data for the 
previous 15-minute interval, and so on. In the Bin spin box, set the Bin value (1 to 12).

You can track 2 bins of data in daily intervals. Bin number 1 contains data for the 
current day. Bin number 2 contains data for the previous daily interval. In the Bin spin 
box, set the Bin value (1 or 2).

The Type group allows you to specify whether to monitor near-end or far-end PM data.

The PM Data for . . . group displays the names and values for the parameters listed. 
The title of this group changes to reflect the option selected in the Type group. The list 
includes values for the following parameters:
� Code Violation-Path (CVCP-P).
� Errored Second-Path (ESCP-P).
� Severely Errored Second-Path (SESCP-P).
� SEF/AIS Second-Path (SAS-P).
� Unavailable Seconds-Path (UASCP-P).
� Code Violation PLCP-Path (CVPLCP-P).
� Errored Second PLCP-Path (ESPLCP-P).
� Severely Errored Second PLCP-Path (SESPLCP-P).
� Severely Errored Framing Second PLCP-Path (SEFSPLCP-P).
� Unavailable Second PLCP-Path (UASPLCP-P).
� Errored Second Line (ES-L).
� Status.

Figure 4-20: DS3 Port Physical PM Tab
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The data will not refresh automatically. Click the Refresh command button to display 
data for the specified interval. Click the Clear command button to clear all 
performance data. Click the Graph button to display the data in graphical format.

The Status in the Data list box will always be either Valid or Invalid. A value of 
Invalid indicates that the data has not been accumulated for the full time of a given 
interval because a bin has been reset. Invalid data should not be used to resolve 
performance issues.

DS3 Port ATM 
PM Tab Page

Click the ATM PM tab to display the following tab page.

The ATM PM (Performance Monitoring) tab page provides information on cells 
received, cells transmitted, cells dropped, and the status. The Interval group allows 
you to specify either 15-minute or Daily PM monitoring intervals. 

You can track up to 12 bins of performance data in 15-minute intervals. Bin number 1 
contains data for the current 15-minute interval. Bin number 2 contains data for the 
previous 15-minute interval and so on. In the Bin spin box, set the Bin value (1 to 12).

You can track 2 bins of data in daily intervals. Bin number 1 contains data for the 
current day. Bin number 2 contains data for the previous day. In the Bin spin box, set 
the Bin value (1 or 2).

The data will not refresh automatically. Click the Refresh command button to display 
data for the specified interval. Click the Clear command button to clear all 
performance data. Click the Graph button to display the data in graphical format.

The Status in the Data list box will always be either Valid or Invalid. A value of 
Invalid indicates that the data has not been accumulated for the full time of a given 
interval because a bin has been reset. Invalid data should not be used to resolve 
performance issues.

The Graph window displays when you click the Graph button from a number of 
different tab pages. The options included on the Graph window vary slightly depending 

Figure 4-21: DS3 Port ATM PM Tab
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on the set of data that is being graphed. As an example, the DS3 ATM PM Graph 
window is shown below.

The Graphing group includes a list of parameters that vary depending on the window 
from which the Graph window was accessed.

The Graph window includes a grid where the line graphs are displayed. The grid can 
display any combination of the available parameters—each parameter displays in a 
different color to make it easier to view the information. The grid is divided into 
15-minute intervals, and labeled by bin number.

The Graph Invalid Data check box displays below the grid if data for any of the 
intervals in the selected bin is invalid. Invalid data displays as a dashed line. Valid data 
displays as a solid line. If you do not want to view invalid data, click the check box to 
deselect it.

The following numeric data is displayed on the right side of the Graph window:
� Current data for the current 15-minute interval and current day.
� Historic data for the eleven previous 15-minute bins and for the previous day.

Click the Close command button to close the window, or the Refresh command button 
to refresh the display.

Figure 4-22: Graph Window, ATM PM
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Chapter 5
OC3 Trunk Cards

Introduction to 
OC3

The OC3-series trunk cards provide a GR-253 compliant Synchronous Optical 
Network (SONET) interface for connecting the D50 to an OC3-based data network. It 
also provides egress address translation, second level multiplexing, and timing 
resources. The OC3 terminates the OC3-formatted ATM data stream to and from the 
ATM data network.

If a cell’s VPI/VCI address identifies the cell as user data, the VPI portion of the cell 
header is replaced with an internal multiplexer address to facilitate routing through the 
D50. A routing tag is also inserted, which is used by the OC3 card to determine the 
destination for the cell. The OC3 translator checks for Operations and Maintenance 
(OAM) cells and processes them based on associated data. The translator supports 
Alarm Indication Signal (AIS), Remote Defect Indicator (RDI), and loopback OAM.

The Master Control Shelf (MCS) contains two OC3 cards in a 1:1 protection group. 
MCS slot 8 contains the working card, and slot 7 contains the protection card.

Upstream data is multiplexed into twelve MLA1 (Master Line Card Adapter) card slots 
and to a queue connected to the ingress data path. The downstream-to-upstream path is 
used for routing OAM and Embedded Operations Channel (EOC) cells out of the OC3 
trunk and for routing test cells to the microprocessor. There is no flow control feedback 
across the interface between the trunk card and the MLA card slots downstream. The 
MLA ports operate at a 25 MHz rate.

Fault information is stored in registers in the multiplexer. This information is used by 
the OC3 card for performance monitoring purposes.

The OC3 card generates system clocks and references. The system references are 
frequency locked to the on-board OC3 carrier TCXO (20 PPM stability) on initial 
power up. The system references may also be frequency locked to the OC3 frame pulse 
(if available), or to an external office reference. The OC3 card provides an 8 KHz and a 
19.44 MHz system reference. It also provides a 25 MHz bus clock. The bus clock is not 
locked to the system reference.

Note: If a MTU card is installed, it will provide the 8 kHz timing signal to the TQS, 
TQL, and TQM OC3 trunk cards. If the MTU signal fails, the trunk cards generate 
the backup 8 kHz timing signal.

1 "MLA" is the generic name for all MLA-series cards.
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The OC3 card types are as follows:
� OC3T. The basic OC3 card, does not support Quality of Service Version 4.0 

(QoSV4).
� OC3T2. The OC3T2 card provides support for QoSV4. For details, see the descrip-

tion of the OC3 Port OC3T Tab Page.
� OC3TQ2. The OC3TQ card supports end-to-end ATM QoS for the different service 

categories of Constant Bit Rate (CBR), Variable Bit Rate real-time (VBR-rt), Vari-
able Bit Rate non-real-time (VBR-nrt), and Unspecified Bit Rate + (UBR+). ATM 
QoS provisioning details for this card are available in the volume titled Provision-
ing, Section 1—Provisioning Concepts, Chapter 12—“ATM QoS Provisioning.”

Note: Additional provisioning information can be located in the volume titled 
Provisioning, Section 4—Appendices, Appendix A—“Provisioning Parameters.”

OC3 Card 
Interface

Click an OC3 card in the MCS equipment locator group to display the following tabs:
� Status.
� Configuration.
� Versions.
� Protection Group Status.
� Protection Group.

OC3 Card Status 
Tab Page

The Status tab page displays initially.

The Conditions list box displays conditions associated with the selected card. Data in 
the Conditions list box is refreshed by the system at user-specified intervals. The 
interval can be set to 0, which means that the data will not automatically refresh. You 
can specify the polling interval by selecting Options from the Tools menu. The data can 
also be updated by clicking the Refresh icon on the toolbar.

2 The OC3TQ reference includes the OC3TQS, OC3TQL, and OC3TQM.

Figure 4-23: OC3 Card Status Tab
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The Administration State group allows you to control whether or not the card is 
available for service. Unlocked makes the card available if there are no other 
conditions blocking its use. Locked makes the card unavailable for service; cards 
should be locked when being configured, when making hardware upgrades, or when 
testing.

Note: If a card is locked, any alarms for that card will not display in the Active 
Alarms list but they will display in the Conditions box on the card’s Status tab. If an 
alarm condition exists and the unlocked option is selected, an alarm will then be 
displayed in the Active Alarms list. For descriptions of alarm conditions, see the 
volume titled Maintenance and Testing, Section 1—System Monitoring, 
Chapter 2—“Conditions.”

The Create button is only enabled if you have clicked on an unprovisioned slot. Click 
this button to display a list of cards you can create.

The Delete command button is only enabled if you have clicked on a provisioned card. 
Click this button and a warning message displays indicating the card is about to be 
deleted from the system. You can either click the OK button to proceed, or the Cancel 
button to cancel the operation.

Click the Reset Card button to physically reset the card. Click this button and a 
warning message displays asking if you are sure you want to reset the card. You can 
click the OK button to proceed or the Cancel button to cancel the operation.

OC3 Card 
Configuration 
Tab Page

Click the Config tab to display the following tab page.

The Configuration list box shows the Serial Number, Hardware Version, CLEI code, 
Name, and the Actual and Configured card type.

Figure 4-24: OC3 Card Configuration Tab
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OC3 Card 
Versions Tab 
Page

Click the Versions tab to display the following tab page.

The Subsystem Versions group lists the subsystems, their version numbers, and the 
dates when they were created.

OC3 Card 
Protection 
Group Status 
Tab Page

Click the Prot Grp Status tab to display the following tab page.

The Conditions list box displays conditions associated with the selected card. Data in 
the Conditions list box is refreshed by the system at user-specified intervals. The 
interval can be set to 0, which means that the data will not automatically refresh. You 
can specify the polling interval by selecting Options from the Tools menu. The data can 
also be updated by clicking the Refresh icon on the toolbar.

The Administration State group allows you to control whether or not the port is 
available for service. Unlocked makes the port available if there are no other 
conditions blocking its use and Locked makes the port unavailable for service. Ports 

Figure 4-25: OC3 Card Versions Tab

Figure 4-26: OC3 Card Protection Group Status Tab
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should be locked when being configured, when making hardware upgrades, or when 
testing.

Note: If a card is locked, any alarms for that card will not display in the Active 
Alarms list but they will display in the Conditions box on the card’s Protection 
Group Status tab. If an alarm condition exists and the unlocked option is selected, an 
alarm will then be displayed in the Active Alarms list. For descriptions of alarm 
conditions, see the volume titled Maintenance and Testing, Section 1—System 
Monitoring, Chapter 2—“Conditions.”

In cases where a trunk card is physically replaced, see the volume titled Commisioning, 
Section 3—Card Cabling, Chapter 1—“OC3 Trunk Card Cabling.”

OC3 Card 
Protection 
Group Tab Page

Click the Protection Group tab to display the following tab page.

The Protection Group tab page is used to set parameters for the 1:1 protection group for 
the two trunk cards.

The Indices group displays the Unique ID for the protection group, and the numbers of 
the primary and standby slots.

Primary Trunk Slot is the MCS slot of the currently active trunk card and Standby 
Trunk Slot is the inactive slot. Slots 7 and 8 are reserved for trunk cards. The left slot 
(Slot 7) is designated the protection slot, and the right slot (Slot 8) is designated the 
working slot.

The Switching Mode group specifies the points of control for protection switching:
� Uni-Directional. Controlled by the multiplexer only.
� Bi-Directional. This feature is not supported.

In the Uni-Directional switching mode, protection switching will not consider far-end 
requests when determining whether to perform a manual switch.

The Reversion Mode group is not enabled for this card.

Figure 4-27: OC3 Card Protection Group Tab
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The Force Switch, Manual Switch, Lockout, and Clear groups allow you to select 
options for protection switching that involve both the multiplexer (near-end) and the 
ATM network (far-end) of the trunk. Protection switching considers these options in the 
following order of priority:

1 Clear. User-initiated, will clear only user-initiated protection request.

2 Lockout. User-initiated, will clear only user-initiated protection request.

3 Force. User-initiated, will clear only user-initiated protection request.

4 Signal failure. System-initiated.

5 Manual. User-initiated, will clear only user-initiated protection request.

6 Signal degrade. System-initiated.

Note: The terms Working and Protection refer to slot provisioning—not to which 
card is currently in active or standby status. The left slot (Slot 7) is designated the 
protection slot, and the right slot (Slot 8) is designated the working slot.
The Clear group allows you to clear the state of the protection switching software. 
– Clear. Clears the state of the software.
– None. Enables the protection switching.
You can then proceed with a manual or forced switch selection. This procedure is 
useful if the system does not seem to be responding to selecting protection switch-
ing options.
The Lockout group controls whether trunk card protection switching is enabled.
– None. Enables protection switching (default).
– Lockout. Disables protection switching.
Forced switching causes protection switching regardless of trunk conditions. The 
Force Switch group allows you to select which trunk slot becomes active upon a 
forced switch.
– None. Disables forced protection switching (default). Always select this option 

after selecting either Working or Protect in order to allow future changes to the 
switching options.

– Working. Causes switching to the working trunk slot (Slot 8).
– Protection. Causes switching to the protection trunk slot (Slot 7).
Manual switching causes protection switching, but is dependent on trunk condi-
tions. The Manual Switch group allows you to select which trunk slot becomes 
active upon a manual switch.
– None. Disables manual protection switching (default). Always select this option 

after selecting either Working or Protection in order to allow future changes to 
the switching options.

– Working. Causes switching to working trunk slot (Slot 8), based on trunk condi-
tions. 

– Protection. Causes switching to protection trunk slot (Slot 7), based on trunk 
conditions.
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OC3 Port 
Interface

Click the port connection on the OC3 card to display the OC3 port interface. The OC3 
port object view contains the following tabs:
� Status.
� Test.
� OC3T.
� OC3 Thresholds.
� Trace Data.
� Physical PM.
� ATM PM.

These tabs are described in the following sections.

OC3 Port Status 
Tab Page

The Status tab displays initially.

The Conditions list box displays conditions associated with the selected port. Data in 
the Conditions list box is refreshed by the system at user-specified intervals. The 
interval can be set to 0, which means that the data will not automatically refresh. You 
can specify the polling interval by selecting Options from the Tools menu. The data can 
also be updated by clicking the Refresh icon on the toolbar.

The Administration State group allows you to control whether or not the port is 
available for service. Unlocked makes the port available if there are no other 
conditions blocking its use. Locked makes the port unavailable for service. Ports 
should be locked when being configured, when making hardware upgrades, or when 
testing.

Note: If a port is locked, any alarms for that port will not display in the Active 
Alarms list but they will display in the Conditions box on the port’s Status tab. If an 
alarm condition exists and the unlocked option is selected, an alarm will then be 
displayed in the Active Alarms list. For descriptions of alarm conditions, see the 
volume titled Maintenance and Testing, Section 1—System Monitoring, 
Chapter 2—“Conditions.”

Figure 4-28: OC3 Port Status Tab
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OC3 Port Test 
Tab Page

Click the Test tab to display the following tab page.

The Test tab allows you to perform testing on the OC3 card.

The Test Mode group allows you to select the type of testing to perform:
� Line. Test the line to the subscriber’s network interface—no data into the system.
� Terminal. Test the line to the subscriber’s modem—no data out of the system.

Test Duration sets the interval in seconds that the system should wait before stopping 
the loopback test. The Test Duration default is 480 seconds. The Test Command 
buttons Start and Stop testing.

Important! All diagnostic tests interrupt data flow through the system. Do not 
perform on a D50 that is providing service. Only use diagnostic tests during 
commissioning procedures or in a lab environment to isolate trouble in the 
system. If using in-band management, a diagnostic test will cut off the D50’s 
control of the management station. The test duration should be set 
appropriately.

For additional information on Diagnostic Test Modes, see the volume titled 
Maintenance and Testing.

Figure 4-29: OC3 Port Test Tab
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OC3 Port OC3T 
Tab Page

Click the OC3T tab to display the following tab page.

The Addressing Mode group indicates either the Network Node Interface (NNI) or 
Universal Network Interface (UNI) mode. This parameter is not provisionable by the 
user and is always set to the NNI option (as shown in the example).

The Facility Type group allows you to specify whether the facility is SONET 
(Synchronous Optical Network) or SDH (Synchronous Digital Hierarchy is always 
used with the D50e). SONET is the ANSI (American National Standards Institute) 
standard, and SDH is the ITU (International Telecommunications Union) standard.

Note: If SDH is selected in the Facility Type group, the Path RDI group title on 
this tab changes to HP RDI (High Order Path RDI). On the OC3 Thresholds tab, the 
Interval titles change as follows: Section changes to RS (Regenerator Section), 
Line changes to MS (Multiplex Section), and Path changes to HP (High Order 
Path). These changes in the interface reflect ITU standards for terminology.

The ATM router/switch side must be configured as the same facility type (SONET or 
SDH) as the D50, otherwise an LOP (Loss of Pointer) condition occurs.

Note: The LOP condition refers to the loss of the pointer byte in the path overhead. 
The SONET and SDH standard are roughly the same as far as ATM payload is 
concerned, but there are several differences in the way they handle overhead bytes. 
SDH facilities use two (S1 and S0) bits in the H1 (pointer byte) path overhead to 
identify the payload type (as defined in 3.1.4 ITU G-709). SONET facilities never 
use S1/S0 bits. If an SDH facility receives a payload containing the H1 byte from 
the SONET end (this will happen if the router/switch side and the D50 are 
configured as different facility types), it misinterprets the payload type and declares 
an LOP condition.

The Starvation Cycles group contains the number of starvation cycles. This field 
shows the specified percentage of service to low and medium-priority traffic.

Note: This group is enabled only for the OC3T2 and OC3TQ cards. For the OC3T 
card, this group is not enabled.

Figure 4-30: OC3 Port OC3T Tab
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The percentage of bandwidth available for low-priority traffic is calculated by the 
system as one divided by the value of this field plus one [1/(starvation cycles + 1)], for 
example:
� If the value for this field is set to 0 (zero), no bandwidth is guaranteed to be avail-

able for low-priority traffic.
� If the value for this field is set to 1, then 1/(1+1), or 50% of available bandwidth is 

available for low-priority traffic.
� If the value for this field is set to 2, then 1/(2+1), or 33% of available bandwidth is 

available for low-priority traffic.

The Timing Option group allows you to specify whether to use loop timing (indicating 
that the D50 will extract timing from the OC3 signal) or internal timing (indicating that 
the D50 will use another internal timing source).

The S1 Sync Status group displays the numbers of transmitted and received S1 bits. 
Valid values for the Transmit field are 1 through 15 (the default is 15). The Received 
field is read-only.

The Remote Defect Indicator (RDI) is a byte that is sent from one end of a link to the 
other, to acknowledge the detection or an LOS (Loss of Signal), LOF (Loss of Frame), 
LOP (Loss of Pointer), or AIS (Alarm Indication Signal) condition at the other end. 
The RDI can be initiated from either end (the D50 or the router). The Path RDI group 
allows you to specify additional conditions for which an RDI will be sent upstream. In 
the Mode group, only the Default option is enabled.

You can enable any of the following conditions:
� Loss of Cell Delineation (LCD).
� Payload Label Mismatch.
� Trace Identifier Mismatch.

LCD and Payload Label Mismatch conditions are far less severe than LOS, LOF, LOP, 
or AIS conditions, so enabling RDI for these conditions is optional. By default, both the 
available options are disabled. If either of the groups of Path RDI conditions (LCD or 
Payload Label Mismatch) are enabled, an RDI will be sent upstream upon detection of 
the specified condition.

If you change any of the provisioning parameters, the Apply Changes command 
button is enabled. Click this button to immediately apply the changes to the system.

Note: Changes should only be applied on a port that is disabled. To cancel any 
changes and return the parameters to the original values, close the window without 
clicking the Apply Changes command button.
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OC3 Port OC3 
Thresholds Tab 
Page

Click the OC3 Thresholds tab to display the following tab page.

The Intervals group allows you to specify Section, Line, and Path thresholds for a 
number of parameters for both 15-minute and Daily intervals:
� Code Violations is the count of CP-bit parity errors occurring in the accumulation 

period.
� Errored Seconds is the count of seconds containing one or more CP-bit parity 

errors, one or more SEF defects, or one or more AIS defects.
� Severely Errored Secs is the count of seconds containing more than 44 CP-bit par-

ity errors, one or more SEF defects, or one or more AIS defects.
� Svrly Erred Frmng Secs is the count of seconds containing one or more SEF 

defects or one or more AIS defects.
� Unavailable Seconds is the count of one second intervals during which the OC3 

path is unavailable.

Note: If SDH is selected in the Facility Type group on the OC3T tab, the Interval 
titles on this tab change as follows: Section changes to RS (Regenerator Section), 
Line changes to MS (Multiplex Section), and Path changes to HP (High Order 
Path).

The BERT (Bit Error Rate Threshold) group allows you to set thresholds for the signal 
degrade and signal fail conditions.

For provisioning parameter tables, see the volume titled Provisioning.

After making changes to any of the thresholds, the Apply Changes button becomes 
enabled. Click this button to apply the changes to the MIB.

Figure 4-31: OC3 Port OC3 Thresholds Tab
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OC3 Port Trace 
Data Tab Page

Click the Trace Data tab to display the following tab page.

The Trace Data tab allows you to specify a data pattern to send out to the router/switch. 
Trace data patterns are typically used to identify the node addresses for each end of a 
link. You can specify a trace data pattern for the section and the path.

If the Section group is enabled, you can define trace data patterns for the section. The 
D50 sends the pattern specified in the Transmit box out to the router/switch, then 
compares the received section trace data with the pattern specified in the Expected 
box. If the Received data does not match, a Section Trace Mismatch condition is 
reported.

If the Section group is disabled, any mismatch condition is cleared.

The Size box allows you to specify the number of bytes (either 16 or 64) to enter for the 
trace data patterns. If set to 64 bytes, the CR/LF (Carriage Return/Line Feed) should be 
inserted in byte 63/64 by selecting the CR/LF check box. If set to 16 bytes, the pad 
characters 0x00 are automatically inserted following the input characters, and a CR/LF 
is automatically inserted in byte 63/64.

The Path group options work the same way as the Section group options, but are used 
to set up trace data for the path. If the received data does not match, a Path Trace 
Mismatch condition is reported.

Figure 4-32: OC3 Port Trace Data Tab
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OC3 Port 
Physical PM Tab 
Page

Click the Physical PM tab to display the following tab page.

The Physical PM tab page provides performance monitoring data for the OC3 port. The 
Interval group allows you to select either 15-minute or Daily intervals for performance 
monitoring.

You can track up to 12 bins of performance data in 15-minute intervals. Bin number 1 
contains data for the current 15-minute interval. Bin number 2 contains data for the 
previous 15-minute interval and so on. In the Bin spin box, set the Bin value (1 to 12).

You can track 2 bins of data in daily intervals. Bin number 1 contains data for the 
current day. Bin number 2 contains data for the previous daily interval. In the Bin spin 
box, set the Bin value (1 or 2).

The Type group allows you to specify whether to monitor near-end or far-end data.

The PM Data for . . . group displays the names and values for the parameters listed. 
The title of this group changes to reflect the option selected in the Type group. This list 
includes values for the following parameters:
� CV-P/HP (Code Violation-Path/High Order Path).
� ES-P/HP (Errored Second-Path/High Order Path).
� FC-P/HP (Feedback Control-Line/High Order Path) Unused.
� SES-P/HP (Severely Errored Second-Path/High Order Path).
� UAS-P/HP (Unavailable Seconds-Path/High Order Path).
� CV-L/MS (Code Violation-Line/Multiplexer Section).
� ES-L/MS (Errored Second-Line/Multiplexer Section).
� FC-L/MS (Feedback Control-Line/Multiplexer Section). Unused.
� SES-L/MS (Severely Errored Second-Line/Multiplexer Section).
� UAS-L/MS (Unavailable Seconds-Line/Multiplexer Section).
� PSC-L/MS (Protection Switch Count-Line/Multiplexer Section).
� SEFS-S/RS (Severely Errored Seconds-Section/Regenerator Section).
� Status.

Figure 4-33: OC3 Port Physical PM Tab
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The data will not automatically refresh. You must click the Refresh command button to 
refresh the data manually. Click the Clear command button to clear all the performance 
data for this port. Click the Graph button to display the data in graphical format. See 
Figure 4-35: Graph Window, ATM PM, page 4-43.

The Status in the Data list box will always be either Valid or Invalid. A value of 
Invalid indicates that the data has not been accumulated for the full time of a given 
interval because a bin has been reset. Invalid data should not be used in resolving 
performance issues.

OC3 Port ATM 
PM Tab Page

Click the ATM PM tab to display the following tab page.

The ATM PM (Performance Monitoring) tab page provides information on cells 
received and transmitted, HEC and OCD errors, and the status. The Interval group 
allows you to select either 15-minute or Daily intervals for performance monitoring. 

You can track up to 12 bins of performance data in 15-minute intervals. Bin number 1 
contains data for the current 15-minute interval. Bin number 2 contains data for the 
previous 15-minute interval and so on. In the Bin spin box, set the Bin value (1 to 12).

You can track 2 bins of data in daily intervals. Bin number 1 contains data for the 
current day. Bin number 2 contains data for the previous day. In the Bin spin box, set 
the Bin value (1 or 2).

The data will not refresh automatically. Click the Refresh command button to display 
data for the specified interval. Click the Clear command button to clear all 
performance data. Click the Graph button to display the data in graphical format.

The Status in the Data list box will always be either Valid or Invalid. A value of 
Invalid indicates that the data has not been accumulated for the full time of a given 
interval because a bin has been reset. Invalid data should not be used to resolve 
performance issues.

The Graph window displays when you click the Graph button from a number of 
different tab pages. The options included on the Graph window vary slightly depending 

Figure 4-34: OC3 Port ATM PM Tab
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on the set of data that is being graphed. As an example, the OC3 ATM PM Graph 
window is shown below.

The Graphing group includes a list of parameters that vary depending on the window 
from which the Graph window was accessed.

The Graph window includes a grid where the line graphs are displayed. The grid can 
display any combination of the available parameters—each parameter displays in a 
different color to make it easier to view the information. The grid is divided into 
15-minute intervals, and labeled by bin number.

The Graph Invalid Data check box displays below the grid if data for any of the 
intervals in the selected bin is invalid (not shown in this example). Invalid data displays 
as a dashed line; valid data displays as a solid line. If you do not want to view invalid 
data, click the check box to deselect it.

The following numeric data is displayed on the right side of the Graph window:
� Current data for the current 15-minute interval and current day.
� Historic data for the eleven previous 15-minute bins and for the previous day.

Click the Close command button to close the window, or the Refresh command button 
to refresh the display.

Figure 4-35: Graph Window, ATM PM
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Chapter 1
MLA and LSM Cards

Introduction There are two categories of broadband interface cards:
� MLA1 (Master Line Card Adapter) cards provide a Line Card Shelf (LCS) interface. 

The LCS types are local LCS, Remote LCS (RLCS), or D50 Remote Access Mod-
ule (D50 RAM).

� Broadband tributary cards provide a standard ATM User Network Interface (UNI) 
that supports provisionable VPI/VCI mappings to the D50 trunk card, allowing 
ATM cells to be aggregated from other ATM network equipment.

There are several types of MLA cards for different types of interfaces. For each MLA 
card type, there is a corresponding Line Card Shelf Multiplexer (LSM) card type, as 
shown in the following table. The broadband tributary card types connect to standard 
ATM network equipment rather than to an LSM card.

MLA Cards and 
Ports

A Master Control Shelf (MCS) can hold up to twelve MLA cards providing the 
interface for up to twelve LCSs.

At the MCS, each MLA card provides an interface to one line card shelf: LCS, RLCS, 
or D50 RAM. At each line card shelf, the MLA card interfaces directly with an LSM 
card. Each line card shelf holds one LSM card. Each LSM card multiplexes and 
de-multiplexes ATM cell streams for the shelf’s remaining line cards.

1 "MLA" is the generic name for all MLA-series cards.

Table 5-1: MLA/LSM Cards, Signal, and Interface Equipment Types

MLA Card 
Types

LSM Card 
Types

Signal 
Type

Interface 
Equipment

MLA21

1 MLA2L (long-haul) and MLA2S (single-mode intermediate reach) are also available.

LSM22

2 LSM2S and LSM2L are also available.

OC-3 LCS, RLCS

MLAT1 LSMT1 DS-1 LCS, RLCS, D50 RAM

MLAT3 LSMT3 DS-3 LCS, RLCS, D50 RAM

OC3L None OC-3 Standards-based ATM

DS3L None DS-3 Standards-based ATM
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Broadband 
Tributary Cards

Broadband tributary cards provide a standard ATM UNI interface that supports 
provisionable VPI/VCI mappings to the D50 trunk card, allowing ATM cells to be 
aggregated from standard ATM network equipment. 

There are two types of broadband tributary cards:
� OC3L. Provides a SONET OC-3 interface with a 3-priority 64K cell buffer in both 

the ingress and egress directions.
� DS3L. Provides a DS-3 interface with a 3-priority 64K cell buffer in both the 

ingress and egress directions.

Only one difference distinguishes the port interface for the broadband tributary cards 
and the MLA cards: on the OC3T tab page (for the OC3L card) and the DS3T tab page 
(for the DS3L card), the Addressing Mode group defaults to the UNI option rather 
than to the Network Node Interface (NNI) option. See Figure 4-30: OC3 Port OC3T 
Tab, page 4-37. For the broadband tributary cards, UNI is the only available option. For 
the MLA cards, NNI is the only available option.

To create virtual connections between broadband tributary cards and the trunk, see 
Broadband Tributary Port Connections, page 5-33 “Broadband Tributary Port 
Connections.”

MLA/LSM 
Interface

There are three types of MLA and LSM cards that provide the interface between the 
MCS and LCS:
� MLA2/LSM2. The MLA2 card has a 3-priority 64K cell buffer (supporting 

QoSV4). The MLA2 buffers are in both ingress and egress directions.
� MLAT1/LSMT1. Like the MLA2/LSM2 cards, but provides a quad DS-1 Inverse 

Multiplexed (IMUX) interface, with one IMUX port and four DS-1 ports. The 3-pri-
ority buffers support priority queueing QoSV4.

� MLAT3/LSMT3. Like the MLA2/LSM2 cards, but provides a DS-3 interface. The 
3-priority buffers support priority queueing QoSV4.

The ports on the MLA/LSM cards all display a similar interface aside from a few 
different tabs and some differences in which fields are enabled on the tabs. These 
differences are described briefly in the following paragraphs but more details are 
provided in the descriptions of the individual tabs.

All three MLA/LSM port interfaces (MLA2/LSM2, MLAT1/LSMT1, and 
MLAT3/LSMT3) include fields that support priority queueing QoSV4, but they are 
only active for the MLA2/LSM2, MLAT1/LSMT1 and MLAT3/LSMT3 cards. These 
fields are included on the following tabs:
� Queue Congestion (not LSM2).
� Queue Congestion PM (not LSM2).
� Queue Manager (not LSM2).
� ATM PM (Performance Monitoring).
Page 5-2 Release 11.0
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The MLAT3/LSMT3 port interfaces are similar to the MLA2/LSM2 port interfaces, 
except for the following different tabs:
� The MLAT3/LSMT3 ports include a DS3T tab instead of an OC3T tab.
� The MLAT3/LSMT3 ports include a DS3 Thresholds tab instead of an OC3 Thresh-

olds tab.

The MLAT1/LSMT1 port interfaces are similar to the MLA2/LSM2 port interfaces. 
Unlike the other MLA/LSM cards, the MLAT1/LSMT1 cards display five individual 
ports when the port connection is clicked—one Inverse Multiplex (IMUX) port and 
four DS-1 ports. Clicking one of these ports displays a port interface similar to that for 
the MLA2/LSM2 cards.

The IMUX port interface is similar to the MLA2/LSM2 port interface, but supports the 
DS-1 interface with the following additional tabs:
� DS1.
� DSL Thresholds.
� DSL Frame Thresholds.
� Actuals.

Since it supports DS-1, the IMUX port interface does not include the OC3T tab or the 
OC3 Thresholds tab as does the MLA2/LSM2 port interface.

The DS-1 port interface is the same as that for the IMUX port, except that it does not 
include the ATM PM tab.

MLA/LSM Card 
Interface

Click an MLA card in the MCS equipment locator group or an LSM card in an LCS 
group to display the following tabs:
� Status.
� Config.
� Versions.
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MLA/LSM Card 
Status Tab Page

The Status tab page displays initially.

The Conditions list box displays conditions associated with the selected card. Data in 
the Conditions list box is refreshed by the system at user-specified intervals. The 
interval can be set to 0, which means that the data will not automatically refresh. You 
can specify the polling interval by selecting Options from the Tools menu. The data can 
also be updated by clicking the Refresh icon on the toolbar.

The Administration State group allows you to control whether or not the card is 
available for service. Unlocked makes the card available if there are no other 
conditions blocking its use. Locked makes the card unavailable for service. Cards 
should be locked when being configured, tested, or when making hardware upgrades.

Note: If a card is locked, any alarms for that card will not display in the Active 
Alarms list but they will display in the Conditions box on the card’s Status tab. If an 
alarm condition exists and the unlocked option is selected, an alarm will then be 
displayed in the Active Alarms list. For descriptions of alarm conditions, see the 
volume titled Maintenance and Testing, Section 1—System Monitoring, 
Chapter 2—“Conditions.”

The Create button is only enabled if you have clicked on an unprovisioned slot. 
Clicking this button displays a list of line cards you can create. Select the type of MLA 
or LSM card that you want to create from the list.

The Delete command button is only enabled if you have clicked on a provisioned card. 
Clicking this button will display a warning message that the card is about to be deleted 
from the system, and you can either click the OK button to proceed with deleting the 
card, or click the Cancel button to cancel the operation.

Click the Reset Card button to physically reset the card. Clicking this button displays a 
warning asking if you are sure you want to reset the card. Click the OK button to 
proceed or the Cancel button to cancel the action.

Important! Resetting an MLA card interrupts data flow to the LCS or CPE 
equipment downstream. Resetting an LSM card interrupts data flow to all line 
cards in the LCS served by that LSM.

Figure 5-1: MLA/LSM Card Status Tab
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MLA/LSM Card 
Config Tab Page

Click the Config tab to display the following tab page.

The Configuration list box shows the Serial Number, Hardware Version, CLEI code, 
Name, and Type (Actual and Configured) for the card. This example shows the tab for 
an MLA card, but the Configuration tabs for all the various types of MLA and LSM 
cards include the same categories of information.

MLA/LSM Card 
Versions Tab 
Page

Click the Versions tab to display the following tab page.

The Versions tab lists the various names and values of the subsystem versions.

Figure 5-2: MLA/LSM Card Configuration Tab

Figure 5-3: MLA/LSM Card Versions Tab
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Chapter 2
MLA and LSM Ports

MLA/LSM Ports Click an MLA21/LSM2, MLAT1/LSMT1 or MLAT3/LSMT3 Port indicator in the 
MCS equipment locator group to display a set of tab pages. The different types of ports 
display different sets of tabs, as described in the following sections.

The MLA2 port object views contain the following tabs:
� Status.
� Test.
� OC3T.
� OC3 Thresholds.
� Physical PM.
� ATM PM.
� Queue Manager.
� Queue Congestion PM.

The LSM2 port object views contain all the tabs that the MLA2 port object view 
includes, except for the following tabs:
� Queue Manager.
� Queue Congestion PM.

The MLAT3/LSMT3 port interfaces are the same, except that the OC3T and OC3 
Thresholds tabs are replaced by the DS3T and DS3 Thresholds tabs. This interface 
supports ingress congestion and queue tabs.

The MLAT1/LSMT1 port interfaces initially display a set of ports instead of a set of 
tabs, one IMUX port and four individual DS-1 ports. The IMUX port interface is the 
same as the MLA/LSM port interface, except that the OC3T and OC3 Thresholds tabs 
are replaced by the DS1, DSL Thresholds, and DSL Frame Thresholds tabs. This 
interface also includes an Actuals tab. 

1 "MLA" is the generic name for all MLA-series cards.

Figure 5-4: MLAT1/LSMT1 Port Interface
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The DS-1 port interface is the same as the IMUX port interface except that it does not 
include the ATM PM tab.

MLA/LSM Port 
Status Tab Page

The Status tab displays initially.

Note: The LSM port Status tab has the same look-and-feel as the MLA port, but the 
LSM port interface is different in that it does not include Queue Manager, Queue 
Congestion, or Queue Congestion PM tabs.

The Conditions list box displays conditions associated with the selected port. Data in 
the Conditions list box is refreshed by the system at user-specified intervals. The 
interval can be set to 0, which means that the data will not automatically refresh. You 
can specify the polling interval by selecting Options from the Tools menu. The data can 
also be updated by clicking the Refresh icon on the toolbar.

The Administration State group allows you to control whether or not the port is 
available for service. Unlocked makes the port available if there are no other 
conditions blocking its use. Locked makes the port unavailable for service. Ports 
should be locked when being configured, when making hardware upgrades, or when 
testing.

Note: If a card is locked, any alarms for that card will not display in the Active 
Alarms list but they will display in the Conditions box on the card’s Status tab. If an 
alarm condition exists and the unlocked option is selected, an alarm will then be 
displayed in the Active Alarms list. For descriptions of alarm conditions, see the 
volume titled Maintenance and Testing, Section 1—System Monitoring, 
Chapter 2—“Conditions.”

Figure 5-5: MLA Port Status Tab
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MLA/LSM Port 
Test Tab Page

Click the Test tab to display the following tab page.

The Test tab enables testing for the MLA and LSM cards.

Note: The LSM port Test tab is the same as the MLA port Test tab except that LSM 
card ports also support Line test mode.

The Test Mode group allow you to select the type of testing to perform. The only 
available test mode in this group is Terminal. This test mode will test the line to the 
subscriber’s modem—no data out of the system.

Figure 5-6: MLA Port Test Tab
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Test Duration sets the interval in seconds that the system should wait before stopping 
the test. Use the Test Command buttons to Start and Stop testing.

Important! All diagnostic tests interrupt data flow through the system. Do not 
perform on a D50 that is providing service. Only use diagnostic tests during 
commissioning procedures or in a lab environment to isolate trouble in the 
system.

For additional information on Diagnostic Test Modes, see the volume titled 
Maintenance and Testing.

MLA/LSM Port 
OC3T/DS3T/DS1 
Tab Pages

Depending on which type of MLA/LSM port you are working with, you can display 
one of the following tab pages:
� The OC3T tab page (MLA2/LSM2 cards only).
� The DS3T tab page (MLAT3/LSMT3 cards only).
� The DS1 tab page (MLAT1/LSMT1 cards only).

Table 5-2: Test Duration Table

Card Type Port Type
Default Test 

Duration 
(in seconds)

MLA2 OC3 480

MLAT1 IMUX 28800

MLAT1 DS1 28800

MLAT3 DS3 60

LSM OC3 480

LSM2 OC3 480

LSMT1 IMUX 28800

LSMT1 DS1 28800

LSMT3 DS3 60
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These tabs are all used to provision the various signals for the cards’ ports, as shown in 
the following table.

MLA/LSM Port 
OC3T Tab Page

If you are working with the MLA2/LSM2 cards, click the OC3T tab to display the 
following tab page.

The OC3T tab page enables provisioning of the OC3 signal on the MLA2/LSM2 ports.

The Addressing Mode group box indicates either the Network Node Interface (NNI) 
or Universal Network Interface (UNI) mode. This parameter is not provisionable by the 
user, but depends instead on the card type:
� For MLA2/LSM interconnect cards, this parameter is always set to the NNI option.
� For the OC3L broadband card, this parameter is always set to the UNI option.

The Facility Type group allows you to specify whether the facility is SONET 
(Synchronous Optical Network) or SDH (Synchronous Digital Hierarchy). SONET is 
the ANSI standard, and SDH is the ITU (International Telecommunications Union) 
standard.

Note: If SDH is selected in the Facility Type group, the Path RDI group title on 
this tab changes to HP RDI (High Order Path RDI). On the OC3 Thresholds tab, the 

Table 5-3: MLA/LSM Card Pairs and Signal Types

MLA/LSM Interconnect 
Pair

Signal Provisioning 
Tab Page

Signal 
Type

MLA2/LSM2 OC3T OC-3

MLAT1/LSMT1 DS1 DS-1

MLAT3/LSMT3 DS3T DS-3

Figure 5-7: OC3T Tab (MLA/LSM2 and MLA2/LSM2 Port)
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Interval titles change as follows: Section changes to RS (Regenerator Section), 
Line changes to MS (Multiplex Section), and Path changes to HP (High Order 
Path). These changes in the interface reflect ITU terminology standards.

The facility type (SONET or SDH) must be the same at both the far and near-end to 
avoid and LOP (Loss of Pointer) condition.

Note: The LOP condition refers to the loss of the pointer byte in the path overhead. 
The SONET and SDH standard are roughly the same as far as ATM payload is 
concerned, but there are several differences in the way they handle overhead bytes.
SDH facilities use two (S1 and S0) bits in the H1 (pointer byte) path overhead to 
identify the payload type (as defined in 3.1.4 ITU G-709). SONET facilities never 
use S1/S0 bits. If an SDH facility receives a payload containing the H1 byte from 
the SONET end (this will happen if the far-end and near-end are configured with 
different facility types), it misinterprets the payload type and declares an LOP con-
dition.

The Timing Option group allows you to specify whether to use loop timing (indicating 
the D50 will extract transmit timing from the OC3 signal) or internal timing (indicating 
the D50 will use the trunk as its timing source).

The S1 Sync Status group displays the numbers of transmitted and received S1 bits. 
These fields are read-only.

The Starvation Cycles group allows you to specify the number of starvation cycles in 
both the ingress and egress directions. This field allows you to allocate a specified 
amount of service for low or medium-priority traffic2. The percentage of bandwidth 
available for low-priority traffic is calculated by the system as one divided by the value 
of this field plus one [1/(starvation cycles + 1)], for example:
� If the value for this field is set to 0 (zero), no bandwidth is guaranteed to be avail-

able for low-priority traffic.
� If the value for this field is set to 1, then 1/(1+1), or 50% of the available bandwidth 

is available for low-priority traffic.
� If the value for this field is set to 2, then 1/(2+1), or 33% of the available bandwidth 

is available for low-priority traffic.

The Remote Defect Indicator (RDI) is a byte that is sent from one end of a link to the 
other, to acknowledge the detection or an LOS (Loss of Signal), LOF (Loss of Frame), 
LOP (Loss of Pointer), or AIS (Alarm Indication Signal) condition at the other end. 
The RDI can be initiated from either end (the D50 or the router). The Path RDI group 
allows you to specify additional conditions for which an RDI will be sent upstream.

You can enable one or both of the following conditions:
� Loss of Cell Delineation. Loss of Cell Delineation (LCD) condition.
� Payload Label Mismatch. Payload Label Mismatch (PLM) condition. An RDI will 

be sent to the far-end connection upon detection of this condition.

The Mode and Trace Identifier Mismatch options are not enabled for the MLA/LSM 
cards.

2 Medium or low-priority queue is selected on LSM card. 
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LCD and Payload Label Mismatch conditions are far less severe than LOS, LOF, LOP, 
or AIS conditions, so enabling RDI for these conditions is optional. By default, both the 
available options are disabled. If either of the groups of Path RDI conditions (LCD or 
Payload Label Mismatch) are enabled, an RDI will be sent upstream upon detection of 
the specified condition.

If you change any of the provisioning parameters, the Apply Changes command 
button is enabled. Click this button to immediately apply the changes to the system.

Note: Changes should only be applied on a port that is disabled. To cancel any 
changes and return the parameters to the original values, close the window without 
clicking the Apply Changes command button.

MLAT3/LSMT3 
Port DS3T Tab 
Page

If you are working with the MLAT3/LSMT3 cards, click the DS3T tab to display the 
following tab page. 

The Addressing Mode group box indicates either the Network Node Interface (NNI) 
or Universal Network Interface (UNI) mode. For MLA2/LSM cards, this option is 
always set to NNI. This parameter is not provisionable and is set by the card type:
� For MLA2/LSM interconnect cards, this parameter is always set to NNI.
� For the DS3L and OC3L broadband cards, this parameter is always set to UNI.

The Cell Scrambling radio buttons disable or enable a feature that prevents false error 
detection on the cell payload. Since direct mapping uses the HEC for cell delineation, it 
is possible that a five-byte pattern with valid ATM cell overhead will appear in the 
payload. Scrambling reduces the possibility of false lock. 

The Starvation Cycles group allows you to specify the number of starvation cycles in 
both the ingress and egress directions. This field allows you to allocate a specified 
amount of service for low or medium-priority traffic3. The percentage of bandwidth 

Figure 5-8: DS3T Tab (MLAT3/LSMT3 Port)

3 Medium or low-priority queue is selected on LSM card. 
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available for low-priority traffic is calculated by the system as one divided by the value 
of this field plus one [1/(starvation cycles + 1)], for example:
� If the value for this field is set to 0 (zero), no bandwidth is guaranteed to be avail-

able for low-priority traffic.
� If the value for this field is set to 1, then 1/(1+1), or 50% of the available bandwidth 

is available for low-priority traffic.
� If the value for this field is set to 2, then 1/(2+1), or 33% of the available bandwidth 

is available for low-priority traffic.

The HEC Coset group allows you to disable or enable Header Error Check (HEC) 
coset. When enabled, this feature ensures non-zero values for HECs in idle ATM cells. 
HEC is an 8-bit field (the last byte) of the ATM cell header, and it allows a receiver to 
detect (and possibly correct) transmission errors in the cell header. It is used for 
checking integrity only and counts only HEC errors that cannot be corrected.

Line Build Out is a cable equalization method on the transmit side of the DS3 line. 
The options are Low or High, which adjusts equalization to reflect the length of the 
DS3 cable. The DS3 trunk Line Interface Unit (LIU) supports two levels of line build 
out (this is the length of the coax cable from the MCS backplane to the other end of the 
DS3 connection, the router, or ATM switch): 
� Low is used for coax cables shorter than 50 feet (default).
� High is used for long distances (a maximum of 910 feet in length).

The Line Type group allows you to select a DS3 frame format.
� Direct Mapping CBit provides the most data throughput and is the preferred oper-

ating mode. Some equipment does not support this mode, in which case one of the 
PLCP modes should be selected. Cell Scrambling and HEC Coset should be 
enabled.

� Direct Mapping M23 is typically only used with older equipment. Cell Scrambling 
and HEC Coset should be enabled when this mode is selected.

� PLCP CBit (the default) is the preferable mode of the two PLCP (Physical Layer 
Convergence Protocol) modes, since it provides better performance monitoring 
(PM) information. Cell Scrambling should be disabled and HEC Coset should be 
enabled.

� PLCP M23 is typically only used with older equipment. Cell Scrambling should be 
disabled and HEC Coset should be enabled.

The Line Timing group enables you to select the type of timing resource for the signal.
� Loop. The system extracts timing from the DS-3 signal.
� Internal. The system supplies timing from an internal source.
� Loop PLCP. The system extracts timing from PLCP.
� Internal PLCP. The system supplies timing from an internal PLCP source.

Note: The HEC Coset, line type, and line timing options selected must match the 
options set on the ATM router or switch at the far-end of the loop.
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MLAT1/LSMT1 
IMUX Port DS1 
Tab Page

If you are working with the MLAT1/LSMT1 IMUX port, click the DS1 tab to display 
the following tab page.

The Line Type group allows you to select a DS1 framing format:
� Extended Super Frame (ESF). This is the default and recommended setting. This 

format uses the framing bit for non-intrusive signaling and control. 8000 framing 
bits are sent per second, of which 2000 framing bits are required for synchroniza-
tion, which leaves 6000 framing bits available for error detection, CRC (cyclic 
redundancy checking), and data link monitoring and maintenance. Using this for-
mat, the data payload will remain intact and the full 1.536 Mbps will be available 
for user data.

� Super Frame (SF). This format combines 24 DS0 time slots and a coded framing 
bit to form a frame. Twelve of these frames are combined to create the super frame.

The Transmit Clock Source group enables you to select the type of timing resource 
for the signal.
� Loop. The system extracts timing from the DS-1 signal.
� Internal. The system supplies timing from an internal source.

The Starvation Cycles group allows you to specify the number of starvation cycles in 
both the ingress and egress directions. This field allows you to allocate a specified 
amount of service for low or medium-priority traffic4. The percentage of bandwidth 
available for low-priority traffic is calculated by the system as one divided by the value 
of this field plus one [1/(starvation cycles + 1)], for example:
� If the value for this field is set to 0 (zero), no bandwidth is guaranteed to be avail-

able for low-priority traffic.

Figure 5-9: DS1 Tab (MLAT1/LSMT1 IMUX Port)

4 Medium or low-priority queue is selected on LSM card. 
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� If the value for this field is set to 1, then 1/(1+1), or 50% of the available bandwidth 
is available for low-priority traffic.

� If the value for this field is set to 2, then 1/(2+1), or 33% of the available bandwidth 
is available for low-priority traffic.

MLAT1/LSMT1 
DS1 Port DS1 
Tab Page

If you are working with a MLAT1/LSMT1 DS1 port, click the DS1 tab to display the 
following tab page. 

The Line Build Out group allows you to specify a cable length (in feet). The default is 
100 (feet).

The rest of the fields are not enabled for the DS-1 ports.

Figure 5-10: DS1 Tab (MLAT1/LSMT1 DS1 Ports)
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MLA2/LSM Port 
OC3/DS3/DSL 
Thresholds Tabs

Depending on which type of MLA/LSM ports you are working with, you can display 
the OC3 Thresholds tab page (MLA2/LSM2, and OC3L cards only), the DS3 
Thresholds tab page (MLAT3/LSMT3 and DS3L cards only), or the DSL Thresholds 
and DSL Frame Thresholds tab pages (MLAT1/LSMT1 cards only). 

These tabs are all used to provision the various error thresholds for the cards’ ports, and 
are summarized in the following table.

Table 5-4: Threshold Tabs for the MLA/LSM Ports

Card Types Threshold Provisioning Tab 
Pages

MLA2/LSM2
MLAE/LSME
OC3L

OC3 Thresholds

MLAT1/LSMT1 (both IMUX and 
DS1 ports)

DSL Thresholds
DSL Frame Thresholds

MLAT3/LSMT3
DS3L

DS3 Thresholds
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MLA2/LSM Port 
OC3 Thresholds 
Tab Page

If you are working with either the MLA2/LSM or the MLA2/LSM2 cards, click the 
OC3 Thresholds tab to display the following tab page.

The Intervals group allows you to specify Section, Line, and Path thresholds for a 
number of parameters for both 15-minute and Daily intervals:
� Code Violations is the count of CP-bit parity errors occurring in the accumulation 

period.
� Errored Seconds is the count of seconds containing one or more CP-bit parity 

errors, one or more SEF defects, or one or more AIS defects.
� Severely Errored Secs is the count of seconds containing more than 44 CP-bit par-

ity errors, one or more SEF defects, or one or more AIS defects.
� Svrly Erred Frmng Secs is the count of seconds containing one or more SEF 

defects or one or more AIS defects.
� Unavailable Seconds is the count of one second intervals during which the OC3 

path is unavailable.

Note: If SDH is selected in the Facility Type group on the OC3T tab, the Interval 
titles on this tab change as follows: Section changes to RS (Regenerator Section), 
Line changes to MS (Multiplex Section), and Path changes to HP (High Order 
Path).

The BERT (Bit Error Rate Threshold) group allows you to set the signal degrade 
condition.

For provisioning parameter tables, see the volume titled Provisioning.

After making changes to any of the thresholds, the Apply Changes button becomes 
enabled. Click this button to apply the changes to the MIB.

Figure 5-11: OC3 Thresholds Tab (MLA2/LSM and MLA2/LSM2 Port)
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If you are working with the MLAT3/LSMT3 cards, click the DS3 Thresholds tab to 
display the following tab page.

The Intervals group allows you to specify thresholds for both 15-minute and Daily 
intervals. Valid values are 6 through 9 (10-x BER).
� CVCP-P. Code Violation-Path is the count of CP-bit parity errors occurring in the 

accumulation period.
� CVPLCP-P. Code Violation-PLCP-Path is the count of BIP-8 code errors in the 

accumulation period.

The BERT (Bit Error Rate Threshold) group allows you to set the signal degrade 
condition. Valid values are 6 through 9 (10-x BER).

For provisioning parameter tables, see the volume titled Provisioning.

After making changes to any of the thresholds, the Apply Changes button becomes 
enabled. Click this button to apply the changes to the MIB.

Figure 5-12: DS3 Thresholds tab (MLAT3/LSMT3 Port)
Release 11.0 Page 5-19
© 2002 Nokia. Proprietary Data.



Volume 6, Section 5: MLA and LSM Interface Cards and Ports
MLAT1/LSMT1 Port DSL Thresholds Tab Page
MLAT1/LSMT1 
Port DSL 
Thresholds Tab 
Page

If you are working with the MLAT1/LSMT1 cards, click the DSL Thresholds tab to 
display the following tab page. 

The Failure Thresholds group allows you to specify thresholds for a number of 
parameters, for both 15-minute and Daily intervals.

For tables of provisioning thresholds, see the volume titled Provisioning.

After making changes to any of the thresholds, the Apply Changes button becomes 
enabled. Click this button to apply the changes to the MIB.

Figure 5-13: DSL Thresholds tab (MLAT1/LSMT1 Ports)
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If you are working with the MLAT1/LSMT1 cards, click the DSL Frame Thresholds 
tab to display the following tab page. 

The Intervals group allows you to specify 15-minute and Daily threshold values for 
several parameters in the Line Near, Path Near, DLCC Near, and DLCC Far columns.

Note: The example shown is for the IMUX port; for the DS-1 port interface, all the 
fields are enabled (not grayed out).

For tables of provisioning thresholds, see the volume titled Provisioning.

After making changes to any of the thresholds, the Apply Changes button becomes 
enabled. Click this button to apply the changes to the MIB.

Figure 5-14: DSL Frame Thresholds tab (MLAT1/LSMT1 Ports)
Release 11.0 Page 5-21
© 2002 Nokia. Proprietary Data.



Volume 6, Section 5: MLA and LSM Interface Cards and Ports
MLAT1/LSMT1 Port Actuals Tab Page
MLAT1/LSMT1 
Port Actuals Tab 
Page

If you are working with the MLAT1/LSMT1 cards, click the Actuals tab to display the 
following tab page.

The MLAT1/LSMT1 Port Actuals tab page displays ATUC connectivity data. This 
information is read-only. 

The scrollable list includes the following actuals for the ATUC (for the IMUX port):

Transmission Status
� Transmit Rate.
� Cells Received.
� Cells Transmitted.

Data Path Data
� Provisioned IMUX Ports.
� Actual IMUX Ports.

Error Data
� LOF (Loss of Frame) Failures.
� LOF (Loss of Frame) Seconds.
� Errored Seconds.
� Coding Violations.
� FE (Far End) Errored Seconds.
� FE Coding Violations.
� HEC (Header Error Control) Errors.
� Bad Prov. Status.

Time Data
� Elapsed Time (current 15 minutes).
� Elapsed Time (current 24 hours).
� Elapsed Time (previous day).

Figure 5-15: Actuals Tab (MLAT1/LSMT1 Ports)
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The scrollable list includes the following actuals for the ATUC (for the DS1 ports):

Transmission Status
� Transmit Rate.

Error Data
� LOF Failures.
� LOS Failures.
� LCD (Loss of Cell Delineation) Failures.
� LOF Seconds.
� LOS Seconds.
� LCD Seconds.
� CV-L (Code Violation-Line).
� ES-L (Errored Second-Line).
� SES-L (Severely Errored Second-Line).
� UAS-L (Unavailable Seconds-Line).
� CV-P (Code Violation-Path).
� ES-P (Errored Second-Path).
� SES-P (Severely Errored Second-Path).
� SAS-P (SEF/AIS Second-Path).
� UAS-P (Unavailable Seconds-Path).
� Errored Seconds.
� Coding Violations.
� FE Errored Seconds.
� FE Coding Violations.
� Bad Prov. Status.

Time Data
� Elapsed Time (current 15 minutes).
� Elapsed Time (current 24 hours).
� Elapsed Time (previous day).

Click the Locally Reset Counters button to reset all values to 0 (zero) for the current 
view, as shown in the example. After being reset, the values will begin incrementing 
again based on data accumulated from the point at which the counters were reset. 
Resetting the counters only affects the current view. Data continues to accumulate 
“behind the scenes,” and if the current view is closed and another view is opened, the 
new view displays values based on the entire reporting period.
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For any of the three types of MLA/LSM cards, click the Physical PM tab to display the 
following tab page.  

The Physical PM (Performance Monitoring) tab page provides information on 
performance monitoring. 

The Interval group allows you to specify either 15-minute or Daily intervals.

You can track up to 12 bins of performance data in 15-minute intervals. Bin number 1 
contains data for the current 15-minute interval. Bin number 2 contains data for the 
previous 15-minute interval and so on. In the Bin spin box, set the Bin value (1 to 12).

You can track 2 bins of data in daily intervals. Bin number 1 contains data for the 
current day. Bin number 2 contains data for the previous day. In the Bin spin box, set 
the Bin value (1 or 2).

The Type group allows you to specify whether to monitor near-end or far-end data.

The PM Data for . . . group displays the names and values for the parameters listed. 
The title of this group changes to reflect the option selected in the Type group. This list 
includes different parameters for the different types of cards, as described in the 
following lists.

The MLA, MLA2, LSM, LSM2, and OC3L cards display values for the following PM 
parameters:
� CV-P/HP (Code Violation-Path/High-Order Path).
� ES-P/HP (Errored Second-Path/High-Order Path).
� FC-P/HP (Feedback Control-Path/High-Order Path).
� SES-P/HP (Severely Errored Seconds-Path/High-Order Path).
� UAS-P/HP (Unavailable Seconds-Path/High-Order Path).
� CV-L/MS (Code Violation-Line/Multiplexer Section).
� ES-L/MS (Errored Seconds-Line/Multiplexer Section).
� FC-L/MS (Feedback Control-Path/Multiplexer Section).

Figure 5-16: MLA/LSM Port Physical PM Tab
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� SES-L/MS (Severely Errored Seconds-Line/Multiplexer Section).
� UAS-L/MS (Unavailable Seconds-Line/Multiplexer Section).
� PSC-L/MS (Protection Switch Count/Multiplexer Section).
� SEFS-S/RS (Severely Errored Framing Seconds-Section/Regenerator Section).
� Status.

The MLAT3, LSMT3, and DS3L cards display the following set of parameters:
� Code Violation-Path (CVCP-P).
� Errored Second-Path (ESCP-P).
� Severely Errored Second-Path (SESCP-P).
� SEF/AIS Second-Path (SAS-P).
� Unavailable Seconds-Path (UASCP-P).
� Code Violation PLCP-Path (CVPLCP-P).
� Errored Second PLCP-Path (ESPLCP-P).
� Severely Errored Second PLCP-Path (SESPLCP-P).
� Severely Errored Framing Second PLCP-Path (SEFSPLCP-P).
� Unavailable Second PLCP-Path (UASPLCP-P).
� Errored Second-Line (ES-L).
� Status.

The MLAT1 and LSMT1 cards’ IMUX ports display values for the following PM 
parameters:
� LOF Seconds.
� LOS Seconds.
� Errored Seconds.
� Code Violations.
� Elapsed Time (current 15 minutes).
� Elapsed Time (current 24 hours).
� Elapsed Time (previous day).
� Status.

The MLAT1 and LSMT1 card’s DS-1 ports display the same set of PM parameters as 
the IMUX port, and also include the following:
� LCD Seconds.
� CV-L.
� ES-L.
� SES-L.
� UAS-L.
� CV-P.
� ES-P.
� SES-P.
� SAS-P.
� UAS-P.
� Errored Seconds.
� Code Violations.
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The data will not automatically refresh. You must click the Refresh command button to 
refresh the data manually. Click the Clear command button to clear all the performance 
data for this port. Click the Graph button to display the data in graphical format.

The Status in the Data list box will always be either Valid or Invalid. A value of 
Invalid indicates that the data has not been accumulated for the full time of a given 
interval because a bin has been reset. Invalid data should not be used in resolving 
performance issues.

MLA/LSM Port 
ATM PM Tab 
Page

Click the ATM PM tab to display the following tab page. 

The ATM PM (Performance Monitoring) tab provides information on cells received 
and transmitted, and dropped due to HEC and OCD, and the status. 

The Interval group allows you to specify either 15-minute or Daily intervals. 

You can track up to 12 bins of performance data in 15-minute intervals. Bin number 1 
contains data for the current 15-minute interval. Bin number 2 contains data for the 
previous 15-minute interval and so on. In the Bin spin box, set the Bin value (1 to 12).

You can track 2 bins of data in daily intervals. Bin number 1 contains data for the 
current day. Bin number 2 contains data for the previous day. In the Bin spin box, set 
the Bin value (1 or 2).

The data will not automatically refresh. You must click the Refresh command button to 
refresh the data manually. Click the Clear command button to clear all the performance 
data for this port. Click the Graph button to display the data in graphical format.

The Status in the Data list box will always be either Valid or Invalid. A value of 
Invalid indicates that the data has not been accumulated for the full time of a given 
interval because the bin has been reset, or because at some time during the interval the 
port was in an LOS or LOF condition. Invalid data should not be used to resolve 
performance issues.

Figure 5-17: MLA/LSM Port ATM PM Tab
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Click the Graph button on the ATM PM tab to display the following window.

The ATM PM Graph window is accessible from a number of tabs, and displays 
different options as appropriate for the tab from which it was accessed. The Graphing 
group box includes a list of parameters that vary depending on the window from which 
the Graph window was accessed. Click the check box next to each parameter to 
select/deselect it for display in the grid.

The grid on the Graph window displays line graphs of the specified parameters. The 
grid can display any combination of the available parameters—each parameter displays 
in a different color to make it easier to view the information. The grid is divided into 
15-minute intervals, and labeled by bin number.

The Graph Invalid Data check box displays below the grid if data for any of the 
intervals in the selected bin is invalid. Invalid data displays as a dashed line and valid 
data displays as a solid line. If you do not want to view invalid data, click the check box 
to deselect it.

The following numeric data is displayed on the right side of the Graph window:
� Current data for the current 15-minute interval and current day.
� Historic data for the eleven previous 15-minute bins and for the previous day.

Click the Close button to close the window, or the Refresh button to refresh the 
display.

Figure 5-18: Graph Window, ATM PM (MLA/LSM Port)
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Click the Queue Manager tab to display the following tab page. 

The Queue Manager tab allows you to specify which of the priority queuing buffers to 
view. The Select Queue group box is used to provision the priority queuing buffers. 
You can specify which queue to view by Priority (Low, Medium, or High) and 
Direction (Ingress or Egress).

As different options are selected in these fields, the Manager Data for . . . title above 
the group changes to reflect the current selections.

Figure 5-19: MLA Port Queue Manager Tab
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The following table shows which Queue Management parameters are provisionable on 
each card (“n/p” means “not provisionable”).

The Priority and Direction fields are only enabled for the MLA2, MLAT1, and 
MLAT3 cards. This feature is not selectable on the MLA card since it has only one 
queue by default. The one queue does not support QoSV4 priority queuing.

On the MLA2 and MLAT3 cards, the high, medium, and low-priority queues monitor 
the queue buffer depth of the IMUX port. The MLAT1 medium and low-priority 
queues also monitor queue buffer depth, but the MLAT1 high-priority queue monitors 
the bandwidth utilization levels of all four IMUX DS-1 links. An alarm is generated 
when queue capacity exceeds the Severe Level % capacity of the queue buffer. To 
activate this feature, select the Congestion Measurement Enable button.

The Conditions box lists any conditions pertaining to the buffers.

The EPD/PPD group box includes check boxes that allow provisioning of the 
EPD/PPD (Early Packet Discard/Partial Packet Discard) and EFCI (Explicit Forward 
Congestion Indicator) features:
� EPD/PPD Enable. Enable/disable EPD and PPD for the port. EPD adds a measure 

of intelligence to the handling of PDUs which helps to reduce the number of partial 
packets that are transmitted. Rather than discarding PDUs that have been partially 
transmitted, EPD transmits only intact PDUs, based on the thresholds set on this tab. 

Table 5-5: Queue Management Parameters Provisionable by Cards

Card Type
Direction

Priority Ingress Egress

Line Cards YES N/A N/P
(preset to Egress)

LSMT1 (IMUX port) YES N/P
(preset to Ingress)

N/A

LSMT3 YES N/P
(preset to Ingress)

N/A

MLA2 YES YES YES

MLAT11 (IMUX port)

1 Unlike other MLA cards, the MLAT1 card high-priority queue is used to monitor, track and report bandwidth
utilization levels of all four IMUX DS-1 links. An alarm is generated when the congestion level exceeds the
Severe Level % bandwidth utilization threshold. The low and medium-priority queues monitor buffer depth
on all MLA cards.

YES YES YES

MLAT3 YES YES YES

Broadband tributary cards YES YES YES

Trunk cards, LSM2 N/P N/P N/P
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This option should only be enabled (the default) if the queue will be carrying con-
nections supporting ATM Adaption Layer (AAL) Type 5. EPD can also be provi-
sioned at the connection level. If a queue will be carrying a combination of AAL5 
and other protocols, EPD/PPD should be enabled at the port level, and enabled for 
the individual connections that will be carrying AAL5 traffic exclusively, and dis-
abled for those connections not carrying AAL5 data.

� EFCI Enable. Enable/disable EFCI for the port.

Thresholds can be specified for each of these parameters, including:
� PPD. Specifies the threshold above which partial packets (Protocol Data Units, or 

PDUs) will be discarded. The default is 95.0 (95%).
� EPD Onset. Specifies the threshold above which PDUs will be discarded. The 

default is 75.0 (75%). A PDU that is being transmitted when this threshold is 
reached will be transmitted in its entirety, and any subsequent PDUs will be dis-
carded.

� EPD Abate. Specifies the threshold below which PDUs will be transmitted. The 
default is 65.0 (65%).

The EFCI group  allows you to provision the EFCI (Explicit Forward Congestion 
Indicator) features.
� EFCI Enable. This check box is used to enable/disable EFCI for the port.
� Enter the threshold above which EFCI will be applied to packets. The default is 65.0 

(65%).

Click the Queue Size command button to display a dialog box where the queue size 
can be viewed and changed. The number displayed in the Queue Size box reflects the 
current provisioning for the queue selected in the Priority list on the Queue Manager 
tab.

Note: This is a data affecting action. Changing the queue size is not recommended. 
You can click the OK button to proceed with the action or the Cancel button to 
cancel any changes to the Queue Size field.

The total buffering available for all three queues of an MLA2, MLAT1 (IMUX port), 
MLAT3, LSMT1 (IMUX port), LSMT3, DS3L or OC3L card is 64511 cells, so the 
total size of all three queues should not exceed 64511. The default allocations are as 
follows:
� Low priority = 45067 cells.

Figure 5-20: Low Priority Queue Default Size
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� Medium priority = 19316 cells.
� High priority = 128 cells.

Note: Although the MLA2 card does not support priority queue provisioning, the 
Queue Size box does display the number of cells in the one fixed-size queue (2048). 
This value is modifiable.

Since the default sizes for the three queues use the entire available buffering, increasing 
the size of one queue requires that you decrease the size of another by at least the same 
number of cells to make the required buffering available. You should decrease the size 
of the other queue first, otherwise a provisioning error will occur. If the total size of all 
three queues exceeds the maximum available buffering, the condition will display in 
the Conditions list on the Queue Manager tab.

The Congestion Measurement group box includes a check box to enable/disable 
congestion measurement. A Weight Factor between .001 and 1.000 can be specified 
(the default is .300). The weight factor is used to smooth data samples5. A value of 1 
means that no weighting is applied to the current sample to calculate the measure of 
congestion. Congestion measurement is disabled by default.

The Levels and Reporting Periods group box enables provisioning of thresholds for 
the following parameters:
� Severe level. Level at which an alarm will be reported if the level stays above the 

specified Abate level for the specified number of Active report seconds. The 
default is 90%.

� Abate level. Level below which an alarm will clear if the level stays below the 
specified Abate level for the specified number of Clear report seconds. The default 
is 70%.

� Intermediate level. Level at which a threshold report will be generated. Only one 
report will be generated per five-minute interval. The default is 40%.

� Active report. Time in seconds (default of 30) before an alarm is reported if:
– The level exceeds the specified Severe level, and
– Stays above the specified Abate level for the specified number of Active report 

seconds.
� Clear report. Time in seconds before an alarm clears if the level stays below the 

specified Abate level. The default is 30 seconds.

After changing the provisioning for a port, click the Apply Changes command button 
to save the provisioning information to the MIB.

5 Data is smoothed for all cards and priority queues that measure buffer occupancy. Only the high-priority 
queue on the MLAT1 card measures bandwidth utilization. Measuring bandwidth utilization does not 
require a weight factor so the data is not smoothed.
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Click the Queue Congestion tab to display the following tab page. 

The Queue Congestion PM (Performance Monitoring) tab provides information on 
ingress and egress data congestion for each of the three queues (Low, Medium, and 
High).

The Interval group is a static (non-configurable) 5-minute value.

You can view up to 12 five-minute bins of performance data. The data in Bin number 1 
contains data for the current interval. Bin number 2 contains data for the previous 
interval and so on.

Use the Priority and Direction fields to specify the queue for which you want to view 
data. As different options are selected in these fields, the PM Data for . . . title above 
the group changes to reflect the current selections.

Note: The Priority and Direction fields are not enabled on the MLA card.

In the Bin spin box, set the Bin value (1 to 12). The bin will contain the maximum and 
minimum smoothed values that occurred in that five-minute period.

The data will not automatically refresh. You must click the Refresh command button to 
refresh the data manually. Click the Clear command button to clear all the performance 
data for this port. Click the Graph button to display the data in graphical format.

The PM Data for . . . box displays the following items of data for bin 1:
� Current value for the period.
� Maximum value for the period.
� Minimum value for the period.
� Count value for the period.
� Dropped value for the period.
� Status of the queue.

Figure 5-21: MLA Port Queue Congestion PM Tab
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For bins 2 through 12, only the following items of data display:
� Minimum and maximum values for the period.
� Status of the queue.

The advantage of displaying the current bin is that by selecting the Refresh button, 
both new and old data can be displayed so that the values can be compared.

Click any of the column headings and drag to resize them.

Broadband 
Tributary Port 
Connections

Unlike the Connections tab available on the line card ports, use the Tools menu to show 
current connections and for the ability to create new connections for broadband 
tributary card ports.

Select Show Connections... Tools menu item to display the (system-wide) 
Connections dialog box.

The Connections dialog box lists all current connections by ID and shows the VPI/VCI 
addresses for the Link A and Link Z sides of the connection. Any conditions are also 

Figure 5-22: Show Connections Tools Menu Item

Figure 5-23: Connections Dialog Box (System-Wide)
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listed. Select any connection ID and click the Show Connection button to display 
connection details.

Select New Connection... from the Tools menu to display the New Connection dialog 
box.

For connection details, see Chapter 9—“Connection Dialog Boxes,” page 6-143.
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SECTION 6LINE CARD SHELF AND CARDS

Chapter 1
Line Card Shelf (LCS)

Introduction The LCS contains the line cards that communicate with the ATM network. A D50 
system can include up to twelve LCSs. Each LCS can contain up to 24 line cards and a 
Line Card Shelf Multiplexer (LSM) card, which provides communication with the 
Master Control Shelf (MCS). An LCS may contain any of the three types of LSM cards 
(LSM2, LSMT1, LSMT3), depending on the type of signal. The LSM cards (and their 
associated MLA cards) are described in the MLA and LSM Cards and Ports chapter.

Note: A D50 Remote Access Module (D50 RAM) shelf provides four slots, but 
otherwise looks the same as a standard LCS.

Note: An additional LSM card, literally named LSM, exists for non-QoS legacy 
purposes and in support of CAP2 cards used in a D50 system. For details, see 
Release 4.0 or earlier System documentation.

Select any LCS on the View menu (LCS1 through LCS12) to display the LCS object.  

An LCS can contain the following cards (see specific chapter for card details):.
� DS1.
� DMT8A3.
� DMT8A4.
� SDSL8.
� SDSL8+.
� SHDSL8.
� IDSL.
� LSM, LSM2, LSMT1, or LSMT3.

Figure 6-1: LCS Object (sample configuration)
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Card Replacement Procedures
Card 
Replacement 
Procedures

At some point, card replacement may be necessary. If so, please read the following 
relevant reference(s) in the volume titled Maintenance and Testing:
� Section 2—Card Replacement, Chapter 1—“Replace Identical Cards,” page 2-1, 

OR
� Section 2—Card Replacement, Chapter 2—“Replace an Existing Card with Differ-

ent Card Type,” page 2-5, OR
� Section 2—Card Replacement, Chapter 3—“Correct an Attribute Mismatch Condi-

tion,” page 2-19.

An Attribute Mismatch condition occurs when the system recognizes one of the 
following discrepancies:
� A card is inserted into a slot that is provisioned for a different card type.
� A card software revision is more recent than that of the active MCP card (i.e., a 

SHDSL card with Release 11.0 software is inserted into a system with the MCP run-
ning Release 10.0 software).

The Attribute Mismatch condition appears in the Conditions box on the Card Status 
tab.

LCS Interface Click an LCS object in the multiplexer (rack) equipment locator group to display the 
following tabs:
� Status.
� Configuration.
� Environmental Alarms.

LCS Status Tab 
Page

The Status tab page displays initially.

The Conditions list box displays a summary of equipment and port conditions for the 
LCS. Data in the Conditions list box is refreshed periodically by the system. The data 
can also be updated by clicking the Refresh icon on the toolbar.

Figure 6-2: LCS Status Tab
Page 6-2 Release 11.0
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LCS Configuration Tab Page
The Create button is only enabled if you have clicked on an unprovisioned LCS in the 
rack. Click this button to create an LCS.

The Delete command button is only enabled if you have clicked on a provisioned card. 
Click this button and a warning message displays indicating the card is about to be 
deleted from the system. You can either click the OK button to proceed with deleting 
the card, or the Cancel button to cancel the action. You can only delete a card if all the 
connections have first been deleted.

LCS 
Configuration 
Tab Page

Click the Config tab to display the following tab page. 

The Configuration box lists the Serial Number, Hardware Version, CLEI, and Unit 
Type for the card.

The Shelf Name box allows you to supply a name to the Line Card Shelf.

The LCS Clock Provisioning group specifies the rate for the line cards in the selected 
shelf. The only relevant selection is All 25MHz.

Note: All other remaining LCS Clock Provisioning options exist for legacy 
purposes only. For further details, see the Release 4.0 or earlier Speedlink System 
documentation.

Figure 6-3: LCS Configuration Tab
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LCS Environmental Alarms Tab Page
LCS 
Environmental 
Alarms Tab Page

Click the Environmental Alarms tab to display the following tab page.

The Environmental Alarms tab lists a number of system components for which alarms 
can be enabled. The Alarm State column displays the current state of each component.

After making any changes to the options, the Apply Changes button becomes active. 
Click this button and a warning message displays asking if you want to make changes 
to the system configuration. Click the OK button to save the changes to the MIB, or the 
Cancel button to cancel the action.

Line Card Ports To enable data transport using any of the line cards, a connection must be set up 
between the trunk interface VPI/VCI and the line card port on which data will be sent 
and received. Line cards have either 4 or 8 ports:
� Four ports: DS1.
� Eight ports: DMT8A3, DMT8A4, SDSL(8), SDSL8+, SHDSL, and IDSL.

Note: While the card’s physical labels include the numeric port designation, the 
user interface does not include these designations in all cases.

Each of the ports on a line card is provisioned separately. To provision a port, first click 
the port indicator on the card.

Note: In order to provision a port, the associated line card must be displayed in the 
LCS equipment locator group. Since provisioning is associated with the slot, not the 
line card, the line card does not have to be physically present in the slot to view and 
change the provisioning information.

Figure 6-4: LCS Environmental Alarms Tab
Page 6-4 Release 11.0
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Line Card Ports
Click the port indicator on a line card to display a bar that contains the individual ports. 

The color of each individual port indicates its status. For details see, Section 2—Craft 
Terminal User Interface, Chapter 2—“Menus, Toolbars, and Object Views.” Click any 
port to view and work with provisioning information for the port.

Information for the selected port is displayed as a port object view, with different 
categories of information presented on separate tab pages. The number of tab 
pages—and the provisioning information included on them—depends on which line 
card is being viewed. For details on the individual tab pages, see the chapters on 
individual cards.

Figure 6-5: Port Indicator and Individual Ports

port indicators

individual ports
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Line Card Ports
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SECTION 6LINE CARD SHELF AND CARDS

Chapter 2
DS1 Card and Ports

Introduction DS1 is a high-speed four port line card capable of delivering 1.54 Mbps (1540 Kbps) 
data in both directions, and divided into 24 data-bearing channels. The DS1 line card 
provides four DS1 ports in balanced (100Ω) form to connect Frame Relay, Ethernet, 
and ATM end users with the ATM backbone over T1 leased line replacement services.

Note: The DS1 line card can be installed only on a Release 8.0 or above D50.

DS1 Card 
Applications

The DS1 line card has the following applications:
� ATM-based Leased Line Services: The DS1 line card provides a T1 ATM-based 

leased line replacement service for Frame Relay, Ethernet, and ATM services. To 
support Frame Relay services, the DS1 line card provides the FRF.5 and FRF.8 
Frame Relay Interworking Functions. To support Ethernet, the DS1 line card uses 
PPP (Point-to-Point Protocol). Compared to xDSL technology, the ATM-based T1 
service can provide an extensive reach well beyond the Central Office with the use 
of repeated T1 lines over existing line terminal (Span) systems.

� ATM over DS1: To support ATM over DS1, the DS1 line card forwards consoli-
dated data and voice traffic between the ATM trunk and the CPE. The DS1 card 
connection to the trunk card must use a IWF descriptor with the Interworking 
Function Type set to ATM. There are four default index decriptors. The fourth one, 
named ATM, contains the default values for ATM or DS1. Enter 4 in the IWF 
descriptor index field of the connection dialog box, or select the ATM IWF type 
from the ATM Interworking Function Descriptor dialog box.

ATM over DS1 connections originate from specialized IAD or CPE equipment. The 
IAD consolidates traffic from multiple voice and data services into ATM cells for ATM 
transport over the DS1 line in the ingress direction. The DSI card sends the ATM cells 
through the ATM trunk card to the ATM network. The reverse occurs in the egress 
direction.

DS1 Card 
Interface

Click a DS1 card in an LCS equipment locator group to display the following tabs:
� Status.
� Configuration.
� Versions.
Release 11.0 Page 6-7
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DS1 Card Status Tab Page
DS1 Card Status 
Tab Page

The Status tab page displays initially.

The Conditions list box displays conditions associated with the selected card. Data in 
the Conditions list box is refreshed by the system at user-specified intervals. The 
interval can be set to 0, which means that the data will not automatically refresh. You 
can specify the polling interval by selecting Options from the Tools menu. The data can 
also be updated by clicking the Refresh icon on the toolbar.

The Administration State group allows you to control whether or not the card is 
available for service. Unlocked makes the card available if there are no other 
conditions blocking its use. Locked makes the card unavailable for service. Cards 
should be locked when being configured, when making hardware upgrades, or when 
testing.

Note: If a card is locked, any alarms for that card will not display in the Active 
Alarms list, but they will display in the Conditions box on the card’s Status tab. If 
an alarm condition exists and the unlocked option is selected, an alarm will then be 
displayed in the Active Alarms list. For descriptions of alarm conditions, see the 
volume titled Maintenance and Testing.

The Create button is only enabled if you have clicked on an unprovisioned slot. Click 
this button to display a list of line cards you can create. Select DS1 from the list.

The Delete command button is only enabled if you have clicked on a provisioned card. 
Click this button and a warning message displays indicating the card is about to be 
deleted from the system, and you can either click the OK button to proceed, or the 
Cancel button to cancel the operation.

Note: You must delete all of a card’s connections before you can delete the card. For 
details, see Chapter 9—“Connection Dialog Boxes,” page 6-143.

Click the Reset Card button to physically reset the card. Click this button and a 
warning message displays asking if you are sure you want to reset the card. You can 
click the OK button to proceed or the Cancel button to cancel the operation.

Figure 6-6: DS1 Card Status Tab
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DS1 Card Versions Tab Page
DS1 Card 
Configuration 
Tab Page

Click the Config tab to display the following tab page.

The Configuration list box shows the serial number, hardware version, CLEI code, 
name, and the actual and configured card type.

DS1 Card 
Versions Tab 
Page

Click the Versions tab to display the following tab page.

The Subsystem Versions group lists the subsystems, their version numbers, and the 
dates when they were created.

Figure 6-7: DS1 Card Versions Tab

Figure 6-8: DS1 Card Versions Tab
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DS1 Port Interface
DS1 Port 
Interface

Click the port connection on an DS1 card to display the four ports. Click any of the 
ports to display the DS1 port object view for that port.

The DS1 port object view contains the following tabs:
� Status.
� Test.
� DS1.
� Error Thresholds.
� Actuals.
� Physical PM.
� ATM PM.
� Queue Manager.
� Queue Congestion PM.
� Connection.

These tabs are described in the following sections.

Figure 6-9: Port Interface
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DS1 Port Status Tab Page
DS1 Port Status 
Tab Page

Click the Status tab to display the following tab page.

The Conditions list box displays conditions associated with the selected port. Data in 
the Conditions list box is refreshed by the system at user-specified intervals. The 
interval can be set to 0, which means that the data will not automatically refresh. You 
can specify the polling interval by selecting Options from the Tools menu. The data can 
also be updated by clicking the Refresh icon on the toolbar.

The Administration State radio buttons control whether the object is available for 
service or not: Unlocked makes the object usable if there are no other conditions 
blocking use of this object. Locked makes the object unavailable for service. Objects 
should be locked when they are being configured or when performing upgrades.

Note: If a port is locked, any alarms for that port will not display in the Active 
Alarms list, but they will display in the Conditions box on the port’s Status tab. If 
an alarm condition exists and the unlocked option is selected, an alarm will then be 
displayed in the Active Alarms list. For descriptions of alarm conditions, see the 
volume titled Maintenance and Testing.

The Managed Interface buttons control whether the port is being actively managed. If 
the managed interface option is enabled, conditions on the port (for example, an LOF 
condition) are reported as alarms in the alarm list. If this option is not enabled (the 
default), conditions on the port will not be reported.

The managed interface option interacts with one of the options in the Options dialog 
box, which is available by selecting Options from the Tools menu. In the Line Card 
Port Color group of the Options dialog box, one of the options is If Managed Interface 
is set to no, show all options as yellow instead of red. If this option is enabled, and the 
managed interface option is disabled, a port for which a condition is reported will 
display yellow instead of red.

Figure 6-10: DS1 Port Status Tab
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DS1 Port Test Tab Page
DS1 Port Test 
Tab Page

Click the Test tab to display the following tab page.

The Test tab enables loopback testing for the DS1 card.

The (ATUC) Test Mode group allows you to select the type of testing to perform:
� Local Line LB. This is a loop-back test that tests the line to the subscriber’s net-

work interface—no data into the system.
� Local Terminal LB. This is a loop-back test that tests the line to the subscriber’s 

modem—no data out of the system.
� Payload Integrity. This adds framing at the DSLAM and then performs a loopback 

test.
� Local Payload LB. This test is similar to the Local Line LB test. It a local loop-

back test that re-generates the framing. Only the payload bits and framing bits are 
re-generated during this test.

� Request Remote Line LB-FDL. The DSLAM will send a request asking the 
far end to do a FDL line loopback test.

� Request Remote Line Payload LB-FDL. The DSLAM will send a request asking 
the far end to do a FDL line loopback test using framing.

� Request Remote Line LB-INBAND. The DSLAM will send a request asking the 
FCU/CSU to do an inband line loopback test. The minimum duration for the test is 8 
seconds, otherwise the results are undefined1.

� Request Remote Smart Jack LB-FDL. The DSLAM will send a request asking 
the Smart Jack to do a FDL line loopback test using framing.

� Request Remote Smart Jack LB-INBAND. The DSLAM will send a request ask-
ing the Smart Jack to do an inband line loopback test. The minimum duration for the 
test is 8 seconds, otherwise the results are undefined1.

Figure 6-11: DS1 Port Test Tab

1 This applies only to In-Band tests since in this case several seconds are needed for the CO and CPE side 
to setup the loopback relationship.
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The Disregard Remote Loopback Request option will cause the far end and Smart 
Jack to not respond to test mode requests from the DSLAM.

Important! All diagnostic tests interrupt data flow through the system. Do not 
perform on a D50 that is providing service. Only use diagnostic tests during 
commissioning procedures or in a lab environment to isolate trouble in the 
system.

Test Duration sets the interval in seconds that the system should wait before stopping 
the loopback test. The Loopback Duration default is 28800 seconds. The Test 
Command buttons will Start and Stop testing.

For additional information, see the volume titled Maintenance and Testing.

DS1 Port DS1 
Tab Page

Click this tab to display the following tab page.

Framing Format lets you select the signal format:
� Extended Super Frame (ESF). This is the default and recommended setting. This 

format uses the framing bit for non-intrusive signaling and control. 8000 framing 
bits are sent per second, of which 2000 framing bits are required for synchroniza-
tion, which leaves 6000 framing bits available for error detection, CRC (cyclic 
redundancy checking), and data link monitoring and maintenance. Using this for-
mat, the data payload will remain intact and the full 1.536 Mbps will be available 
for user data.

� Super Frame (SF). This format combines 24 DS0 time slots and a coded framing 
bit to form a frame. Twelve of these frames are combined to create the super frame.

Note: If Super Frame format is used on the DS1 line card port and an RDI condition 
is detected on the otherwise stable link, it may be necessary to limit the number of 
time slots which are in use. With Super Frame framing format, the payload bits are 
used to convey the RDI condition, so RDI may inadvertently be reported due to the 
nature of the payload carried. The probability for this to occur is higher if all 24 time 
slots are used. This problem is not present in the Extended Super Frame framing 

Figure 6-12: DS1 Port Rates Tab
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format since RDI is reported by the means of FDL. In any case, the more advanced 
Extended Super Frame framing format is always the preferred option if the far-end 
equipment supports it.

Select the LMI mode (Local Management Interface). LMI is a specification for the use 
of frame relay products that defines a method of exchanging status information 
between devices. The options are:
� Auto. The DS1 card automatically detects the type of LMI signal sent.
� None. No status information will be exchanged. This is the default.
� OrigLMI. This is the original LMI specification.
� ANSI. American National Standards Institute. This option sets the LMI to meet the 

telecommunications standards in the United States.
� ITU. This option sets the LMI to meet the ITU standards.

Note: If FRF.5 One-To-Many is selected for any of the DLCIs provisioned on a 
DS1 port, LMI mode has to be set to None on that port (i.e LMI cannot be used) .

Transmit clock source:
� Loop. The DS1 card will get the timing from the CPE. The far end must be config-

ured for Internal timing if the line card is set to Loop.
� Internal. The DS1 card will provide its own timing source and the CPE will get its 

clock source from the DS1 card. The far end must be configured for Loop timing if 
the line card is set to Internal.

Line Code & Polarity. The line code is needed for clocking functions. The available 
line code types are:
� B8ZS (Binary 8-Zero Substitution). This is a line-coding format in T1 transmission 

systems. If there are eight consecutive zeros in the bit stream, two coded bits are 
inserted into the transmission stream. These coded bits are out of sync with the 
polarity rules of the signal, so it can be recognized at the far-end of the connection. 
This process maintains ones density in the signal.

� AMI & Inverted. This is the same as AMI line-coding except the polarity is 
reversed.

� B8ZS & Inverted. This is the same as B8ZS line-coding except the polarity is 
reversed. B8SZ normally maintains ones density, but if AMI is used anywhere 
between the near-end and far-end of the data stream, reversing the polarity may be 
needed.

The FR to OAM Mapping group enables or disables the DS1’s ability to generate 
Frame Relay Alarm Indication Signals (AIS). This feature is disabled by default.

The Line Build Out group sets the strength of the signal sent based on the cable length 
in feet. Set the line length between 0 and 655 feet.

DS0 Time Slots group. Use this group to set the slots that will be available for data. 
Enable a time slot for data, or disable it for voice signals.

Click Apply to make changes to the MIB.
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DS1 Port Error 
Thresholds Tab 
Page

Click the Error Thresholds tab to display the following tab page.

The Error Thresholds tab allows you to specify 15-minute and daily interval thresholds 
for a number of parameters. The default is 0 for all values.

For tables of provisioning thresholds, see the volume titled Provisioning.

After making changes to any of the thresholds, the Apply Changes button becomes 
enabled. Click this button to apply the changes to the MIB.

Figure 6-13: DS1 Port Error Thresholds Tab
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DS1 Port 
Actuals Tab 
Page

Click the Actuals tab to display the following tab page.

The DS1 Port Actuals tab page displays connectivity data. This information is 
read-only.

The scrollable list includes the following DS1 actuals:

Click the Locally Reset Counters button to reset all values to 0 (zero) for the current 
view, as shown in the example. After being reset, the values will begin incrementing 

Figure 6-14: DS1 Port Actuals Tab

Table 6-1: Actuals

Transmission 
Status

Error Data Time Data

Transmit Rate LOF Failures
LOS Failures
LMI Failures
LOF Seconds
LOS Seconds
LMI Fail Seconds
CV-L
ES-L
SES-L
UAS-L
CV-P
ES-P
SES-P
SAS-P
UAS-P
Payload Integrity Test
Bad Prov. Status

Elapsed Time (current 
15 minutes)

Elapsed Time (current 
24 hours)

Elapsed Time 
(previous day)
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again based on data accumulated from the point at which the counters were reset. 
Resetting the counters only affects the current view. Data continues to accumulate 
“behind the scenes,” and if another view is opened, the new view displays values based 
on the entire reporting period.

DS1 Port 
Physical PM Tab 
Page

Click the Physical PM tab to display the following tab page.

The Physical PM (Performance Monitoring) tab page provides near and far-end 
performance monitoring information.

The Interval group allows you to specify either 15-minute or Daily intervals.

You can track up to 12 bins of performance data in 15-minute intervals. Bin number 1 
contains data for the current 15-minute interval. Bin number 2 contains data for the 
previous 15-minute interval and so on. In the Bin spin box, set the Bin value (1 to 12).

You can track 2 bins of data in daily intervals. Bin number 1 contains data for the 
current day. Bin number 2 contains data for the previous daily interval. In the Bin spin 
box, set the Bin value (1 or 2).

The Type group allows you to specify whether to monitor near or far-end data.

The PM Data for . . . group displays the title and value for each parameter. The title of 
this group changes to reflect the option selected in the Type group. This list includes 
values for the following parameters:
� LOF Seconds.
� LOS Seconds.
� LMI Fail Seconds.
� CV-L.
� ES-L.
� SES-L.
� UAS-L.

Figure 6-15: DS1 Port Physical PM Tab
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� CV-P.
� ES-P.
� SES-P.
� SAS-P.
� UAS-P.
� Errored Seconds.
� Elapsed Time (current 15 minutes).
� Elapsed Time (current 24 hours).
� Elapsed Time (previous day).
� Status.

Note: These parameters are defined in the glossary at the end of this volume.

The data will not automatically refresh. You must click the Refresh button to refresh 
the data manually. Click the Clear button to clear all the performance data for this port. 
Click the Graph button to display the data in graphical format.

The Status in the PM Data for . . . group will always be either Valid or Invalid. A 
value of Invalid indicates that the data has not been accumulated for the full time of a 
given interval because a bin has been reset. Invalid data should not be used in resolving 
performance issues.

Click the Graph button to display the data in graphical format. See Figure 6-16:  Graph 
Window, Physical PM, page 6-19.

The Status in the PM Data for . . . group will always be either Valid or Invalid. A 
value of Invalid indicates that the data has not been accumulated for the full time of a 
given interval because the bin has been reset, or because at some time during the 
interval the port was in an LOS or LOF condition. Invalid data should not be used to 
resolve performance issues.
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The Graph window displays when you click the Graph button from a number of 
different tab pages. The options included on the Graph window vary slightly depending 
on the set of data that is being graphed. As an example, the ATM PM Graph window is 
shown below.

The information included in the Graph window is described in the following sections.

Graphing group. This group includes a list of parameters that vary depending on the 
window from which the Graph window was accessed.

The Graph window includes a grid where the line graphs are displayed. The grid can 
display any combination of the available parameters. Each parameter displays in a 
different color to make it easier to view the information. The grid is divided into 
15-minute intervals, and labeled by bin number.

The following numeric data is displayed on the right side of the Graph window:
� Current data for the current 15-minute interval and current day.
� Historic data for the eleven previous 15-minute bins and for the previous day.

Click the Close command button to close the window, or the Refresh command button 
to refresh the display.

Figure 6-16: Graph Window, Physical PM
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DS1 Port ATM 
PM Tab Page

Click the ATM PM tab to display the following tab page.

The Interval group allows you to specify either 15-minute or Daily intervals.

You can track up to 12 bins of performance data in 15-minute intervals. Bin number 1 
contains data for the current 15-minute interval. Bin number 2 contains data for the 
previous 15-minute interval and so on. In the Bin spin box, set the Bin value (1 to 12).

You can track 2 bins of data in daily intervals. Bin number 1 contains data for the 
current day. Bin number 2 contains data for the previous daily interval. In the Bin spin 
box, set the Bin value (1 or 2).

The PM Data for . . . group displays the title and value for each parameter. The title of 
this group changes to reflect the option selected in the Type group. This list includes 
values for the following parameters:
� Received Bytes.
� Transmitted Bytes.
� PDU Errors.
� Status.

Note: These parameters are defined in the glossary at the end of this volume.

The data will not automatically refresh. You must click the Refresh button to refresh 
the data manually. Click the Clear button to clear all the performance data for this port. 
Click the Graph button to display the data in graphical format.

The Status in the PM Data for . . . group will always be either Valid or Invalid. A 
value of Invalid indicates that the data has not been accumulated for the full time of a 
given interval because a bin has been reset. Invalid data should not be used in resolving 
performance issues.

Click the Graph button to display the data in graphical format. See Figure 6-16:  Graph 
Window, Physical PM, page 6-19.

Figure 6-17: DS1 Port ATM PM Tab
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The Status in the PM Data for . . . group will always be either Valid or Invalid. A 
value of Invalid indicates that the data has not been accumulated for the full time of a 
given interval because the bin has been reset, or because at some time during the 
interval the port was in an LOS or LOF condition. Invalid data should not be used to 
resolve performance issues.

DS1 Port Queue 
Manager Tab 
Page

Click the Queue Manager tab to display the following tab page.

The Queue Manager tab enables provisioning of the priority queuing Quality of 
Service (QoSV4) buffers.

The EPD/PPD group includes check boxes that allow provisioning of the EPD/PPD 
(Early Packet Discard/Partial Packet Discard):
� EPD/PPD Enable. This check box is used to enable EPD and PPD for the port. 

Only enable this option (the default) if the queue will be carrying connections sup-
porting ATM Adaption Layer (AAL) Type 5. EPD can also be provisioned at the 
connection level. If a queue will be carrying a combination of AAL5 and other pro-
tocols, EPD/PPD should be enabled at the port level, and enabled for the individual 
connections that will be carrying AAL5 traffic exclusively, and disabled for those 
connections not carrying AAL5 data.

� EPD Onset. Specifies the threshold above which packets will be discarded. The 
default is 75.0 (75%).

� EPD Abate. Specifies the threshold below which packets will be transmitted. The 
default is 65.0 (65%).

� PPD Thresh. Specifies the threshold above which partial packets will be discarded. 
The default is 95.0 (95%).

The EFCI group  allows you to provision the EFCI (Explicit Forward Congestion 
Indicator) features.
� EFCI Enable. This check box is used to enable/disable EFCI for the port.

Figure 6-18: DS1 Port Queue Manager Tab
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� Enter the threshold above which EFCI will be applied to packets. The default is 65.0 
(65%).

The Conditions box lists any conditions pertaining to the buffers.

Thresholds can be specified for each of these parameters, including:

The Select Queue group contains a Priority box and a Direction box.
� Select Low, Medium or High from the Priority box. Low Priority is the default.
� The Direction field is set to Egress and cannot be changed since it is the only valid 

value for this card.

Click the Queue Size command button to display a dialog box where the queue size 
can be viewed and changed. The number displayed in the Queue Size box reflects the 
current provisioning for the queue selected in the Priority list on the Queue Manager 
tab.

Note: This is a data affecting action. Changing the queue size is not recommended. 
You can click the OK button to proceed with the action or the Cancel button to 
cancel any changes to the Queue Size field.

The total buffering available for all three queues for one port of a DS1 card is 1024 
cells. The default allocations are as follows:
� Low priority = 694 cells.
� Medium priority = 298 cells.
� High priority = 32 cells.

Since the default sizes for the three queues use the entire available buffering, increasing 
the size of one queue requires that you decrease the size of another by at least the same 
number of cells to make the required buffering available. Before increasing a queue, 
you should decrease the size of another queue first, otherwise a provisioning error will 
occur. If the total size of all three queues exceeds the maximum available buffering, the 
condition will display in the Conditions list on the Queue Manager tab.

The Congestion Measurement group box includes a check box to enable (unchecked 
by default) congestion measurement. A Weight Factor between .001 and 1.000 can be 
specified (the default is .300). The weight factor is used to smooth data samples. A 
value of 1 means that no weighting is applied to the current sample to calculate the 
measure of congestion.

Figure 6-19: Low Priority Queue Default Size
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The Levels and Reporting Periods group box enables provisioning of thresholds for 
the following parameters:
� Severe level. Level at which an alarm will be reported if the level stays above the 

specified Abate level for the specified number of Active report seconds. The 
default is 90%.

� Abate level. Level below which an alarm will clear if the level stays below the 
specified Abate level for the specified number of Clear report seconds. The default 
is 70%.

� Intermediate level. Level at which a threshold report will be generated. Only one 
report will be generated per five-minute interval. The default is 40%.

� Active report. Time in seconds (default of 30) before an alarm is reported if:
– The level exceeds the specified Severe level, and
– Stays above the specified Abate level for the specified number of Active report 

seconds.
� Clear report. Time in seconds before an alarm clears if the level stays below the 

specified Abate level. The default is 30 seconds.

After changing the provisioning for a port, click the Apply Changes command button 
to save the provisioning information to the MIB.
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DS1 Port Queue 
Congestion PM 
Tab Page

Click the Queue Congestion PM tab to display the following tab page.

The Queue Congestion PM (Performance Monitoring) tab provides information on 
data congestion for each of the three queues (Low, Medium, and High).

The Interval group is set to a value of 5-minutes and cannot be changed since it is the 
only valid value for this card.

You can view up to 12 five-minute bins of performance data. The data in Bin number 1 
always contains the data for the current interval. Bin number 2 contains the data for the 
previous interval and so on.

Use the Priority field to specify the queue for which you want to view data. The 
Direction field is not enabled for this tab.

In the Bin spin box, set the Bin value (1 to 12). The bin will contain the maximum and 
minimum smoothed values which occurred in that five-minute period.

The data will not automatically refresh. You must click the Refresh button to refresh 
the data manually. Click the Clear button to clear all the performance data for this port. 
Click the Graph button to display the data in graphical format.

The PM Data for . . . box displays the following items of data for bin 1:
� Current value for the period.
� Maximum value for the period.
� Minimum value for the period.
� Status of the queue.

For bins 2 through 12, only the following items of data display:
� Maximum value for the period.
� Minimum value for the period.
� Status of the queue.

Figure 6-20: DS1 Port Queue Congestion PM Tab
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The advantage of displaying the current bin is that by selecting the Refresh button, 
both new and old data can be displayed so that the values can be compared.

Click any of the column headings and drag to resize them.

DS1 Port 
Connection Tab 
Page

Click the Connection tab to display the following tab page.

The Connection tab lists all connections on the port by ID, and shows the traffic 
descriptor assigned to each connection and the VPI/VCI addresses for the Link A and 
Link Z sides of the connection. Any conditions are also listed.

Select any connection and click the Open Connection button to display connection 
details. Click the New Connection button to add a new virtual connection. To see a list 
of Frame Relay/ATM interworking function descriptors, click IWF Descriptors. For 
details, see Chapter 9—“Connection Dialog Boxes,” page 6-143.

Figure 6-21: DS1 Port Connection Tab
Release 11.0 Page 6-25
© 2002 Nokia. Proprietary Data.



Volume 6, Section 6: Line Card Shelf and Cards
DS1 Port Connection Tab Page
Page 6-26 Release 11.0
© 2002 Nokia. Proprietary Data.



SECTION 6LINE CARD SHELF AND CARDS

Chapter 3
DMT8A3 Cards and Ports

Introduction The DMT8A3 line card provides RADSL (Rate Adaptive Asymmetric DSL) service 
using the DMT (Discrete Multi-Tone) modulation technique. DMT uses FDD 
(Frequency Division Duplex) multiplexing to transmit data in the 25 kHz to 1.1 MHz 
frequency spectrum. It divides this spectrum into a 256 discrete bands, each with 4 kHz 
bandwidth. Each band is independently modulated. Each DMT8A3 card provides eight 
ports. The DMT8A3 card specifically supports both “lite” (G.lite) and “full-rate” 
(G.dmt) ADSL.

DMT8A3 Card 
Interface

Click a DMT8A3 card in an LCS equipment locator group to display the following 
tabs:
� Status.
� Configuration.
� Versions.

DMT8A3 Card 
Status Tab Page

The Status tab page displays initially.

The Conditions list box displays conditions associated with the selected card. Data in 
the Conditions list box is refreshed by the system at user-specified intervals. The 
interval can be set to 0, which means that the data will not automatically refresh. You 
can specify the polling interval by selecting Options from the Tools menu. The data can 
also be updated by clicking the Refresh icon on the toolbar.

Figure 6-22: DMT8A3 Card Status Tab
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The Administration State group allows you to control whether or not the card is 
available for service. Unlocked makes the card available if there are no other 
conditions blocking its use. Locked makes the card unavailable for service. Cards 
should be locked when being configured, when making hardware upgrades, or when 
testing.

Note: If a card is locked, any alarms for that card will not display in the Active 
Alarms list, but they will display in the Conditions box on the card’s Status tab. If 
an alarm condition exists and the unlocked option is selected, an alarm will then be 
displayed in the Active Alarms list. For descriptions of alarm conditions, see the 
volume titled Maintenance and Testing.

The Create button is only enabled if you have clicked on an unprovisioned slot. Click 
this button to display a list of line cards you can create. Select DMT8A3 from the list.

The Delete command button is only enabled if you have clicked on a provisioned card. 
Click this button and a warning message displays indicating the card is about to be 
deleted from the system, and you can either click the OK button to proceed, or the 
Cancel button to cancel the operation.

Note: You must lock the card and delete all of the connections before you can delete 
the card. For details, see Chapter 9—“Connection Dialog Boxes,” page 6-143.

Click the Reset Card button to physically reset the card. Click this button and a 
warning message displays asking if you are sure you want to reset the card. You can 
click the OK button to proceed or the Cancel button to cancel the operation.

DMT8A3 Card 
Configuration 
Tab Page

Click the Config tab to display the following tab page.

The Configuration list box shows the serial number, hardware version, CLEI code, 
name, and the actual and configured card type.

Figure 6-23: DMT8A3 Card Configuration Tab
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DMT8A3 Card 
Versions Tab 
Page

Click the Versions tab to display the following tab page.

The Subsystem Versions group lists the subsystems, their version numbers, and the 
dates when they were created.

DMT8A3 Port 
Interface

Click the port connection on the DMT8A3 card to display the eight ports. Click any of 
the eight ports to display the DMT8A3 port object view for that port.

The DMT8A3 port object view contains the following tabs:
� Status. � Test.
� Rates. � DSL Thresholds.
� DMT. � Advanced.
� Actuals. � Physical PM.
� ATM PM. � Queue Manager.
� Queue Congestion PM. � Connection.

These tabs are described in the following sections.

Figure 6-24: DMT8A3 Card Versions Tab

Figure 6-25: Individual Ports
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DMT8A3 Port 
Status Tab Page

The Status tab displays initially.

The Conditions list box displays conditions associated with the selected port. Data in 
the Conditions list box is refreshed by the system at user-specified intervals The 
interval can be set to 0, which means that the data will not automatically refresh. You 
can specify the polling interval by selecting Options from the Tools menu. The data can 
also be updated by clicking the Refresh icon on the toolbar.

The Administration State radio buttons control whether the object is available for 
service or not: Unlocked makes the object usable if there are no other conditions 
blocking use of this object. Locked makes the object unavailable for service. Objects 
should be locked when they are being configured or when performing upgrades.

Note: If a port is locked, any alarms for that port will not display in the Active 
Alarms list, but they will display in the Conditions box on the port’s Status tab. If 
an alarm condition exists and the unlocked option is selected, an alarm will then be 
displayed in the Active Alarms list. For descriptions of alarm conditions, see the 
volume titled Maintenance and Testing.

The Managed Interface buttons control whether the port is being actively managed. If 
the managed interface option is enabled, conditions on the port (for example, an LOS 
condition) are reported as alarms in the alarm list. If this option is not enabled (the 
default), conditions on the port will not be reported.

The managed interface option interacts with one of the options in the Options dialog 
box, which is available by selecting Options from the Tools menu. In the Line Card 
Port Color group of the Options dialog box, one of the options is If Managed Interface 
is set to no, show all options as yellow instead of red. If this option is enabled, and the 
managed interface option is disabled, a port for which a condition is reported will 
display yellow instead of red.

Figure 6-26: DMT8A3 Port Status Tab
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DMT8A3 Port 
Test Tab Page

Click the Test tab to display the following tab page.

The Test tab enables testing for the DMT8A3 card.

The ATUC Test Mode group allows you to select the type of testing to perform:
� Terminal. Test the line to the subscriber’s modem—no data out of the system.
� Spectrum. The DSL puts out the same signal (the same frequency spectral compo-

sition) that it would if it was linked with a CPE DSL unit—this does not require any 
CPE on the line (ATUC only).

� Analog. Test the line by looping a signal out through the transmit side and in 
through the receive side.

� Phys Loop. Performs as though active, but without sending data.

Note: The disabled options do not apply to this port type.

Test Duration sets the interval in seconds that the system should wait before stopping 
the loopback test. The Test Duration default for the ATUC is 28800 seconds.

The Test Command buttons Start and Stop testing.

Important! All diagnostic tests interrupt data flow through the system. Do not 
perform on a D50 that is providing service. Only use diagnostic tests during 
commissioning procedures or in a lab environment to isolate trouble in the 
system.

Figure 6-27: DMT8A3 Port Test Tab
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Bits Per Tone1 will display a new window with a graph of the actual bits in each of the 
256 tones. The tone numbers will be plotted in the ‘X’ axis and the number of bits per 
each tone will be plotted in ‘Y’ axis. The graph is shown below.

1 Bits Per Tone is available only with D50 Release 11.0 system software

Figure 6-28: Bits Per Tone Graph
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DMT8A3 Port 
Rates Tab Page

Click the Rates tab to display the following tab page.

The Rates tab page allows you to view and set parameters for data rates, modes, and 
thresholds for the DMT8A3 card.

Use either the Fast Rates group or the Interleave Rates group to set the maximum and 
minimum data rates for the ATUC and ATUR in Kbps. One of the groups must be set to 
0. The default system mode is Interleave. This is because Interleave mode provides the 
most robust service and provides the more reliable service under “long reach” 
conditions.
� The Fast Rates group allows you to set the maximum and minimum data rates for 

the ATUC and ATUR in Kbps. When these parameters are set to values other than 0 
(default), the Interleave Rates parameters must be set to 0. Use the Fast mode for 
latency sensitive applications.

� The Interleave Rates group allows you to set the maximum and minimum data 
rates for ATUC and ATUR in Kbps. The default settings for Max, Min and Delay 
Interleave Rates are as shown in the figure above. When these parameters are set to 
values other than 0, the Fast Rate parameters must be set to 0. Use the Interleave 
mode to improve burst error performance.

The Thresholds group allows you to view and set near and far-end Error Retrain and 
Error Alarm thresholds for the ATUC, and the Rate Degraded thresholds for the 
ATUC and ATUR.
� Error Retrain. set the number of near-end and/or far-end errored frames per second 

allowed during Data mode before the port retrains. The default is 10.
� Error Alarm. Set the number of near-end and/or far-end errored frames per second 

allowed during Data mode before the port generates an event (alarm). The default is 
0.

� Rate Degraded. Set the number of bits per second below the minimum data rate 
provisioned for the ATUC (downstream) and ATUR (upstream) channels before the 
port generates a Rate Degraded condition. The default is 0.

Figure 6-29: DMT8A3 Port Rates Tab
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The RADSL Mode group allows you to select the Rate Adaptive DSL (RADSL) mode 
for the ATUC. The options are None and Startup.
� None. Fixed bit rate. An error message is generated if the line/connection cannot 

support the data rate entered.
� Startup. Use rate adaptation during training. There is only training at startup. If 

there is a loss of signal (LOS) after startup, the system does not retrain and an error 
message is generated.

If you make changes to the parameters, click the Apply Changes button to update the 
system using the new parameters.

For more information on provisioning DMT rates, see the volume titled Provisioning.

DMT8A3 Port 
DSL Thresholds 
Tab Page

Click the DSL Thresholds tab to display the following tab page.

The Failure Thresholds group allows you to specify 15-minute and daily interval 
thresholds for a number of parameters. The default is 0 for all values.

The Frame Thresholds group allows you to specify 15-minute and daily interval 
thresholds for Coding Violations and Errored Seconds for the near and far-end ATUC. 
The default is 0 for all values.

For tables of provisioning thresholds, see the volume titled Provisioning.

After making changes to any of the thresholds, the Apply Changes button becomes 
enabled. Click this button to apply the changes to the MIB.

Figure 6-30: DMT8A3 Port DSL Thresholds Tab
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Click the DMT tab to display the following tab page.

The DMT8A3 DMT tab page allows you to enable or disable a number of 
signal-enhancing features for the port.

The ATUC Advanced Config group allows the parameters on this tab to be set 
automatically or manually. When this feature is set to Auto (default) no other options 
on this tab will be enabled.

Coding Gain allows you to set Auto or Manual coding gain. Auto (default) is 
typically set for automatic bit allocation. The Manual option provides a Gain (dB) 
value, see the next parameter.

Gain (dB) is the gain due to Trellis coding for the Manual Coding Gain setting. 
The range is 0 to 7 dB in 1 dB increments. This value is inactive for Auto Coding 
Gain.

RS Correction allows you to enable or disable downstream foward error correction. 
ATUC Time default is 2 ms. ATUR Time default is 1 ms. This feature is enabled by 
default.

ATUC Operational Mode allows you to set the operational standard for the port. The 
options are Auto, AutoANSI, ANSI, G.lite, and G.dmt, Alcatel, Alcatel14, ADI, and 
UAWG. This feature is set to Auto by default.

Note: When Auto mode is selected, the system trains to the mode supported by the 
CPE modem. Refer to the Actuals tab after training is complete to see the actual 
Operation Mode selected.

Trellis is a best-fit modem modulation technique, Trellis Coding Modulation (TCM). 
Trellis is enabled by default.

Bitswap is not available for this card.

For more information on DMT provisioning, see the volume titled Provisioning.

Figure 6-31: DMT8A3 Port DMT Tab
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DMT8A3 Port 
Adavanced Tab 
Page

Click the Actuals tab to display the following tab page.

The Target Noise Margin (dB) fields allow you to specify the margin (in dB) that the 
port establishes during the training process (ATUC and ATUR default is 6). These 
thresholds determine the amount of noise allowed on the line for the channel to operate 
at 10-7 BER. Larger margins lower the rate, but increase the line’s immunity to noise. 
The port trains to the maximum data rate that a line will support at the thresholds 
specified in these fields when operating at 10-7 BER. The actual and provisioned 
margin should be about equal.

Tx (Transmit) Power Reduction (dB) parameter limits the maximum power of a 
channel’s transmit signal. It instructs the port to reduce the full transmit power level by 
the Transmit Power Reduction amount. The default is 0 dB.

The ACP parameter is reserved for future use.

Figure 6-32: DMT8A3 Port Actuals Tab
Page 6-36 Release 11.0
© 2002 Nokia. Proprietary Data.



Chapter 3 DMT8A3 Cards and Ports
DMT8A3 Port Actuals Tab Page
DMT8A3 Port 
Actuals Tab 
Page

Click the Actuals tab to display the following tab page.

The DMT8A3 Port Actuals tab page displays ATUC and ATUR connectivity data. This 
information is read-only.

Click the Locally Reset Counters button to reset all values to 0 (zero) for the current 
view, as shown in the example. After being reset, the values will begin incrementing 
again based on data accumulated from the point at which the counters were reset. 
Resetting the counters only affects the current view. Data continues to accumulate 
“behind the scenes,” and if the current view is closed and another view is opened, the 
new view displays values based on the entire reporting period.

Figure 6-33: DMT8A3 Port Actuals Tab
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The scrollable list includes the following DMT8A3 actuals for the ATUC and ATUR:

For more information on DMT actuals, see the volume titled Provisioning.

Table 6-2: ATUC/ATUR Actuals

Transmission 
Status

Data Path 
Data

Error Data 
(ATUC only)

Time Data 
(ATUC only)

Noise Margin

Loop Attenuation

Transmit Power

Transmit Rate

Previous Transmit 
Rate

Best Transmit Rate

Payload Transmit 
Rate

Max Achievable 
Rate

Best Max 
Achievable Rate

Cells Received 
(ATUC only)

Cells Transmitted 
(ATUC only)

Operation Mode 
(ATUC only)

R (bytes/RS 
codeword)

Interleave 
Depth

Coding Gain 
(ATUC only)

S (symbols/RS 
codeword)

Vendor ID

Vendor 
Version

Serial Number 
(ATUR only)

LOF Failures

LOS Failures

LPR Failures

LCD Failures

LOF Seconds

LOS Seconds

LPR Seconds

LCD Seconds

Errored Seconds

Coding Violations

FE Errored Seconds

FE Coding Violations

HEC Errors

FE HEC Errors

Error Retrains

FE Error Retrains

LOF Retrains

Training Starts

Corrected Errors

FE Corrected Errors

Bad Prov. Status

Elapsed Time 
(current 15 
minutes)

Elapsed Time 
(current 24 hours)

Elapsed Time 
(previous day)
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DMT8A3 Port 
Physical PM Tab 
Page

Click the Physical PM tab to display the following tab page.

The Physical PM (Performance Monitoring) tab page provides near and far-end 
performance monitoring information.

The Intervals group allows you to specify either 15-minute or Daily intervals.

You can track up to 12 bins of performance data in 15-minute intervals. Bin number 1 
contains data for the current 15-minute interval. Bin number 2 contains data for the 
previous 15-minute interval and so on. In the Bin spin box, set the Bin value (1 to 12).

You can track 2 bins of data in daily intervals. Bin number 1 contains data for the 
current day. Bin number 2 contains data for the previous day. In the Bin spin box, set 
the Bin value (1 or 2).

The Type group allows you to specify whether to monitor near or far-end data.

Figure 6-34: DMT8A3 Port Physical PM Tab
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The PM Data for . . . group displays the title and value for each parameter. The title of 
this group changes to reflect the option selected in the Type group. This list includes 
values for the following parameters:

The data will not automatically refresh. You must click the Refresh button to refresh 
the data manually. Click the Clear button to clear all the performance data for this port. 
Click the Graph button to display the data in graphical format.

The Status in the PM Data for . . . group will always be either Valid or Invalid. A 
value of Invalid indicates that the data has not been accumulated for the full time of a 
given interval because a bin has been reset. Invalid data should not be used in resolving 
performance issues.

Table 6-3: Near and Far-End PM Parameters

Near-End Far-End

� LOF Seconds
� LOS Seconds
� LPR Seconds
� LCD Seconds
� LOF Retrains
� Error Rate Retrains
� Errored Seconds
� Code Violations
� Elapsed Time (current 15 minutes)
� Elapsed Time (current 24 hours)
� Elapsed Time (previous day)
� Status

� Errored Seconds
� Code Violations
� Error Rate Retrains
� Elapsed Time (current 15 minutes)
� Elapsed Time (current 24 hours)
� Elapsed Time (previous day)
� Status
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DMT8A3 Port 
ATM PM Tab 
Page

Click the ATM PM tab to display the following tab page.

The ATM PM (Performance Monitoring) tab page provides information on cells 
received, transmitted, HEC errors, and the status.

The Intervals group allows you to specify either 15-minute or Daily intervals.

You can track up to 12 bins of performance data in 15-minute intervals. Bin number 1 
contains data for the current 15-minute interval. Bin number 2 contains data for the 
previous 15-minute interval and so on. In the Bin spin box, set the Bin value (1 to 12).

You can track 2 bins of data in daily intervals. Bin number 1 contains the data for the 
current day. Bin number 2 contains the data for the previous day. In the Bin spin box, 
set the Bin value (1 or 2).

The data will not automatically refresh. You must click the Refresh button to refresh 
the data manually. Click the Clear button to clear all the performance data for this port. 
Click the Graph button to display the data in graphical format. See Figure 6-36:  
DMT8A3 Graph Window, ATM PM, page 6-42.

The Status in the PM Data for . . . group will always be either Valid or Invalid. A 
value of Invalid indicates that the data has not been accumulated for the full time of a 
given interval because the bin has been reset, or because at some time during the 
interval the port was in an LOS condition. Invalid data should not be used to resolve 
performance issues.

Figure 6-35: DMT8A3 Port ATM PM Tab
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The Graph window displays when you click the Graph button from a number of 
different tab pages. The options included on the Graph window vary slightly depending 
on the set of data that is being graphed. As an example, the ATM PM Graph window is 
shown below.

The Graphing group includes a list of parameters that vary depending on the window 
from which the Graph window was accessed. Select the parameters you want to display 
by clicking the check boxes to select or deselect them.

The Graph window includes a grid where the line graphs are displayed. The grid can 
display any combination of the available parameters. Each parameter displays in a 
different color to make it easier to view the information. The grid is divided into 
15-minute intervals, and labeled by bin number.

The following numeric data is displayed on the right side of the Graph window:
� Current data for the current 15-minute interval and current day.
� Historic data for the eleven previous 15-minute bins and for the previous day.

Click the Close command button to close the window, or the Refresh command button 
to refresh the display.

Figure 6-36: DMT8A3 Graph Window, ATM PM
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DMT8A3 Port 
Queue Manager 
Tab Page

Click the Queue Manager tab to display the following tab page.

The Queue Manager tab enables provisioning of the priority queuing Quality of 
Service (QoSV4) buffers.

The EPD/PPD group includes check boxes that allow provisioning of the EPD/PPD 
(Early Packet Discard/Partial Packet Discard):
� EPD/PPD Enable. This check box is used to enable EPD and PPD for the port. 

Only enable this option (the default) if the queue will be carrying connections sup-
porting ATM Adaption Layer (AAL) Type 5. EPD can also be provisioned at the 
connection level. If a queue will be carrying a combination of AAL5 and other pro-
tocols, EPD/PPD should be enabled at the port level, and enabled for the individual 
connections that will be carrying AAL5 traffic exclusively, and disabled for those 
connections not carrying AAL5 data.

� EPD Onset. Specifies the threshold above which packets will be discarded. The 
default is 75.0 (75%).

� EPD Abate. Specifies the threshold below which packets will be transmitted. The 
default is 65.0 (65%).

� PPD Thresh. Specifies the threshold above which partial packets will be discarded. 
The default is 95.0 (95%).

The EFCI group  allows you to provision the EFCI (Explicit Forward Congestion 
Indicator) features.
� EFCI Enable. This check box is used to enable/disable EFCI for the port.
� Enter the threshold above which EFCI will be applied to packets. The default is 65.0 

(65%).

Figure 6-37: DMT8A3 Port Queue Manager Tab
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The Conditions box lists any conditions pertaining to the buffers.

Thresholds can be specified for each of these parameters, including:

The Select Queue group contains a Priority box and a Direction box.
� Select Low, Medium or High from the Priority box. Low Priority is the default.
� The Direction field is set to Egress and cannot be changed since it is the only valid 

value for this card.

Click the Queue Size command button to display a dialog box where the queue size 
can be viewed and changed. The number displayed in the Queue Size box reflects the 
current provisioning for the queue selected in the Priority list on the Queue Manager 
tab.

Note: This is a data affecting action. Changing the queue size is not recommended. 
You can click the OK button to proceed with the action or the Cancel button to 
cancel any changes to the Queue Size field.

The total buffering available for all three queues for one port of a DMT8A3 card is 
1024 cells. The default allocations are as follows:
� Low priority = 694 cells.
� Medium priority = 298 cells.
� High priority = 32 cells.

Since the default sizes for the three queues use the entire available buffering, increasing 
the size of one queue requires that you decrease the size of another by at least the same 
number of cells to make the required buffering available. Before increasing a queue, 
you should decrease the size of another queue first, otherwise a provisioning error will 
occur. If the total size of all three queues exceeds the maximum available buffering, the 
condition will display in the Conditions list on the Queue Manager tab.

The Congestion Measurement group box includes a check box to enable (unchecked 
by default) congestion measurement. A Weight Factor between .001 and 1.000 can be 
specified (the default is .300). The weight factor is used to smooth data samples. A 
value of 1 means that no weighting is applied to the current sample to calculate the 
measure of congestion.

Figure 6-38: Low Priority Queue Default Size
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The Levels and Reporting Periods group box enables provisioning of thresholds for 
the following parameters:
� Severe level. Level at which an alarm will be reported if the level stays above the 

specified Abate level for the specified number of Active report seconds. The 
default is 90%.

� Abate level. Level below which an alarm will clear if the level stays below the 
specified Abate level for the specified number of Clear report seconds. The default 
is 70%.

� Intermediate level. Level at which a threshold report will be generated. Only one 
report will be generated per five-minute interval. The default is 40%.

� Active report. Time in seconds (default of 30) before an alarm is reported if:
– The level exceeds the specified Severe level, and
– Stays above the specified Abate level for the specified number of Active report 

seconds.
� Clear report. Time in seconds before an alarm clears if the level stays below the 

specified Abate level. The default is 30 seconds.

After changing the provisioning for a port, click the Apply Changes command button 
to save the provisioning information to the MIB.
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DMT8A3 Port 
Queue 
Congestion PM 
Tab Page

Click the Queue Congestion tab to display the following tab page.

The Queue Congestion PM (Performance Monitoring) tab provides information on 
ingress and egress data congestion for each of the three queues (Low, Medium, and 
High).

The Interval group is set to a value of 5-minutes and cannot be changed since it is the 
only valid value for this card.

You can view up to 12 five-minute bins of performance data. The data in Bin number 1 
always contains the data for the current interval. Bin number 2 contains the data for the 
previous interval and so on.

Use the Priority field to specify the queue for which you want to view data. The 
Direction field is not enabled for this tab.

In the Bin spin box, set the Bin value (1 to 12). The bin will contain the maximum and 
minimum smoothed values which occurred in that five-minute period.

The data will not automatically refresh. You must click the Refresh button to refresh 
the data manually. Click the Clear button to clear all the performance data for this port. 
Click the Graph button to display the data in graphical format.

The PM Data for . . . box displays the following items of data for bin 1:
� Current value for the period.
� Maximum value for the period.
� Minimum value for the period.
� Total number of cells.
� Number of dropped cells.
� Status of the queue.

Figure 6-39: DMT8A3 Port Queue Congestion PM Tab
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For bins 2 through 12, only the following items of data display:
� Maximum value for the period.
� Minimum value for the period.
� Status of the queue.

The advantage of displaying the current bin is that by selecting the Refresh button, 
both new and old data can be displayed so that the values can be compared.

Click any of the column headings and drag to resize them.

DMT8A3 Port 
Connection Tab 
Page

Click the Connection tab to display the following tab page.

The Connection tab lists all connections on the port by ID, and shows the traffic 
descriptor assigned to each connection and the VPI/VCI addresses for the Link A and 
Link Z sides of the connection. Any conditions are also listed.

Select any connection ID and click the Open Connection button to display connection 
details. Click the New Connection button to add a new virtual connection. For details, 
see Chapter 9—“Connection Dialog Boxes,” page 6-143.

Figure 6-40: DMT8A3 Port Connection Tab
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SECTION 6LINE CARD SHELF AND CARDS

Chapter 4
DMT8A4 Cards and Ports

Introduction The DMT8A4 line card provides RADSL (Rate Adaptive Asymmetric DSL) service 
using the Discrete Multi-Tone (DMT) modulation technique. DMT uses FDD 
(Frequency Division Duplex) multiplexing to transmit data in the 25 kHz to 1.1 MHz 
frequency spectrum. It divides this spectrum into a 256 discrete bands, each with 4 kHz 
bandwidth. Each band is independently modulated. Each DMT8A4 card provides eight 
ports. The DMT8A4 card specifically supports both “lite” (G.lite) and “full-rate” 
(G.dmt) ADSL.1

DMT8A4 Card 
Interface

Click a DMT8A4 card in an LCS equipment locator group to display the following 
tabs:
� Status.
� Configuration.
� Versions.

DMT8A4 Card 
Status Tab Page

The Status tab page displays initially.

The Conditions list box on the Status tab displays conditions associated with the 
selected card. Data in the Conditions list box is refreshed by the system at 
user-specified intervals. The interval can be set to 0, which means that the data will not 

1 The DMT8a4 line card also supports speeds up to 10.8 Mbps in 32 Kbps increments in Interleave Mode 
based on "S=1/2" from the ITU-T G992.1 standard, when used in conjunction with an "S=1/2"-compliant 
CPE.

Figure 6-41: DMT8A4 Card Status Tab
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automatically refresh. You can specify the polling interval by selecting Options from 
the Tools menu. The data can also be updated by clicking the Refresh icon on the 
toolbar.

The Administration State group allows you to control whether or not the card is 
available for service. Unlocked makes the card available if there are no other 
conditions blocking its use. Locked makes the card unavailable for service. Cards 
should be locked when being configured, when making hardware upgrades, or when 
testing.

Note: If a card is locked, any alarms for that card will not display in the Active 
Alarms list, but they will display in the Conditions box on the card’s Status tab. If 
an alarm condition exists and the unlocked option is selected, an alarm will then be 
displayed in the Active Alarms list. For descriptions of alarm conditions, see the 
volume titled Maintenance and Testing.

The Create button is only enabled if you have clicked on an unprovisioned slot. Click 
this button to display a list of line cards you can create. Select DMT8A4 from the list.

The Delete command button is only enabled if you have clicked on a provisioned card. 
Click this button and a warning message displays indicating the card is about to be 
deleted from the system, and you can either click the OK button to proceed, or the 
Cancel button to cancel the operation.

Note: You must lock the card and delete all of the connections before you can delete 
the card. For details, see Chapter 9—“Connection Dialog Boxes,” page 6-143.

Click the Reset Card button to physically reset the card. Click this button and a 
warning message displays asking if you are sure you want to reset the card. You can 
click the OK button to proceed or the Cancel button to cancel the operation.

DMT8A4 Card 
Configuration 
Tab Page

Click the Config tab to display the following tab page.

The Configuration list box shows the serial number, hardware version, CLEI code, 
name, and the actual and configured card type.

Figure 6-42: DMT8A4 Card Configuration Tab
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Click the Versions tab to display the following tab page.

The Subsystem Versions group lists the subsystems, their version numbers, and the 
dates when they were created.

DMT8A4 Port 
Interface

Click the port connection on the DMT8A4 card to display the eight ports. Click any of 
the eight ports to display the DMT8A4 port object view for that port.

The DMT8A4 port object view contains the following tabs:
� Status. � Test.
� Rates. � DSL Thresholds.
� DMT. � Advanced.
� Actuals. � Physical PM.
� ATM PM. � Queue Manager.
� Queue Congestion PM. � Connection.

These tabs are described in the following sections.

Figure 6-43: DMT8A4 Card Versions Tab

Figure 6-44: Individual Ports
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DMT8A4 Port 
Status Tab Page

The Status tab displays initially.

The Conditions list box displays conditions associated with the selected port. Data in 
the Conditions list box is refreshed by the system at user-specified intervals The 
interval can be set to 0, which means that the data will not automatically refresh. You 
can specify the polling interval by selecting Options from the Tools menu. The data can 
also be updated by clicking the Refresh icon on the toolbar.

The Administration State radio buttons control whether the object is available for 
service or not: Unlocked makes the object usable if there are no other conditions 
blocking use of this object. Locked makes the object unavailable for service. Objects 
should be locked when they are being configured or when performing upgrades.

Note: If a port is locked, any alarms for that port will not display in the Active 
Alarms list, but they will display in the Conditions box on the port’s Status tab. If 
an alarm condition exists and the unlocked option is selected, an alarm will then be 
displayed in the Active Alarms list. For descriptions of alarm conditions, see the 
volume titled Maintenance and Testing.

The Managed Interface buttons control whether the port is being actively managed. If 
the managed interface option is enabled, conditions on the port (for example, an LOS 
condition) are reported as alarms in the alarm list. If this option is not enabled (the 
default), conditions on the port will not be reported.

The managed interface option interacts with one of the options in the Options dialog 
box, which is available by selecting Options from the Tools menu. In the Line Card 
Port Color group of the Options dialog box, one of the options is If Managed Interface 
is set to no, show all options as yellow instead of red. If this option is enabled, and the 
managed interface option is disabled, a port for which a condition is reported will 
display yellow instead of red.

Figure 6-45: DMT8A4 Port Status Tab
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DMT8A4 Port 
Test Tab Page

Click the Test tab to display the following tab page.

The Test tab enables testing for the DMT8A4 card.

The ATUC Test Mode group allows you to select the type of testing to perform:
� Terminal. Test the line to the subscriber’s modem—no data out of the system.
� Spectrum. The DSL puts out the same signal (the same frequency spectral compo-

sition) that it would if it was linked with a CPE DSL unit—this does not require any 
CPE on the line (ATUC only).

Note: The disabled options do not apply to this port type.

Important! All diagnostic tests interrupt data flow through the system. Do not 
perform on a D50 that is providing service. Only use diagnostic tests during 
commissioning procedures or in a lab environment to isolate trouble in the 
system.

Test Duration sets the interval in seconds that the system should wait before stopping 
the loopback test. The Test Duration default for the ATUC is 28800 seconds.

The Test Command buttons Start and Stop testing.

Figure 6-46: DMT8A4 Port Test Tab
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The Bits Per Tone2 button will display a new window with a graph of the actual bits in 
each of the 256 tones. The tone numbers will be plotted in the ‘X’ axis and the number 
of bits per each tone will be plotted in ‘Y’ axis. The graph is shown below.

2 Bits Per Tone is available only with D50 Release 11.0 system software

Figure 6-47: Bits Per Tone Graph
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DMT8A4 Port 
Rates Tab Page

Click the Rates tab to display the following tab page.

The Rates tab page allows you to view and set parameters for data rates, modes, and 
thresholds for the DMT8A4 card.

Use either the Fast Rates group or the Interleave Rates group to set the maximum and 
minimum data rates for the ATUC and ATUR in Kbps. One of the groups must be set to 
0. The default system mode is Interleave. This is because Interleave mode provides the 
most robust service and provides the more reliable service under “long reach” 
conditions.
� The Fast Rates group allows you to set the maximum and minimum data rates for 

the ATUC and ATUR in Kbps. When these parameters are set to values other than 0 
(default), the Interleave Rates parameters must be set to 0. Use the Fast mode for 
latency sensitive applications.

� The Interleave Rates group allows you to set the maximum and minimum data 
rates for ATUC and ATUR in Kbps. The default settings for Max, Min and Delay 
Interleave Rates are as shown in the figure above. When these parameters are set to 
values other than 0, the Fast Rate parameters must be set to 0. Use the Interleave 
mode to improve burst error performance.

The Thresholds group allows you to view and set near and far-end Error Retrain and 
Error Alarm thresholds for the ATUC, and the Rate Degraded thresholds for the 
ATUC and ATUR.
� Error Retrain. set the number of near-end and/or far-end errored frames per second 

allowed during Data mode before the port retrains. The default is 10.
� Error Alarm. Set the number of near-end and/or far-end errored frames per second 

allowed during Data mode before the port generates an event (alarm). The default is 
0.

� Rate Degraded. Set the number of bits per second below the minimum data rate 
provisioned for the ATUC (downstream) and ATUR (upstream) channels before the 
port generates a Rate Degraded condition. The default is 0.

Figure 6-48: DMT8A4 Port Rates Tab
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The RADSL Mode group allows you to select the Rate Adaptive DSL (RADSL) mode 
for the ATUC. The options are None and Startup.
� None. Fixed bit rate. An error message is generated if the line/connection cannot 

support the data rate entered.
� Startup. Use rate adaptation during training. There is only training at startup. If 

there is a loss of signal (LOS) after startup, the system does not retrain and an error 
message is generated.

If you make changes to the parameters, click the Apply Changes button to update the 
system using the new parameters.

For more information on provisioning DMT rates, see the volume titled Provisioning.
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DMT8A4 Port 
DSL Thresholds 
Tab Page

Click the DSL Thresholds tab to display the following tab page.

The Failure Thresholds group allows you to specify 15-minute and daily interval 
thresholds for a number of parameters. The default is 0 for all values.

The Frame Thresholds group allows you to specify 15-minute and daily interval 
thresholds for Coding Violations and Errored Seconds for the near and far-end ATUC. 
The default is 0 for all values.

For tables of provisioning thresholds, see the volume titled Provisioning.

After making changes to any of the thresholds, the Apply Changes button becomes 
enabled. Click this button to apply the changes to the MIB.

Figure 6-49: DMT8A4 Port DSL Thresholds Tab
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Click the DMT tab to display the following tab page.

The DMT8A4 DMT tab page allows you to enable or disable a number of 
signal-enhancing features for the port.

The ATUC Advanced Config group allows the parameters on this tab to be set 
automatically or manually. When this feature is set to Auto (default) no other options 
on this tab will be enabled.

Coding Gain allows you to set Auto or Manual coding gain. Auto (default) is 
typically set for automatic bit allocation. The Manual option provides a Gain (dB) 
value, see the next parameter. This feature is disabled in Release 11.0.

Gain (dB) is the gain due to Trellis coding for the Manual Coding Gain setting. 
The range is 0 to 7 dB in 1 dB increments. This value is inactive for Auto Coding 
Gain. This feature is disabled in Release 11.0.

RS Correction allows you to enable or disable downstream foward error correction. 
ATUC Time default is 2 ms. ATUR Time default is 1 ms. This feature is disabled in 
Release 11.0.

ATUC Operational Mode allows you to set the operational standard for the port. The 
options are Auto, G.lite, and G.dmt. This feature is set to Auto by default.

Note: When Auto mode is selected, the system trains to the mode supported by the 
CPE modem. Refer to the Actuals tab after training is complete to see the actual 
Operation Mode selected.

Trellis is a best-fit modem modulation technique, Trellis Coding Modulation (TCM). 
Trellis is enabled by default.

Bitswap allows you to enable or disable bitswapping. Bitswapping allows you to 
manage bit allocation during data mode to adapt to changing line conditions to help 
maintain an acceptable level of noise margin for each bin. Bitswapping does not 
dynamically change the data rate. Bit allocations are “swapped” from a bin with a 
degraded margin to one with a high margin.

For more information on DMT provisioning, see the volume titled Provisioning.

Figure 6-50: DMT8A4 Port DMT Tab
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DMT8A4 Port 
Advanced Tab 
Page

Click the Advanced tab to display the following tab page.

The Target Noise Margin (dB) fields allow you to specify the margin (in dB) that the 
port establishes during the training process (ATUC and ATUR default is 6). These 
thresholds determine the amount of noise allowed on the line for the channel to operate 
at 10-7 BER. Larger margins lower the rate, but increase the line’s immunity to noise. 
The port trains to the maximum data rate that a line will support at the thresholds 
specified in these fields when operating at 10-7 BER. The actual and provisioned 
margin should be about equal.

Tx (Transmit) Power Reduction (dB) parameter limits the maximum power of a 
channel’s transmit signal. It instructs the port to reduce the full transmit power level by 
the Transmit Power Reduction amount. The default is 0 dB.

Figure 6-51: DMT8A4 Port Actuals Tab
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Click the Actuals tab to display the following tab page.

The DMT8A4 Port Actuals tab page displays ATUC and ATUR connectivity data. This 
information is read-only.

Click the Locally Reset Counters button to reset all values to 0 (zero) for the current 
view, as shown in the example. After being reset, the values will begin incrementing 
again based on data accumulated from the point at which the counters were reset. 
Resetting the counters only affects the current view. Data continues to accumulate 
“behind the scenes,” and if the current view is closed and another view is opened, the 
new view displays values based on the entire reporting period.

Figure 6-52: DMT8A4 Port Actuals Tab
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The scrollable list includes the following DMT8A4 actuals for the ATUC and ATUR:

For more information on DMT actuals, see the volume titled Provisioning.

Table 6-4: ATUC/ATUR Actuals

Transmission 
Status

Data Path 
Data

Error Data 
(ATUC only)

Time Data 
(ATUC only)

Noise Margin

Loop Attenuation

Transmit Power 
(ATUC only)

Transmit Rate

Previous Transmit 
Rate

Best Transmit Rate

Payload Transmit 
Rate

Max Achievable 
Rate

Best Max 
Achievable Rate

Cells Received 
(ATUC only)

Cells Transmitted 
(ATUC only)

Operation Mode 
(ATUC only)

R (bytes/RS 
codeword)

Interleave 
Depth

Coding Gain 
(ATUC only)

S (symbols/RS 
codeword)

Vendor ID

Vendor 
Version

Serial Number 
(ATUR only)

LOF Failures

LOS Failures

LPR Failures

LCD Failures

LOF Seconds

LOS Seconds

LPR Seconds

LCD Seconds

Errored Seconds

Coding Violations

FE Errored Seconds

FE Coding Violations

HEC Errors

FE HEC Errors

Error Retrains

FE Error Retrains

LOF Retrains

Training Starts

Corrected Errors

FE Corrected Errors

Bad Prov. Status

Elapsed Time 
(current 15 
minutes)

Elapsed Time 
(current 24 hours)

Elapsed Time 
(previous day)
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Page

Click the Physical PM tab to display the following tab page.

The Physical PM (Performance Monitoring) tab page provides near and far-end 
performance monitoring information.

The Intervals group allows you to specify either 15-minute or Daily intervals.

You can track up to 12 bins of performance data in 15-minute intervals. Bin number 1 
contains data for the current 15-minute interval. Bin number 2 contains data for the 
previous 15-minute interval and so on. In the Bin spin box, set the Bin value (1 to 12).

You can track 2 bins of data in daily intervals. Bin number 1 contains data for the 
current day. Bin number 2 contains data for the previous day. In the Bin spin box, set 
the Bin value (1 or 2).

The Type group allows you to specify whether to monitor near or far-end data.

Figure 6-53: DMT8A4 Port Physical PM Tab
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The PM Data for . . . group displays the title and value for each parameter. The title of 
this group changes to reflect the option selected in the Type group. This list includes 
values for the following parameters:

The data will not automatically refresh. You must click the Refresh button to refresh 
the data manually. Click the Clear button to clear all the performance data for this port. 
Click the Graph button to display the data in graphical format.

The Status in the PM Data for . . . group will always be either Valid or Invalid. A 
value of Invalid indicates that the data has not been accumulated for the full time of a 
given interval because a bin has been reset. Invalid data should not be used in resolving 
performance issues.

Table 6-5: Near and Far-End PM Parameters

Near-End Far-End

� LOF Seconds
� LOS Seconds
� LPR Seconds
� LCD Seconds
� LOF Retrains
� Error Rate Retrains
� Errored Seconds
� Code Violations
� Elapsed Time (current 15 minutes)
� Elapsed Time (current 24 hours)
� Elapsed Time (previous day)
� Status

� Errored Seconds
� Code Violations
� Error Rate Retrains
� Elapsed Time (current 15 minutes)
� Elapsed Time (current 24 hours)
� Elapsed Time (previous day)
� Status
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DMT8A4 Port 
ATM PM Tab 
Page

Click the ATM PM tab to display the following tab page.

The ATM PM (Performance Monitoring) tab page provides information on cells 
received, transmitted, HEC errors, and the status.

The Intervals group allows you to specify either 15-minute or Daily intervals.

You can track up to 12 bins of performance data in 15-minute intervals. Bin number 1 
contains data for the current 15-minute interval. Bin number 2 contains data for the 
previous 15-minute interval and so on. In the Bin spin box, set the Bin value (1 to 12).

You can track 2 bins of data in daily intervals. Bin number 1 contains the data for the 
current day. Bin number 2 contains the data for the previous day. In the Bin spin box, 
set the Bin value (1 or 2).

The data will not automatically refresh. You must click the Refresh button to refresh 
the data manually. Click the Clear button to clear all the performance data for this port. 
Click the Graph button to display the data in graphical format. See Figure 6-55:  
DMT8A4 Graph Window, ATM PM, page 6-65.

The Status in the PM Data for . . . group will always be either Valid or Invalid. A 
value of Invalid indicates that the data has not been accumulated for the full time of a 
given interval because the bin has been reset, or because at some time during the 
interval the port was in an LOS condition. Invalid data should not be used to resolve 
performance issues.

Figure 6-54: DMT8A4 Port ATM PM Tab
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The Graph window displays when you click the Graph button from a number of 
different tab pages. The options included on the Graph window vary slightly depending 
on the set of data that is being graphed. As an example, the ATM PM Graph window is 
shown below.

The Graphing group includes a list of parameters that vary depending on the window 
from which the Graph window was accessed. Select the parameters you want to display 
by clicking the check boxes to select or deselect them.

The Graph window includes a grid where the line graphs are displayed. The grid can 
display any combination of the available parameters. Each parameter displays in a 
different color to make it easier to view the information. The grid is divided into 
15-minute intervals, and labeled by bin number.

The following numeric data is displayed on the right side of the Graph window:
� Current data for the current 15-minute interval and current day.
� Historic data for the eleven previous 15-minute bins and for the previous day.

Click the Close command button to close the window, or the Refresh command button 
to refresh the display.

Figure 6-55: DMT8A4 Graph Window, ATM PM
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DMT8A4 Port 
Queue Manager 
Tab Page

Click the Queue Manager tab to display the following tab page.

The Queue Manager tab enables provisioning of the priority queuing Quality of 
Service (QoSV4) buffers.

The EPD/PPD group includes check boxes that allow provisioning of the EPD/PPD 
(Early Packet Discard/Partial Packet Discard):
� EPD/PPD Enable. This check box is used to enable EPD and PPD for the port. 

Only enable this option (the default) if the queue will be carrying connections sup-
porting ATM Adaption Layer (AAL) Type 5. EPD can also be provisioned at the 
connection level. If a queue will be carrying a combination of AAL5 and other pro-
tocols, EPD/PPD should be enabled at the port level, and enabled for the individual 
connections that will be carrying AAL5 traffic exclusively, and disabled for those 
connections not carrying AAL5 data.

� EPD Onset. Specifies the threshold above which packets will be discarded. The 
default is 75.0 (75%).

� EPD Abate. Specifies the threshold below which packets will be transmitted. The 
default is 65.0 (65%).

� PPD Thresh. Specifies the threshold above which partial packets will be discarded. 
The default is 95.0 (95%).

The EFCI group  allows you to provision the EFCI (Explicit Forward Congestion 
Indicator) features.
� EFCI Enable. This check box is used to enable/disable EFCI for the port.
� Enter the threshold above which EFCI will be applied to packets. The default is 65.0 

(65%).

Figure 6-56: DMT8A4 Port Queue Manager Tab
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The Conditions box lists any conditions pertaining to the buffers.

Thresholds can be specified for each of these parameters, including:

The Select Queue group contains a Priority box and a Direction box.
� Select Low, Medium or High from the Priority box. Low Priority is the default.
� The Direction field is set to Egress and cannot be changed since it is the only valid 

value for this card.

Click the Queue Size command button to display a dialog box where the queue size 
can be viewed and changed. The number displayed in the Queue Size box reflects the 
current provisioning for the queue selected in the Priority list on the Queue Manager 
tab.

Note: This is a data affecting action. Changing the queue size is not recommended. 
You can click the OK button to proceed with the action or the Cancel button to 
cancel any changes to the Queue Size field.

The total buffering available for all three queues for one port of a DMT8A4 card is 
1024 cells. The default allocations are as follows:
� Low priority = 694 cells.
� Medium priority = 298 cells.
� High priority = 32 cells.

Since the default sizes for the three queues use the entire available buffering, increasing 
the size of one queue requires that you decrease the size of another by at least the same 
number of cells to make the required buffering available. Before increasing a queue, 
you should decrease the size of another queue first, otherwise a provisioning error will 
occur. If the total size of all three queues exceeds the maximum available buffering, the 
condition will display in the Conditions list on the Queue Manager tab.

The Congestion Measurement group box includes a check box to enable (unchecked 
by default) congestion measurement. A Weight Factor between .001 and 1.000 can be 
specified (the default is .300). The weight factor is used to smooth data samples. A 
value of 1 means that no weighting is applied to the current sample to calculate the 
measure of congestion.

Figure 6-57: Low Priority Queue Default Size
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The Levels and Reporting Periods group box enables provisioning of thresholds for 
the following parameters:
� Severe level. Level at which an alarm will be reported if the level stays above the 

specified Abate level for the specified number of Active report seconds. The 
default is 90%.

� Abate level. Level below which an alarm will clear if the level stays below the 
specified Abate level for the specified number of Clear report seconds. The default 
is 70%.

� Intermediate level. Level at which a threshold report will be generated. Only one 
report will be generated per five-minute interval. The default is 40%.

� Active report. Time in seconds (default of 30) before an alarm is reported if:
– The level exceeds the specified Severe level, and
– Stays above the specified Abate level for the specified number of Active report 

seconds.
� Clear report. Time in seconds before an alarm clears if the level stays below the 

specified Abate level. The default is 30 seconds.

After changing the provisioning for a port, click the Apply Changes command button 
to save the provisioning information to the MIB.
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Click the Queue Congestion tab to display the following tab page.

The Queue Congestion PM (Performance Monitoring) tab provides information on 
ingress and egress data congestion for each of the three queues (Low, Medium, and 
High).

The Interval group is set to a value of 5-minutes and cannot be changed since it is the 
only valid value for this card.

You can view up to 12 five-minute bins of performance data. The data in Bin number 1 
always contains the data for the current interval. Bin number 2 contains the data for the 
previous interval and so on.

Use the Priority field to specify the queue for which you want to view data. The 
Direction field is not enabled for this tab.

In the Bin spin box, set the Bin value (1 to 12). The bin will contain the maximum and 
minimum smoothed values which occurred in that five-minute period.

The data will not automatically refresh. You must click the Refresh button to refresh 
the data manually. Click the Clear button to clear all the performance data for this port. 
Click the Graph button to display the data in graphical format.

The PM Data for . . . box displays the following items of data for bin 1:
� Current value for the period.
� Maximum value for the period.
� Minimum value for the period.
� Total number of cells.
� Number of dropped cells.
� Status of the queue.

Figure 6-58: DMT8A4 Port Queue Congestion PM Tab
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For bins 2 through 12, only the following items of data display:
� Maximum value for the period.
� Minimum value for the period.
� Status of the queue.

The advantage of displaying the current bin is that by selecting the Refresh button, 
both new and old data can be displayed so that the values can be compared.

Click any of the column headings and drag to resize them.

DMT8A4 Port 
Connection Tab 
Page

Click the Connection tab to display the following tab page.

The Connection tab lists all connections on the port by ID, and shows the traffic 
descriptor assigned to each connection and the VPI/VCI addresses for the Link A and 
Link Z sides of the connection. Any conditions are also listed.

Select any connection ID and click the Open Connection button to display connection 
details. Click the New Connection button to add a new virtual connection. For details, 
see Chapter 9—“Connection Dialog Boxes,” page 6-143.

Figure 6-59: DMT8A4 Port Connection Tab
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Chapter 5
SDSL Card and Ports

Introduction The Symmetrical Digital Subscriber Line (SDSL) line card provides DSL service using 
the 2B1Q (2 Binary, 1 Quaternary) line encoding technique. 2B1Q is a DSL line 
encoding technique that uses four variations in amplitude and polarity to represent two 
bits. Unlike ADSL line cards which can carry both data and analog voice 
transmissions, SDSL line cards use the entire frequency spectrum for data 
transmission. The SDSL card supports a data rate of up to 1.536 Mbps (1536 Kbps).

The SDSL card port communicates with the customer premise equipment (CPE) over 
an embedded operations channel (EOC) to establish a rate for the D50 to CPE link. The 
EOC assists in determining the most reliable rate in the shortest time possible. After the 
link rate is established, the EOC allows for the exchange of information for the purpose 
of monitoring the link and adapting to changing line conditions as required.

Each SDSL line card provides eight ports.

SDSL Card 
Interface

Click an SDSL card in an LCS equipment locator group to display the following tabs:
� Status.
� Configuration.
� Versions.

SDSL Card 
Status Tab Page

The Status tab page displays initially.

The Conditions list box displays conditions associated with the selected card. Data in 
the Conditions list box is refreshed by the system at user-specified intervals. The 

Figure 6-60: SDSL Card Status Tab
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interval can be set to 0, which means that the data will not automatically refresh. You 
can specify the polling interval by selecting Options from the Tools menu. The data can 
also be updated by clicking the Refresh icon on the toolbar.

The Administration State group controls whether or not the card is available for 
service. Unlocked makes the card available if there are no other conditions blocking its 
use. Locked makes the card unavailable for service. Cards should be locked when 
being configured, when making hardware upgrades, or when testing.

Note: If a card is locked, any alarms for that card will not display in the Active 
Alarms list, but they will display in the Conditions box on the card’s Status tab. If 
an alarm condition exists and the unlocked option is selected, an alarm will then be 
displayed in the Active Alarms list. For descriptions of alarm conditions, see the 
volume titled Maintenance and Testing.

The Create button is only enabled if you have clicked on an unprovisioned slot. Click 
this button to display a list of line cards you can create. Select SDSL8+ from the list.

The Delete command button is only enabled if you have clicked on a provisioned card. 
Click this button and a warning message displays indicating the card is about to be 
deleted from the system, and you can either click the OK button to proceed, or the 
Cancel button to cancel the operation.

Note: You must lock the card and delete all of the connections before you can delete 
the card. For details, see Chapter 9—“Connection Dialog Boxes,” page 6-143.

Click the Reset Card button to physically reset the card. Click this button and a 
warning message displays asking if you are sure you want to reset the card. You can 
click the OK button to proceed or the Cancel button to cancel the operation.

SDSL Card 
Configuration 
Tab Page

Click the Config tab to display the following tab page.

The Configuration list box shows the serial number, hardware version, CLEI code, 
name, and the actual and configured card type.

Figure 6-61: SDSL Card Configuration Tab
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SDSL Card 
Versions Tab 
Page

Click the Versions tab to display the following tab page.

The Subsystem Versions group lists the subsystems, their version numbers, and the 
dates when they were created.

SDSL Port 
Interface

Click the port connection on an SDSL card to display the eight ports. Click any of the 
ports to display the SDSL port object view for that port.

The SDSL port object view contains the following tabs:
� Status. � Test.
� Rates. � DSL Thresholds.
� Actuals. � Physical PM.
� ATM PM. � Queue Manager.
� Queue Congestion PM. � Connection.

These tabs are described in the following sections.

Figure 6-62: SDSL Card Versions Tab

Figure 6-63: Port Interface
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SDSL Port 
Status Tab Page

Click the Status tab to display the following tab page.

The Conditions list box displays conditions associated with the selected port. Data in 
the Conditions list box is refreshed by the system at user-specified intervals. The 
interval can be set to 0, which means that the data will not automatically refresh. You 
can specify the polling interval by selecting Options from the Tools menu. The data can 
also be updated by clicking the Refresh icon on the toolbar.

The Administration State radio buttons control whether the object is available for 
service or not: Unlocked makes the object usable if there are no other conditions 
blocking use of this object. Locked makes the object unavailable for service. Objects 
should be locked when they are being configured or when performing upgrades.

Note: If a port is locked, any alarms for that port will not display in the Active 
Alarms list, but they will display in the Conditions box on the port’s Status tab. If 
an alarm condition exists and the unlocked option is selected, an alarm will then be 
displayed in the Active Alarms list. For descriptions of alarm conditions, see the 
volume titled Maintenance and Testing.

The Managed Interface buttons control whether the port is being actively managed. If 
the managed interface option is enabled, conditions on the port (for example, an LOF 
condition) are reported as alarms in the alarm list. If this option is not enabled (the 
default), conditions on the port will not be reported.

The managed interface option interacts with one of the options in the Options dialog 
box, which is available by selecting Options from the Tools menu. In the Line Card 
Port Color group of the Options dialog box, one of the options is If Managed Interface 
is set to no, show all options as yellow instead of red. If this option is enabled, and the 
managed interface option is disabled, a port for which a condition is reported will 
display yellow instead of red.

Figure 6-64: SDSL Port Status Tab
Page 6-74 Release 11.0
© 2002 Nokia. Proprietary Data.



Chapter 5 SDSL Card and Ports
SDSL Port Test Tab Page
SDSL Port Test 
Tab Page

Click the Test tab to display the following tab page.

The Test tab enables loopback testing for the SDSL card.

The (ATUC) Test Mode group allows you to select the type of testing to perform:
� Terminal. Test the line to the subscriber’s modem—no data out of the system.
� Spectrum. The DSL puts out the same signal (the same frequency spectral compo-

sition) that it would if it was linked with a CPE DSL unit—this does not require any 
CPE on the line (ATUC only).

� Send CRC Errors. Sends CRC errors to the CPE.
� Send HEC Errors. Sends HEC errors to the CPE.
� Phys Loop. Performs as though active, but without sending data.

Note: The disabled options do not apply to this port type.

Important! All diagnostic tests interrupt data flow through the system. Do not 
perform on a D50 System that is providing service. Only use diagnostic tests 
during commissioning procedures or in a lab environment to isolate trouble in 
the system.

Test Duration sets the interval in seconds that the system should wait before stopping 
the loopback test. The Loopback Duration default is 28800 seconds. The Test 
Command buttons Start and Stop testing.

For additional information, see the volume titled Maintenance and Testing.

Figure 6-65: SDSL Port Test Tab
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SDSL Port Rates 
Tab Page

Click the Rates tab to display the following tab page.

The Rates tab page allows you to view information and provision the data rates for the 
port.

The Data Rates group allows you to specify the minimum and maximum data rate for 
the ATUC.

The Thresholds group allows you to view the near-end and far-end Error Alarm, 
Error Retrain and Rate Degraded thresholds for the ATUC and ATUR. Rate 
Degraded ATUC is the only provisionable parameter.
� Rate Degraded. Set the number of bits per second below the minimum data rate 

provisioned for the ATUC (downstream) channel before the port generates a Rate 
Degraded condition. The default is 0.

The ATUC Startup Modes are as follows:
� Fixed. Fixed rate training.
� AutoBaud: This training mode works only with an AutoBaud Pre-Activation Rate 

Negotiation capable CPE. This mode establishes a simple communication channel 
prior to synchronization between the SDSL8 port and the CPE.

For information on setting the data rates, thresholds, and startup mode for this tab, see 
the volume titled Provisioning.

Figure 6-66: SDSL Port Rates Tab
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SDSL Port DSL 
Thresholds Tab 
Page

Click the DSL Thresholds tab to display the following tab page.

The Failure Thresholds group allows you to specify 15-minute and daily interval 
thresholds for a number of parameters. The default is 0 for all values.

The Frame Thresholds group allows you to specify 15-minute and daily interval 
thresholds for Coding Violations and Errored Seconds for the near and far-end ATUC. 
The default is 0 for all values.

For tables of provisioning thresholds, see the volume titled Provisioning.

After making changes to any of the thresholds, the Apply Changes button becomes 
enabled. Click this button to apply the changes to the MIB.

Figure 6-67: SDSL Port DSL Thresholds Tab
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SDSL Port 
Actuals Tab 
Page

Click the Actuals tab to display the following tab page.

The SDSL Port Actuals tab page displays ATUC connectivity data. This information is 
read-only. 

The scrollable list includes the following SDSL actuals for the ATUC:

Click the Locally Reset Counters button to reset all values to 0 (zero) for the current 
view, as shown in the example. After being reset, the values will begin incrementing 
again based on data accumulated from the point at which the counters were reset. 

Figure 6-68: SDSL Port Actuals Tab

Table 6-6: ATUC Actuals

Transmission 
Status

Data Path 
Data

Error Data Time Data

Noise Margin

Loop Attenuation

Transmit Power

Transmit Rate

Payload Transmit 
Rate

Received Blocks

Transmitted Blocs

Cells Received

Cells Transmitted

Vendor ID LOF Failures

LOS Failure

LOF Seconds

LOS Seconds

Errored Seconds

Coding Violations

FE Errored Seconds

FE Coding Violations

HEC Errors

LOF Retrains

Bad Prov. Status

Elapsed Time 
(current 15 
minutes)

Elapsed Time 
(current 24 hours)

Elapsed Time 
(previous day)
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Resetting the counters only affects the current view. Data continues to accumulate 
“behind the scenes,” and if another view is opened, the new view displays values based 
on the entire reporting period.

SDSL Port 
Physical PM Tab 
Page

Click the Physical PM tab to display the following tab page.

The Physical PM (Performance Monitoring) tab page provides near and far-end 
performance monitoring information.

The Interval group allows you to specify either 15-minute or Daily intervals.

You can track up to 12 bins of performance data in 15-minute intervals. Bin number 1 
contains data for the current 15-minute interval. Bin number 2 contains data for the 
previous 15-minute interval and so on. In the Bin spin box, set the Bin value (1 to 12).

You can track 2 bins of data in daily intervals. Bin number 1 contains data for the 
current day. Bin number 2 contains data for the previous daily interval. In the Bin spin 
box, set the Bin value (1 or 2).

The Type group allows you to specify whether to monitor near or far-end ATUC data.

The PM Data for . . . group displays the title and value for each parameter. The title of 
this group changes to reflect the option selected in the Type group. This list includes 
values for the following parameters:
� LOF Seconds.
� LOF Retrains.
� Errored Seconds.
� Code Violations.
� Elapsed Time (current 15 minutes).
� Elapsed Time (current 24 hours).
� Elapsed Time (previous day).
� Status.

Figure 6-69: SDSL Port Physical PM Tab
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The data will not automatically refresh. You must click the Refresh button to refresh 
the data manually. Click the Clear button to clear all the performance data for this port. 
Click the Graph button to display the data in graphical format.

The Status in the PM Data for . . . group will always be either Valid or Invalid. A 
value of Invalid indicates that the data has not been accumulated for the full time of a 
given interval because a bin has been reset. Invalid data should not be used in resolving 
performance issues.

SDSL Port ATM 
PM Tab Page

Click the ATM PM tab to display the following tab page.

The ATM PM (Performance Monitoring) tab page provides information on cells 
received, transmitted, HEC errors, and the status.

The Intervals group allows you to specify either 15-minute or Daily intervals.

You can track up to 12 bins of performance data in 15-minute intervals. Bin number 1 
contains data for the current 15-minute interval. Bin number 2 contains data for the 
previous 15-minute interval and so on. In the Bin spin box, set the Bin value (1 to 12).

You can track 2 bins of data in daily intervals. Bin number 1 contains data for the 
current day. Bin number 2 contains data for the previous day. In the Bin spin box, set 
the Bin value (1 or 2).

The data will not automatically refresh. You must click the Refresh button to refresh 
the data manually. Click the Clear button to clear all the performance data for this port. 
Click the Graph button to display the data in graphical format. See Figure 6-71:  Graph 
Window, ATM PM, page 6-81.

The Status in the PM Data for . . . group will always be either Valid or Invalid. A 
value of Invalid indicates that the data has not been accumulated for the full time of a 
given interval because the bin has been reset, or because at some time during the 
interval the port was in an LOS or LOF condition. Invalid data should not be used to 
resolve performance issues.

Figure 6-70: SDSL Port ATM PM Tab
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The Graph window displays when you click the Graph button from a number of 
different tab pages. The options included on the Graph window vary slightly depending 
on the set of data that is being graphed. As an example, the ATM PM Graph window is 
shown below.

The information included in the Graph window is described in the following sections.

Graphing group. This group includes a list of parameters that vary depending on the 
window from which the Graph window was accessed.

The Graph window includes a grid where the line graphs are displayed. The grid can 
display any combination of the available parameters. Each parameter displays in a 
different color to make it easier to view the information. The grid is divided into 
15-minute intervals, and labeled by bin number.

The following numeric data is displayed on the right side of the Graph window:
� Current data for the current 15-minute interval and current day.
� Historic data for the eleven previous 15-minute bins and for the previous day.

Click the Close command button to close the window, or the Refresh command button 
to refresh the display.

Figure 6-71: Graph Window, ATM PM
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SDSL Port 
Queue Manager 
Tab Page

Click the Queue Manager tab to display the following tab page.

The Queue Manager tab enables provisioning of the priority queuing Quality of 
Service (QoSV4) buffers.

The EPD/PPD group includes check boxes that allow provisioning of the EPD/PPD 
(Early Packet Discard/Partial Packet Discard):
� EPD/PPD Enable. This check box is used to enable EPD and PPD for the port. 

Only enable this option (the default) if the queue will be carrying connections sup-
porting ATM Adaption Layer (AAL) Type 5. EPD can also be provisioned at the 
connection level. If a queue will be carrying a combination of AAL5 and other pro-
tocols, EPD/PPD should be enabled at the port level, and enabled for the individual 
connections that will be carrying AAL5 traffic exclusively, and disabled for those 
connections not carrying AAL5 data.

� EPD Onset. Specifies the threshold above which packets will be discarded. The 
default is 75.0 (75%).

� EPD Abate. Specifies the threshold below which packets will be transmitted. The 
default is 65.0 (65%).

� PPD Thresh. Specifies the threshold above which partial packets will be discarded. 
The default is 95.0 (95%).

The EFCI group  allows you to provision the EFCI (Explicit Forward Congestion 
Indicator) features.
� EFCI Enable. This check box is used to enable/disable EFCI for the port.
� Enter the threshold above which EFCI will be applied to packets. The default is 65.0 

(65%).

The Conditions box lists any conditions pertaining to the buffers.

Figure 6-72: SDSL Port Queue Manager Tab
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Thresholds can be specified for each of these parameters, including:

The Select Queue group contains a Priority box and a Direction box.
� Select Low, Medium or High from the Priority box. Low Priority is the default.
� The Direction field is set to Egress and cannot be changed since it is the only valid 

value for this card.

Click the Queue Size command button to display a dialog box where the queue size 
can be viewed and changed. The number in the Queue Size box reflects the current 
provisioning for the queue selected in the Priority list on the Queue Manager tab.

Note: This is a data affecting action. Changing the queue size is not recommended. 
You can click the OK button to proceed with the action or the Cancel button to 
cancel any changes to the Queue Size field.

The total buffering available for all three queues for one port of a SDSL card is 1024 
cells. The default allocations are as follows:
� Low priority = 694 cells.
� Medium priority = 298 cells.
� High priority = 32 cells.

Since the default sizes for the three queues use the entire available buffering, increasing 
the size of one queue requires that you decrease the size of another by at least the same 
number of cells to make the required buffering available. Before increasing a queue, 
you should decrease the size of another queue first, otherwise a provisioning error will 
occur. If the total size of all three queues exceeds the maximum available buffering, the 
condition will display in the Conditions list on the Queue Manager tab.

The Congestion Measurement group box includes a check box to enable (unchecked 
by default) congestion measurement. A Weight Factor between .001 and 1.000 can be 
specified (the default is .300). The weight factor is used to smooth data samples. A 
value of 1 means that no weighting is applied to the current sample to calculate the 
measure of congestion.

The Levels and Reporting Periods group box enables provisioning of thresholds for 
the following parameters:
� Severe level. Level at which an alarm will be reported if the level stays above the 

specified Abate level for the specified number of Active report seconds. The 
default is 90%.

Figure 6-73: Low Priority Queue Default Size
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� Abate level. Level below which an alarm will clear if the level stays below the 
specified Abate level for the specified number of Clear report seconds. The default 
is 70%.

� Intermediate level. Level at which a threshold report will be generated. Only one 
report will be generated per five-minute interval. The default is 40%.

� Active report. Time in seconds (default of 30) before an alarm is reported if:
– The level exceeds the specified Severe level, and
– Stays above the specified Abate level for the specified number of Active report 

seconds.
� Clear report. Time in seconds before an alarm clears if the level stays below the 

specified Abate level. The default is 30 seconds.

After changing the provisioning for a port, click the Apply Changes command button 
to save the provisioning information to the MIB.

SDSL Port 
Queue 
Congestion PM 
Tab Page

Click the Queue Congestion PM tab to display the following tab page.

The Queue Congestion PM (Performance Monitoring) tab provides information on 
data congestion for each of the three queues (Low, Medium, and High).

The Interval group is set to a value of 5-minutes and cannot be changed since it is the 
only valid value for this card.

You can view up to 12 five-minute bins of performance data. The data in Bin number 1 
always contains the data for the current interval. Bin number 2 contains the data for the 
previous interval and so on.

Use the Priority field to specify the queue for which you want to view data. The 
Direction field is not enabled for this tab.

In the Bin spin box, set the Bin value (1 to 12). The bin will contain the maximum and 
minimum smoothed values which occurred in that five-minute period.

Figure 6-74: SDSL Port Queue Congestion PM Tab
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The data will not automatically refresh. You must click the Refresh button to refresh 
the data manually. Click the Clear button to clear all the performance data for this port. 
Click the Graph button to display the data in graphical format.

The PM Data for . . . box displays the following items of data for bin 1:
� Current value for the period.
� Maximum value for the period.
� Minimum value for the period.
� Status of the queue.

For bins 2 through 12, only the following items of data display:
� Maximum value for the period.
� Minimum value for the period.
� Status of the queue.

The advantage of displaying the current bin is that by selecting the Refresh button, 
both new and old data can be displayed so that the values can be compared.

Click any of the column headings and drag to resize them.

SDSL Port 
Connection Tab 
Page

Click the Connection tab to display the following tab page.

The Connection tab lists all connections on the port by ID, and shows the traffic 
descriptor assigned to each connection and the VPI/VCI addresses for the Link A and 
Link Z sides of the connection. Any conditions are also listed.

Select any connection and click the Open Connection button to display connection 
details. Click the New Connection button to add a new virtual connection.  For details, 
see Chapter 9—“Connection Dialog Boxes,” page 6-143.

Figure 6-75: SDSL Port Connection Tab
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SECTION 6LINE CARD SHELF AND CARDS

Chapter 6
SDSL8+ Card and Ports

Introduction SDSL8+ line cards provide Symmetrical Digital Subscriber Line (SDSL) service using 
the 2B1Q (2 Binary, 1 Quaternary) line encoding technique. 2B1Q is a DSL line 
encoding technique that use four variations in amplitude and polarity to represent two 
bits. Unlike ADSL line cards which can carry both data and analog voice 
transmissions, SDSL8+ line cards uses the entire frequency spectrum for data 
transmission.

The SDSL8+ card, with an equally compatible CPE, provides variable data rate range 
in 8 Kbps increments. The SDSL8+ line card allows provisioning of 273 data rates 
within a range of 144 to 2320 Kbps in 8 Kbps increments. The default data rate is 384 
Kbps. In comparison, the SDSL8 card allows five specific data rates of 192, 384, 768, 
1152, and 1536 Kbps.

Note: Additional provisioning information can be located in the volume titled 
Provisioning, Section 4—Appendices, Appendix A—“Provisioning Parameters.”

SDSL8+ Card 
Interface

Click an SDSL8+ card in an LCS equipment locator group to display the following 
tabs:
� Status.
� Configuration.
� Versions.
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SDSL8+ Card 
Status Tab Page

The Status tab page displays initially.

The Conditions list box displays conditions associated with the selected card. Data in 
the Conditions list box is refreshed by the system at user-specified intervals. The 
interval can be set to 0, which means that the data will not automatically refresh. You 
can specify the polling interval by selecting Options from the Tools menu. The data can 
also be updated by clicking the Refresh icon on the toolbar.

The Administration State group allows you to control whether or not the card is 
available for service. Unlocked makes the card available if there are no other 
conditions blocking its use. Locked makes the card unavailable for service; cards 
should be locked when being configured, when making hardware upgrades, or when 
testing.

Note: If a card is locked, any alarms for that card will not display in the Active 
Alarms list, but they will display in the Conditions box on the card’s Status tab. If 
an alarm condition exists and the unlocked option is selected, an alarm will then be 
displayed in the Active Alarms list. For descriptions of alarm conditions, see the 
volume titled Maintenance and Testing.

The Create button is only enabled if you have clicked on an unprovisioned slot. Click 
this button to display a list of line cards you can create. Select SDSL8+ from the list.

The Delete command button is only enabled if you have clicked on a provisioned card. 
Click this button and a warning message displays indicating the card is about to be 
deleted from the system, and you can either click the OK button to proceed, or the 
Cancel button to cancel the operation.

Note: You must lock the card and delete all of the connections before you can delete 
the card. For details, see Chapter 9—“Connection Dialog Boxes,” page 6-143.

Click the Reset Card button to physically reset the card. Click this button and a 
warning message displays asking if you are sure you want to reset the card. You can 
click the OK button to proceed or the Cancel button to cancel the operation.

Figure 6-76: SDSL8+ Card Status Tab
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SDSL8+ Card 
Configuration 
Tab Page

Click the Config tab to display the following tab page.

The Configuration list box shows the serial number, hardware version, CLEI code, 
name, and the actual and configured card type.

SDSL8+ Card 
Versions Tab 
Page

Click the Versions tab to display the following tab page.

The Subsystem Versions group lists the subsystems, their version numbers, and the 
dates when they were created.

Figure 6-77: SDSL8+ Card Configuration Tab

Figure 6-78: SDSL8+ Card Versions Tab
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SDSL8+ Port 
Interface

Click the port connection on an SDSL8+ card to display the eight ports. Click any of 
the ports to display the SDSL8+ port object view for that port.

The SDSL8+ port object view contains the following tabs:
� Status. � Test.
� Rates. � DSL Thresholds.
� Actuals. � Physical PM.
� ATM PM. � Queue Manager.
� Queue Congestion PM. � Connection.

These tabs are described in the following sections.

Figure 6-79: Port Interface
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SDSL8+ Port 
Status Tab Page

Click the Status tab to display the following tab page.

The Conditions list box displays conditions associated with the selected port. Data in 
the Conditions list box is refreshed by the system at user-specified intervals. The 
interval can be set to 0, which means that the data will not automatically refresh. You 
can specify the polling interval by selecting Options from the Tools menu. The data can 
also be updated by clicking the Refresh icon on the toolbar.

The Administration State radio buttons control whether the object is available for 
service or not: Unlocked makes the object usable if there are no other conditions 
blocking use of this object. Locked makes the object unavailable for service. Objects 
should be locked when they are being configured or when performing upgrades.

Note: If a port is locked, any alarms for that port will not display in the Active 
Alarms list, but they will display in the Conditions box on the port’s Status tab. If 
an alarm condition exists and the unlocked option is selected, an alarm will then be 
displayed in the Active Alarms list. For descriptions of alarm conditions, see the 
volume titled Maintenance and Testing.

The Managed Interface buttons control whether the port is being actively managed. If 
the managed interface option is enabled (the default), conditions on the port (for 
example, an LOF condition) are reported as alarms in the alarm list. If this option is not 
enabled, conditions on the port will not be reported.

The managed interface option interacts with one of the options in the Options dialog 
box, which is available by selecting Options from the Tools menu. In the Line Card 
Port Color group of the Options dialog box, one of the options is If Managed Interface 
is set to no, show all options as yellow instead of red. If this option is enabled, and the 
managed interface option is disabled, a port for which a condition is reported will 
display yellow instead of red.

Figure 6-80: SDSL8+ Port Status Tab
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SDSL8+ Port 
Test Tab Page

Click the Test tab to display the following tab page.

The Test tab enables loopback testing for the SDSL8+ card.

The (ATUC) Test Mode group allows you to select the type of testing to perform:
� Terminal. Test the line to the subscriber’s modem—no data out of the system.
� Spectrum. The DSL puts out the same signal (the same frequency spectral compo-

sition) that it would if it was linked with a CPE DSL unit—this does not require any 
CPE on the line (ATUC only).

� Send CRC Errors: Sends CRC errors to the CPE.
� Send HEC Errors: Sends HEC errors to the CPE.
� Phys Loop. Performs as though active, but without sending data.

Note: The disabled options do not apply to this port type.

Important! All diagnostic tests interrupt data flow through the system. Do not 
perform on a D50 System that is providing service. Only use diagnostic tests 
during commissioning procedures or in a lab environment to isolate trouble in 
the system.

Test Duration sets the interval in seconds that the system should wait before stopping 
the loopback test. The Loopback Duration default is 28800 seconds. The Test 
Command buttons Start and Stop testing.

For additional information, see the volume titled Maintenance and Testing.

Figure 6-81: SDSL8+ Port Test Tab
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SDSL8+ Port 
Rates Tab Page

Click the Rates tab to display the following tab page.

The Rates tab page allows you to view information and provision the data rates for the 
port.

The Data Rates group allows you to specify the minimum and maximum data rate for 
the ATUC.

The Thresholds group allows you to view the near and far-end Error Alarm, Error 
Retrain, and Rate Degraded thresholds for the ATUC and ATUR. Rate Degraded 
ATUC is the only provisionable parameter.
� Rate Degraded. Set the number of bits per second below the minimum data rate 

provisioned for the ATUC (downstream) channel before the port generates a Rate 
Degraded condition. The default is 0.

The ATUC Startup Modes are as follows:
� Fixed. Fixed rate training.
� AutoBaud: This training mode works only with an AutoBaud Pre-Activation Rate 

Negotiation capable CPE. This mode establishes a simple communication channel 
prior to synchronization between the SDSL8 port and the CPE.

For information on setting the data rates, thresholds, and startup mode for this tab, see 
the volume titled Provisioning.

Figure 6-82: SDSL8+ Port Rates Tab
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SDSL8+ Port 
DSL Thresholds 
Tab Page

Click the DSL Thresholds tab to display the following tab page.

The Failure Thresholds group allows you to specify 15-minute and daily interval 
thresholds for a number of parameters. The default is 0 for all values.

The Frame Thresholds group allows you to specify 15-minute and daily interval 
thresholds for Coding Violations and Errored Seconds for the near and far-end ATUC. 
The default is 0 for all values.

For tables of provisioning thresholds, see the volume titled Provisioning.

After making changes to any of the thresholds, the Apply Changes button becomes 
enabled. Click this button to apply the changes to the MIB.

Figure 6-83: SDSL8+ Port DSL Thresholds Tab
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SDSL8+ Port 
Actuals Tab 
Page

Click the Actuals tab to display the following tab page.

The SDSL8+ Port Actuals tab page displays ATUC connectivity data. This information 
is read-only. 

The scrollable list includes the following SDSL8+ actuals for the ATUC:

Click the Locally Reset Counters button to reset all values to 0 (zero) for the current 
view, as shown in the example. After being reset, the values will begin incrementing 
again based on data accumulated from the point at which the counters were reset. 
Resetting the counters only affects the current view. Data continues to accumulate 
“behind the scenes,” and if another view is opened, the new view displays values based 
on the entire reporting period.

Figure 6-84: SDSL8+ Port Actuals Tab

Table 6-7: ATUC Actuals

Transmission 
Status

Data Path 
Data

Error Data Time Data

Noise Margin
Loop Attenuation
Transmit Power
Transmit Rate
Payload Transmit Rate
Received Blocks
Transmitted Blocks
Cells Received
Cells Transmitted

Vendor ID LOF Failures
LOS Failures
LOF Seconds
LOS Seconds
Errored Seconds
Coding Violations
FE Errored Seconds
FE Coding Violations
HEC Errors
LOF Retrains
Bad Prov. Status

Elapsed Time 
(current 15 
minutes)

Elapsed Time 
(current 24 hours)

Elapsed Time 
(previous day)
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SDSL8+ Port 
Physical PM Tab 
Page

Click the Physical PM tab to display the following tab page.

The Physical PM (Performance Monitoring) tab page provides near and far-end 
performance monitoring information.

The Interval group allows you to specify either 15-minute or Daily intervals.

You can track up to 12 bins of performance data in 15-minute intervals. Bin number 1 
contains data for the current 15-minute interval. Bin number 2 contains data for the 
previous 15-minute interval and so on. In the Bin spin box, set the Bin value (1 to 12).

You can track 2 bins of data in daily intervals. Bin number 1 contains data for the 
current day. Bin number 2 contains data for the previous daily interval. In the Bin spin 
box, set the Bin value (1 or 2).

The Type group allows you to specify whether to monitor near or far-end ATUC data.

The PM Data for . . . group displays the title and value for the parameter. The title of 
this group changes to reflect the option selected in the Type group. This list includes 
values for the following parameters:
� LOF Seconds.
� LOF Retrains.
� Errored Seconds.
� Code Violations.
� Elapsed Time (current 15 minute).
� Elapsed Time (current 24 hours).
� Elapsed Time (previous day).
� Status.

The data will not automatically refresh. You must click the Refresh button to refresh 
the data manually. Click the Clear button to clear all the performance data for this port. 
Click the Graph button to display the data in graphical format.

Figure 6-85: SDSL8+ Port Physical PM Tab
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The Status in the PM Data for . . . group will always be either Valid or Invalid. A 
value of Invalid indicates that the data has not been accumulated for the full time of a 
given interval because a bin has been reset. Invalid data should not be used in resolving 
performance issues.

SDSL8+ Port 
ATM PM Tab 
Page

Click the ATM PM tab to display the following tab page.

The ATM PM (Performance Monitoring) tab page provides information on cells 
received, transmitted, HEC errors, and the status.

The Intervals group allows you to specify either 15-minute or Daily intervals.

You can track up to 12 bins of performance data in 15-minute intervals. Bin number 1 
contains data for the current 15-minute interval. Bin number 2 contains data for the 
previous 15-minute interval and so on. In the Bin spin box, set the Bin value (1 to 12).

You can track 2 bins of data in daily intervals. Bin number 1 contains data for the 
current day. Bin number 2 contains data for the previous day. In the Bin spin box, set 
the Bin value (1 or 2).

The data will not automatically refresh. You must click the Refresh button to refresh 
the data manually. Click the Clear button to clear all the performance data for this port. 
Click the Graph button to display the data in graphical format. See Figure 6-87:  Graph 
Window, ATM PM, page 6-98.

The Status in the PM Data for . . . group will always be either Valid or Invalid. A 
value of Invalid indicates that the data has not been accumulated for the full time of a 
given interval because the bin has been reset, or because at some time during the 
interval the port was in an LOS or LOF condition. Invalid data should not be used to 
resolve performance issues.

The Graph window displays when you click the Graph button from a number of 
different tab pages. The options included on the Graph window vary slightly depending 

Figure 6-86: SDSL8+ Port ATM PM Tab
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on the set of data that is being graphed. As an example, the ATM PM Graph window is 
shown below.

The information included in the Graph window is described in the following sections.

Graphing group. This group includes a list of parameters that vary depending on the 
window from which the Graph window was accessed.

The Graph window includes a grid where the line graphs are displayed. The grid can 
display any combination of the available parameters. Each parameter displays in a 
different color to make it easier to view the information. The grid is divided into 
15-minute intervals, and labeled by bin number.

The following numeric data is displayed on the right side of the Graph window:
� Current data for the current 15-minute interval and current day.
� Historic data for the eleven previous 15-minute bins and for the previous day.

Click the Close command button to close the window, or the Refresh command button 
to refresh the display.

Figure 6-87: Graph Window, ATM PM
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SDSL8+ Port 
Queue Manager 
Tab Page

Click the Queue Manager tab to display the following tab page.

The Queue Manager tab enables provisioning of the priority queuing Quality of 
Service (QoSV4) buffers.

The EPD/PPD group includes check boxes that allow provisioning of the EPD/PPD 
(Early Packet Discard/Partial Packet Discard):
� EPD/PPD Enable. This check box is used to enable EPD and PPD for the port. 

Only enable this option (the default) if the queue will be carrying connections sup-
porting ATM Adaption Layer (AAL) Type 5. EPD can also be provisioned at the 
connection level. If a queue will be carrying a combination of AAL5 and other pro-
tocols, EPD/PPD should be enabled at the port level, and enabled for the individual 
connections that will be carrying AAL5 traffic exclusively, and disabled for those 
connections not carrying AAL5 data.

� EPD Onset. Specifies the threshold above which packets will be discarded. The 
default is 75.0 (75%).

� EPD Abate. Specifies the threshold below which packets will be transmitted. The 
default is 65.0 (65%).

� PPD Thresh. Specifies the threshold above which partial packets will be discarded. 
The default is 95.0 (95%).

The EFCI group  allows you to provision the EFCI (Explicit Forward Congestion 
Indicator) features.
� EFCI Enable. This check box is used to enable/disable EFCI for the port.
� Enter the threshold above which EFCI will be applied to packets. The default is 65.0 

(65%).

Figure 6-88: SDSL8+ Port Queue Manager Tab
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The Conditions box lists any conditions pertaining to the buffers.

Thresholds can be specified for each of these parameters, including:

The Select Queue group contains a Priority box and a Direction box.
� Select Low, Medium or High from the Priority box. Low Priority is the default.
� The Direction field is set to Egress and cannot be changed since it is the only valid 

value for this card.

Click the Queue Size command button to display a dialog box where the queue size 
can be viewed and changed. The number displayed in the Queue Size box reflects the 
current provisioning for the queue selected in the Priority list on the Queue Manager 
tab.

Note: This is a data affecting action. Changing the queue size is not recommended. 
You can click the OK button to proceed with the action or the Cancel button to 
cancel any changes to the Queue Size field.

The total buffering available for all three queues for one port of a SDSL8+ card is 1024 
cells. The default allocations are as follows:
� Low priority = 694 cells.
� Medium priority = 298 cells.
� High priority = 32 cells.

Since the default sizes for the three queues use the entire available buffering, increasing 
the size of one queue requires that you decrease the size of another by at least the same 
number of cells to make the required buffering available. Before increasing a queue, 
you should decrease the size of another queue first, otherwise a provisioning error will 
occur. If the total size of all three queues exceeds the maximum available buffering, the 
condition will display in the Conditions list on the Queue Manager tab.

The Congestion Measurement group box includes a check box to enable (unchecked 
by default) congestion measurement. A Weight Factor between .001 and 1.000 can be 
specified (the default is .300). The weight factor is used to smooth data samples. A 
value of 1 means that no weighting is applied to the current sample to calculate the 
measure of congestion.

The Levels and Reporting Periods group box enables provisioning of thresholds for 
the following parameters:

Figure 6-89: Low Priority Queue Default Size
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� Severe level. Level at which an alarm will be reported if the level stays above the 
specified Abate level for the specified number of Active report seconds. The 
default is 90%.

� Abate level. Level below which an alarm will clear if the level stays below the 
specified Abate level for the specified number of Clear report seconds. The default 
is 70%.

� Intermediate level. Level at which a threshold report will be generated. Only one 
report will be generated per five-minute interval. The default is 40%.

� Active report. Time in seconds (default of 30) before an alarm is reported if:
– The level exceeds the specified Severe level, and
– Stays above the specified Abate level for the specified number of Active report 

seconds.
� Clear report. Time in seconds before an alarm clears if the level stays below the 

specified Abate level. The default is 30 seconds.

After changing the provisioning for a port, click the Apply Changes command button 
to save the provisioning information to the MIB.
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Congestion PM 
Tab Page

Click the Queue Congestion PM tab to display the following tab page.

The Queue Congestion PM (Performance Monitoring) tab provides information on 
data congestion for each of the three queues (Low, Medium, and High). 

The Interval group is set to a value of 5-minutes and cannot be changed since it is the 
only valid value for this card.

You can view up to 12 five-minute bins of performance data. The data in Bin number 1 
always contains the data for the current interval. Bin number 2 contains the data for the 
previous interval and so on.

Use the Priority field to specify the queue for which you want to view data. The 
Direction field is not enabled for this tab.

In the Bin spin box, set the Bin value (1 to 12). The bin will contain the maximum and 
minimum smoothed values which occurred in that five-minute period.

The data will not automatically refresh. You must click the Refresh button to refresh 
the data manually. Click the Clear button to clear all the performance data for this port. 
Click the Graph button to display the data in graphical format.

The PM Data for . . . box displays the following items of data for bin 1:
� Current value for the period.
� Maximum value for the period.
� Minimum value for the period.
� Status of the queue.

For bins 2 through 12, only the following items of data display:
� Maximum value for the period.
� Minimum value for the period.
� Status of the queue.

Figure 6-90: SDSL8+ Port Queue Congestion PM Tab
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The advantage of displaying the current bin is that by selecting the Refresh button, 
both new and old data can be displayed so that the values can be compared.

Click any of the column headings and drag to resize them.

SDSL8+ Port 
Connection Tab 
Page

Click the Connection tab to display the following tab page.

The Connection tab lists all connections on the port by ID, and shows the traffic 
descriptor assigned to each connection and the VPI/VCI addresses for the Link A and 
Link Z sides of the connection. Any conditions are also listed.

Select any connection and click the Open Connection button to display connection 
details. Click the New Connection button to add a new virtual connection. For details, 
see Chapter 9—“Connection Dialog Boxes,” page 6-143.

Figure 6-91: SDSL8+ Port Connection Tab
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Chapter 7
SHDSL Card and Ports

Introduction The SHDSL line card supports 8 ports of symmetric bit-rate transmission using 
Multilevel Trellis Coded Pulse Amplitude Modulation (TC-PAM). The line card 
supports ITU-T G.991.2. The user payload rate is variable and has a minimum range of 
64 Kbps up to over 2.3 Mbps in 64 Kbps increments. Unlike ADSL line cards which 
can carry both data and analog voice transmissions, SHDSL uses the entire frequency 
spectrum for data transmission.

In addition to retaining SDSL8 line card functionality, the SHDSL card:
� Uses the Pair Bonding technique to support a transfer rate of up to 4.6 Mbps by 

combining two ports.
� Uses PAM 16 linecode with Trellis coding. The SHDSL line card uses the TC-PAM 

Code to ensure compliance with ITU-T G.991.2.
� Trains typically in 40 seconds or less.
� Allows provisioning within a range of 64 to 2304 Kbps in 64 Kbps increments.
� Supports fixed rate operation. The minimum and maximum rates can be set to the 

same value to make the card operate at the provisioned rate or not at all.
� Is rate adaptive at startup. This means that the units (Central Office and/or CPE) 

have the capability to analyze the transmission line and determine the highest bit 
rate the “loop” can support (within the provisioned range).

� Supports higher speed services over longer distances. The SHDSL line card offers 
the capability to reach more customers with higher speed services than an SDSL 
line card within a given deployment area, since it is based on 16-level Trellis Coded 
Pulse Amplitude Modulation (TC-PAM) line encoding technology and is compliant 
with the ITU G.shdsl1 standard.

Note: SHDSL features are available only with equally compatible CPE. 

Note: Additional provisioning information can be located in the volume titled 
Provisioning, Section 4—Appendices, Appendix A—“Provisioning Parameters.”

SHDSL Card 
Interface

Click an SHDSL card in an LCS equipment locator group to display the following tabs:
� Status.
� Configuration.
� Versions.

1 International Telecommunication Union Recommendation G.991.2.
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SHDSL Card 
Status Tab Page

The Status tab page displays initially.

The Conditions list box displays conditions associated with the selected card. Data in 
the Conditions list box is refreshed by the system at user-specified intervals. The 
interval can be set to 0, which means that the data will not automatically refresh. You 
can specify the polling interval by selecting Options from the Tools menu. The data can 
also be updated by clicking the Refresh icon on the toolbar.

The Administration State group allows you to control whether or not the card is 
available for service. The Unlocked option makes the card available if there are no 
other conditions blocking its use.The Locked option makes the card unavailable for 
service. Cards should be locked when being configured, when making hardware 
upgrades, or when testing.

Note: If a card is locked, any alarms for that card will not display in the Active 
Alarms list, but they will display in the Conditions box on the card’s Status tab. If 
an alarm condition exists and the unlocked option is selected, an alarm will then be 
displayed in the Active Alarms list. For descriptions of alarm conditions, see the 
volume titled Maintenance and Testing.

The Create button is only enabled if you have clicked on an unprovisioned slot. Click 
this button to display a list of line cards you can create. Select SHDSL from the list.

The Delete command button is only enabled if you have clicked on a provisioned card. 
Click this button and a warning message displays indicating the card is about to be 
deleted from the system, and you can either click the OK button to proceed, or the 
Cancel button to cancel the operation.

Note: The card must be locked and all of the connections deleted before you can 
delete the card. For details, see Chapter 9—“Connection Dialog Boxes,” 
page 6-143.

Click the Reset Card button to physically reset the card. Click this button and a 
warning message displays asking if you are sure you want to reset the card. You can 
click the OK button to proceed or the Cancel button to cancel the operation.

Figure 6-92: SHDSL Card Status Tab
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SHDSL Card 
Configuration 
Tab Page

Click the Config tab to display the following tab page.

The Configuration list box shows the serial number, hardware version, CLEI code, 
name, and the actual and configured card type.

SHDSL Card 
Versions Tab 
Page

Click the Versions tab to display the following tab page.

The Subsystem Versions group lists the subsystems, their version numbers, and the 
dates when they were created.

Figure 6-93: SHDSL Card Configuration Tab

Figure 6-94: SHDSL Card Versions Tab
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SHDSL Port 
Interface

Click the port connection on an SHDSL card to display the list of eight ports. Click any 
of the ports to display the SHDSL port object view for that port. A standard port that 
has no errors and is active is shown in green. A pair of ports that has been linked using 
the Pair Bonding method is shown in a white rectangle.

The SHDSL port object view contains the following tabs:
� Status.
� Test.
� Rates.
� DSL Thresholds.
� SHDSL.
� Actuals.
� Physical PM.
� ATM PM.
� Queue Manager.
� Queue Congestion PM.
� Connection.

These tabs are described in the following sections.

Figure 6-95: Port Interface

Port List Without 
Pair Bonding

Port List With Pair 
Bonding
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Status Tab Page

Click the Status tab to display the following tab page.

The Conditions list box displays conditions associated with the selected port. Data in 
the Conditions list box is refreshed by the system at user-specified intervals. The 
interval can be set to 0, which means that the data will not automatically refresh. You 
can specify the polling interval by selecting Options from the Tools menu. The data can 
also be updated by clicking the Refresh icon on the toolbar.

The Administration State radio buttons control whether the object is available for 
service or not: the Unlocked option makes the object usable if there are no other 
conditions blocking use of this object. The Locked option makes the object unavailable 
for service. Objects should be locked when they are being configured or when 
performing upgrades.

Note: If a port is locked, any alarms for that port will not display in the Active 
Alarms list, but they will display in the Conditions box on the port’s Status tab. If 
an alarm condition exists and the unlocked option is selected, an alarm will then be 
displayed in the Active Alarms list. For descriptions of alarm conditions, see the 
volume titled Maintenance and Testing.

The Managed Interface buttons control whether the port is being actively managed. If 
the managed interface option is enabled (the default), conditions on the port (for 
example, an LOF condition) are reported as alarms in the alarm list. If this option is not 
enabled, conditions on the port will not be reported.

The managed interface option interacts with one of the options in the Options dialog 
box, which is available by selecting Options from the Tools menu. In the Line Card 
Port Color group of the Options dialog box, one of the options is If Managed Interface 
is set to no, show all options as yellow instead of red. If this option is enabled, and the 
managed interface option is disabled, a port for which a condition is reported will 
display yellow instead of red.

Figure 6-96: SHDSL Port Status Tab
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SHDSL Port Test 
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Click the Test tab to display the following tab page.

The Test tab enables loopback testing for the SHDSL card.

The (STUC) Test Mode group allows you to select the type of testing to perform:
� Terminal. Test the line to the subscriber’s modem—no data out of the system.
� Spectrum. The DSL puts out the same signal (the same frequency spectral compo-

sition) that it would if it was linked with a CPE DSL unit—this does not require any 
CPE on the line (STUC only).

� Analog. Test the line by looping a signal out through the transmit side and in 
through the receive side.

� Phys Loop. Performs as though active, but without sending data.

Note: The disabled options do not apply to this port type.

Important! All diagnostic tests interrupt data flow through the system. Do not 
perform on a D50 System that is providing service. Only use diagnostic tests 
during commissioning procedures or in a lab environment to isolate trouble in 
the system.

Test Duration sets the interval in seconds that the system should wait before stopping 
the loopback test. The Loopback Duration default is 28800 seconds. The Test 
Command buttons Start and Stop testing.

For additional information, see the volume titled Maintenance and Testing.

Figure 6-97: SHDSL Port Test Tab
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The Rates tab page allows you to view information and provision the data rates for the 
port. Click the Rates tab to display the following tab page.

The Data Rates group specifies the minimum and maximum data rate for the STUC.
Maximum Rate. The STUC Maximum data rate can be provisioned for the SHDSL 
port in Kilobits per second. The setting options are in the range of 64 to 2304 Kbps 
in 64 Kbps increments. The SHDSL port will train down to the next lower, fixed 
data rate if the provisioned rate is less than the next higher data rate. The default 
maximum rate is 2304 Kbps.
Minimum Rate. The STUC Minimum data rate should be entered in Kilobits per 
second for the SHDSL port. The default minimum rate is 1152.
Example: If a user enters a Minimum data rate of 192 Kbps, the SHDSL port will 
train down to 192 Kbps.

Note: If the Pair Bonding technique is used to double the bandwidth to the CPE, the 
Maximum and Minimum rates must be set to the same value (fixed rate mode). 
The total maximum rate for both ports should not exceed 4608 Kbps (2304 Kbps for 
the odd port, and 2304 Kbps for the even port). For information on provisioning the 
system for Pair Bonding, see the volume titled Provisioning, 
Section  2 - System and Service order Provisioning, Chapter 2 Initial Service Provision

When RADSL mode is set to Startup, the STUC and STUR  Target Noise Margin 
fields allow you to specify the margin (in dB) that the port establishes during the 
training process (the STUC and STUR default is 6). These thresholds determine the 
amount of noise allowed on the line for the channel to operate at 10-7 BER. Larger 
margins lower the rate, but increase the line’s immunity to noise. The port trains to the 
maximum data rate that a line will support at the thresholds specified in these fields 
when operating at 10-7 BER. The actual and provisioned margin should be about equal.

The Thresholds group allows you to view and set near and far-end Error Alarm and 
Error Retrain thresholds for the STUC, and the Rate Degraded thresholds for the 
STUC and STUR.

Figure 6-98: SHDSL Port Rates Tab
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� Error Retrain. Set the number of near-end and/or far-end errored frames per sec-
ond allowed during Data mode before the port retrains. The default is 10.

� Error Alarm. Set the number of near-end and/or far-end errored frames per second 
allowed during Data mode before the port generates an event. The default is 0.

� Rate Degraded. Set the number of bits per second below the minimum data rate 
provisioned for the STUC (downstream) and STUR (upstream) channels before the 
port generates a Rate Degraded condition. The default is 0.

The RADSL Mode group allows you to select the Rate Adaptive DSL (RADSL) mode 
for the STUC. The options are None and Startup.
� Startup. Use rate adaptation during training. There is only training at startup. If 

there is a loss of signal (LOS) after startup, the system does not retrain and an error 
message is generated.

� None (default). Fixed bit rate. An error message is generated if the line/connection 
cannot support the data rate entered.

For information on setting the data rates, thresholds, and startup mode for this tab, see 
the volume titled Provisioning.

SHDSL Port DSL 
Thresholds Tab 
Page

Click the DSL Thresholds tab to display the following tab page.

The Failure Thresholds group allows you to specify 15-minute and daily interval 
thresholds for a number of parameters. The default is 0 for all values.

The Frame Thresholds group allows you to specify 15-minute and daily interval 
thresholds for Coding Violations and Errored Seconds for the near and far-end STUC. 
The default is 0 for all values.

For tables of provisioning thresholds, see the volume titled Provisioning.

After making changes to any of the thresholds, the Apply Changes button becomes 
enabled. Click this button to apply the changes to the MIB.

Figure 6-99: SHDSL Port DSL Thresholds Tab
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Click the SHDSL tab to display the following tab page.

The STUC Advanced Config parameter, when set to Auto, sets the advanced 
configuration parameters for optimal performance for the selected Operation Mode. 
Auto is the default and recommended setting. When set to Manual, the advanced 
configuration parameters must be set manually.

The STUC Operation Mode allows you to set the operational standard for the port. 
This feature can be set to AnnexA if the deployment area is in North America or  
Annex B if it the system is deployed in Europe.

The following SHDSL tab parameters are set automatically when the STUC Advanced 
Configuration parameter is set to the default (and recommended) setting of Auto.

Odd/Even Pair Bonding. Pair Bonding combines an odd pair to the next even pair 
creating a two pair (four wire) connection capable of providing up to 4.6 Mbps 
symmetrical service to the CPE.

Note: Only fixed rate mode (see SHDSL Port Rates Tab Page, page 6-111) is 
supported for Pair Bonding.

Power Backoff. Select this option to enable/disable power reduction on short loops.

TC-PAM 32. This feature is not supported.

ACP l. The Advanced Control Parameter #1 is reserved for future enhancements.

ACP 2. The Advanced Control Parameter #2 is reserved for future enhancements.

After making changes to any of the thresholds, the Apply Changes button becomes 
enabled. Click this button to apply the changes to the MIB.

Figure 6-100: SHDSL Port SHDSL Tab
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SHDSL Port 
Actuals Tab 
Page

Click the Actuals tab to display the following tab page.

The SHDSL Port Actuals tab page displays STUC and STUR connectivity data. This 
information is read-only.

Figure 6-101: SHDSL Port Actuals Tab
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The scrollable list includes the following SHDSL actuals for the STUC and STUR:

For more information on DMT actuals, see the volume titled Provisioning.

Click the Locally Reset Counters button to reset all values to 0 (zero) for the current 
view, as shown in the example. After being reset, the values will begin incrementing 
again based on data accumulated from the point at which the counters were reset. 
Resetting the counters only affects the current view. Data continues to accumulate 
“behind the scenes,” and if another view is opened, the new view displays values based 
on the entire reporting period.

Table 6-8: STUC and STUR Actuals

Transmission 
Status

Data Path 
Data Error Data Time Data

Noise Margin

Loop Attenuation

Transmit Power

Receiver Gain

Transmit Rate

Previous Transmit 
Rate

Best Transmit Rate

Payload Transmit 
Rate

Max. Achievable 
Rate

Best Max. 
Achievable Rate

Received Blocks

Transmitted Blocks

Cells Received

Cells Transmitted

Operation Mode

Vendor ID

Vendor 
Version

Serial Number 
(STUR only)

LOF Failures

LOS Failures

LCD Failures

LOF Seconds

LOS Seconds

LCD Seconds

Errored Seconds

Coding Violations

FE Errored Seconds

FE Coding Violations

HEC Errors

FE HEC Errors

Error Retrains

FE Error Retrains

LOF Retrains

Training Starts

Bad Prov. Status

Elapsed Time 
(current 15 
minutes)

Elapsed Time 
(current 24 hours)

Elapsed Time 
(previous day)
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SHDSL Port 
Physical PM Tab 
Page

Click the Physical PM tab to display the following tab page.

The Physical PM (Performance Monitoring) tab page provides near-end and far-end 
performance monitoring information.

The Interval group allows you to specify either 15-minute or Daily intervals.

You can track up to 12 bins of performance data in 15-minute intervals. Bin number 1 
contains data for the current 15-minute interval. Bin number 2 contains data for the 
previous 15-minute interval and so on. In the Bin spin box, set the Bin value (1 to 12).

You can track 2 bins of data in daily intervals. Bin number 1 contains data for the 
current day. Bin number 2 contains data for the previous daily interval. In the Bin spin 
box, set the Bin value (1 or 2).

The Type group allows you to specify whether to monitor near-end or far-end STUC 
data.

The PM Data for . . . group displays the title and value for the parameter. The title of 
this group changes to reflect the option selected in the Type group. This list includes 
values for the following parameters:
� LOF Seconds.
� LOS Seconds.
� LCD Seconds.
� LOF Retrains.
� Error Rate Retrains.
� Errored Seconds.
� Code Violations.
� Elapsed Time (current 15 minute).
� Elapsed Time (current 24 hours).
� Elapsed Time (previous day).
� Status.

Figure 6-102: SHDSL Port Physical PM Tab
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The data will not automatically refresh. You must click the Refresh button to refresh 
the data manually. Click the Clear button to clear all the performance data for this port. 
Click the Graph button to display the data in graphical format.

The Status in the PM Data for . . . group will always be either Valid or Invalid. A 
value of Invalid indicates that the data has not been accumulated for the full time of a 
given interval because a bin has been reset. Invalid data should not be used in resolving 
performance issues.

SHDSL Port ATM 
PM Tab Page

Click the ATM PM tab to display the following tab page.

The ATM PM (Performance Monitoring) tab page provides information on cells 
received, cells transmitted, HEC errors, and the status.

The Intervals group allows you to specify either 15-minute or Daily intervals.

You can track up to 12 bins of performance data in 15-minute intervals. Bin number 1 
contains data for the current 15-minute interval. Bin number 2 contains data for the 
previous 15-minute interval and so on. In the Bin spin box, set the Bin value (1 to 12).

You can track 2 bins of data in daily intervals. Bin number 1 contains data for the 
current day. Bin number 2 contains data for the previous day. In the Bin spin box, set 
the Bin value (1 or 2).

The data will not automatically refresh. You must click the Refresh button to refresh 
the data manually. Click the Clear button to clear all the performance data for this port. 
Click the Graph button to display the data in graphical format. See Figure 6-104:  
Graph Window, ATM PM, page 6-118.

The Status in the PM Data for . . . group will always be either Valid or Invalid. A 
value of Invalid indicates that the data has not been accumulated for the full time of a 
given interval because the bin has been reset, or because at some time during the 
interval the port was in an LOS or LOF condition. Invalid data should not be used to 
resolve performance issues.

Figure 6-103: SHDSL Port ATM PM Tab
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The Graph window displays when you click the Graph button from a number of 
different tab pages. The options included on the Graph window vary slightly depending 
on the set of data that is being graphed. As an example, the ATM PM Graph window is 
shown below.

The information included in the Graph window is described in the following sections.

Graphing group. This group includes a list of parameters that vary depending on the 
window from which the Graph window was accessed.

The Graph window includes a grid where the line graphs are displayed. The grid can 
display any combination of the available parameters. Each parameter displays in a 
different color to make it easier to view the information. The grid is divided into 
15-minute intervals, and labeled by bin number.

The following numeric data is displayed on the right side of the Graph window:
� Current data for the current 15-minute interval and current day.
� Historic data for the eleven previous 15-minute bins and for the previous day.

Click the Close command button to close the window, or the Refresh command button 
to refresh the display.

Figure 6-104: Graph Window, ATM PM
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SHDSL Port 
Queue Manager 
Tab Page

Click the Queue Manager tab to display the following tab page.

The Queue Manager tab enables provisioning of the priority queuing Quality of 
Service (QoSV4) buffers.

The EPD/PPD group includes check boxes that allow provisioning of the EPD/PPD 
(Early Packet Discard/Partial Packet Discard):
� EPD/PPD Enable. This check box is used to enable EPD and PPD for the port. 

Only enable this option (the default) if the queue will be carrying connections sup-
porting ATM Adaption Layer (AAL) Type 5. EPD can also be provisioned at the 
connection level. If a queue will be carrying a combination of AAL5 and other pro-
tocols, EPD/PPD should be enabled at the port level, and enabled for the individual 
connections that will be carrying AAL5 traffic exclusively, and disabled for those 
connections not carrying AAL5 data.

� EPD Onset. Specifies the threshold above which packets will be discarded. The 
default is 75.0 (75%).

� EPD Abate. Specifies the threshold below which packets will be transmitted. The 
default is 65.0 (65%).

� PPD Thresh. Specifies the threshold above which partial packets will be discarded. 
The default is 95.0 (95%).

The EFCI group  allows you to provision the EFCI (Explicit Forward Congestion 
Indicator) features.
� EFCI Enable. This check box is used to enable/disable EFCI for the port.
� Enter the threshold above which EFCI will be applied to packets. The default is 65.0 

(65%).

The Conditions box lists any conditions pertaining to the buffers.

Thresholds can be specified for each of these parameters, including:

Figure 6-105: SHDSL Port Queue Manager Tab
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The Select Queue group contains a Priority box and a Direction box.
� Select Low, Medium or High from the Priority box. Low Priority is the default.
� The Direction field is set to Egress and cannot be changed since it is the only valid 

value for this card.

Click the Queue Size command button to display a dialog box where the queue size 
can be viewed and changed. The number displayed in the Queue Size box reflects the 
current provisioning for the queue selected in the Priority list on the Queue Manager 
tab.

Note: This is a data affecting action. Changing the queue size is not recommended. 
You can click the OK button to proceed with the action or the Cancel button to 
cancel any changes to the Queue Size field.

The total buffering available for all three queues for one port of a SHDSL card is 1024 
cells. The default allocations are as follows:
� Low priority = 694 cells.
� Medium priority = 298 cells.
� High priority = 32 cells.

Since the default sizes for the three queues use the entire available buffering, increasing 
the size of one queue requires that you decrease the size of another by at least the same 
number of cells to make the required buffering available. Before increasing a queue, 
you should decrease the size of another queue first, otherwise a provisioning error will 
occur. If the total size of all three queues exceeds the maximum available buffering, the 
condition will display in the Conditions list on the Queue Manager tab.

The Congestion Measurement group box includes a check box to enable (unchecked 
by default) congestion measurement. A Weight Factor between .001 and 1.000 can be 
specified (the default is .300). The weight factor is used to smooth data samples. A 
value of 1 means that no weighting is applied to the current sample to calculate the 
measure of congestion.

The Levels and Reporting Periods group box enables provisioning of thresholds for 
the following parameters:
� Severe level. Level at which an alarm will be reported if the level stays above the 

specified Abate level for the specified number of Active report seconds. The 
default is 90%.

Figure 6-106: Low Priority Queue Default Size
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� Abate level. Level below which an alarm will clear if the level stays below the 
specified Abate level for the specified number of Clear report seconds. The default 
is 70%.

� Intermediate level. Level at which a threshold report will be generated. Only one 
report will be generated per five-minute interval. The default is 40%.

� Active report. Time in seconds (default of 30) before an alarm is reported if:
– The level exceeds the specified Severe level, and
– Stays above the specified Abate level for the specified number of Active report 

seconds.
� Clear report. Time in seconds before an alarm clears if the level stays below the 

specified Abate level. The default is 30 seconds.

After changing the provisioning for a port, click the Apply Changes command button 
to save the provisioning information to the MIB.

SHDSL Port 
Queue 
Congestion PM 
Tab Page

Click the Queue Congestion PM tab to display the following tab page.

The Queue Congestion PM (Performance Monitoring) tab provides information on 
data congestion for each of the three queues (Low, Medium, and High). 

The Interval group is set to a value of 5-minutes and cannot be changed since it is the 
only valid value for this card.

You can view up to 12 five-minute bins of performance data. The data in Bin number 1 
always contains the data for the current interval. Bin number 2 contains the data for the 
previous interval and so on.

Use the Priority field to specify the queue for which you want to view data. The 
Direction field is not enabled for this tab.

In the Bin spin box, set the Bin value (1 to 12). The bin will contain the maximum and 
minimum smoothed values which occurred in that five-minute period.

Figure 6-107: SHDSL Port Queue Congestion PM Tab
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The data will not automatically refresh. You must click the Refresh button to refresh 
the data manually. Click the Clear button to clear all the performance data for this port. 
Click the Graph button to display the data in graphical format.

The PM Data for . . . box displays the following items of data for bin 1:
� Current value for the period.
� Maximum value for the period.
� Minimum value for the period.
� Status of the queue.

For bins 2 through 12, only the following items of data display:
� Maximum value for the period.
� Minimum value for the period.
� Status of the queue.

The advantage of displaying the current bin is that by selecting the Refresh button, 
both new and old data can be displayed so that the values can be compared.

Click any of the column headings and drag to resize them.

SHDSL Port 
Connection Tab 
Page

Click the Connection tab to display the following tab page.

The Connection tab lists all connections on the port by ID, and shows the traffic 
descriptor assigned to each connection and the VPI/VCI addresses for the Link A and 
Link Z sides of the connection. Any conditions are also listed.

Select any connection and click the Open Connection button to display connection 
details. Click the New Connection button to add a new virtual connection. For details, 
see Chapter 9—“Connection Dialog Boxes,” page 6-143.

Figure 6-108: SHDSL Port Connection Tab
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Chapter 8
IDSL Card and Ports

Introduction The IDSL line card provides translation between standard frame-based protocols 
(Frame Relay, PPP) and the ATM broadband network.

The Segmentation and Reassembly (SAR) function is located on the IDSL line card 
rather than on the CPE (as with ATM-based line cards). Since the SAR function is 
located on the card itself, the IDSL card must implement Inter-Working Functions 
(IWFs) from the frame-based protocols on the line, translating them to ATM on the 
backbone.

In the ingress direction, the IDSL card operates on incoming frames using one of the 
IWF options. The modified frames are then segmented and sent as ATM cells across the 
backplane.

In the egress direction, the ATM cells are reassembled into a Protocol Data Unit (PDU), 
again operated on using the selected IWF, then sent to the CPE.

The PDUs transported through the ATM network are transmitted out the line card line 
interface over High-Level Data Link Control (HDLC), carried on a transceiver-specific 
physical layer. The IDSL line card uses standard ISDN transceivers supporting the 
2B1Q line encoding.

IDSL Card 
Interface

Click an IDSL card in an LCS equipment locator group to display the following tabs:
� Status.
� Configuration.
� Versions.
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IDSL Card 
Status Tab Page

The Status tab page displays initially.

The Conditions list box displays conditions associated with the selected card. Data in 
the Conditions list box is refreshed by the system at user-specified intervals. The 
interval can be set to 0, which means that the data will not automatically refresh. You 
can specify the polling interval by selecting Options from the Tools menu. The data can 
also be updated by clicking the Refresh icon on the toolbar.

The Administration State group allows you to control whether or not the card is 
available for service. Unlocked makes the card available if there are no other 
conditions blocking its use. Locked makes the card unavailable for service; cards 
should be locked when being configured, when making hardware upgrades, or when 
testing.

Note: If a card is locked, any alarms for that card will not display in the Active 
Alarms list, but they will display in the Conditions box on the card’s Status tab. If 
an alarm condition exists and the unlocked option is selected, an alarm will then be 
displayed in the Active Alarms list. For descriptions of alarm conditions, see the 
volume titled Maintenance and Testing.

The Create button is only enabled if you have clicked on an unprovisioned slot. Click 
this button to display a list of line cards you can create. Select IDSL from the list.

The Delete command button is only enabled if you have clicked on a provisioned card. 
Click this button and a warning message displays indicating the card is about to be 
deleted from the system, and you can either click the OK button to proceed, or the 
Cancel button to cancel the operation.

Note: You must delete all of a card’s connections before you can delete the card. For 
details, see Chapter 9—“Connection Dialog Boxes,” page 6-143.

Click the Reset Card button to physically reset the card. Click this button and a 
warning message displays asking if you are sure you want to reset the card. You can 
click the OK button to proceed or the Cancel button to cancel the operation.

Figure 6-109: IDSL Card Status Tab
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IDSL Card 
Configuration 
Tab Page

Click the Config tab to display the following tab page.

The Configuration list box shows the serial number, hardware version, CLEI code, 
name, and the actual and configured card type.

IDSL Card 
Versions Tab 
Page

Click the Versions tab to display the following tab page.

The Subsystem Versions group lists the subsystems, their version numbers, and the 
dates when they were created.

Figure 6-110: IDSL Card Configuration Tab

Figure 6-111: IDSL Card Versions Tab
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Click the port connection on an IDSL card to display the eight ports. Click any of the 
ports to display the IDSL port object view for that port.

The IDSL port object view contains the following tabs:
� Status.
� IDSL.
� DSL Thresholds.
� Channels.
� Actuals.
� Physical PM.
� ATM PM.
� Queue Manager.
� Queue Congestion.
� Queue Congestion PM.
� Connection.

These tabs are described in the following sections.

Figure 6-112: Individual Ports
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IDSL Port Status 
Tab Page

The Status tab displays initially.

The Conditions list box displays conditions associated with the selected port. Data in 
the Conditions list box is refreshed by the system at user-specified intervals. The 
interval can be set to 0, which means that the data will not automatically refresh. You 
can specify the polling interval by selecting Options from the Tools menu. The data can 
also be updated by clicking the Refresh icon on the toolbar.

The Administration State radio buttons control whether the object is available for 
service or not: Unlocked makes the object usable if there are no other conditions 
blocking use of this object. Locked makes the object unavailable for service, and 
prevents alarms from being reported.

Note: If a port is locked, any alarms for that port will not display in the Active 
Alarms list, but they will display in the Conditions box on the port’s Status tab. If 
an alarm condition exists and the unlocked option is selected, an alarm will then be 
displayed in the Active Alarms list. For descriptions of alarm conditions, see the 
volume titled Maintenance and Testing.

The Managed Interface buttons control whether the port is being actively managed. If 
the managed interface option is enabled, conditions on the port (for example, an LOF 
condition) are reported as alarms in the alarm list. If this option is not enabled (the 
default), conditions on the port will not be reported.

The managed interface option interacts with one of the options in the Options dialog 
box, which is available by selecting Options from the Tools menu. In the Line Card 
Port Color group of the Options dialog box, one of the options is If Managed Interface 
is set to no, show all options as yellow instead of red. If this option is enabled, and the 
managed interface option is disabled, a port for which a condition is reported will 
display yellow instead of red.

Figure 6-113: IDSL Port Status Tab
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IDSL Port IDSL 
Tab Page

Click the IDSL tab to display the following tab page.

The IDSL tab supports IDSL Mode Provisioning and Test for the IDSL card.

The IDSL Mode allows you to select a mode for the ISDN port. The mode selected 
determines the data rate for the port. The mode option used depends on the mapping 
option specified on the IDSL port object view Channels tab, as follows:
� 2B Plus D Bonded. 144 Kbps. Used with mapping option B1. This is the default.
� 2B Bonded. 128 Kbps. Used with mapping option B1.
� 2B Independent. 2B channels, 64 Kbps each. Use with mapping options B1 or B2.
� ISDN Compatible. 2B channels, 64 Kbps each. D channel, 16 Kbps. Use with map-

ping options B1, B2, or D.

For more information on the mapping options, see IDSL Port Channels Tab Page, 
page 6-131.

The (ATUC) Test Mode group allows you to select the type of testing to perform:
� Line. Test the line to the subscriber’s network interface—no data into the system.
� Terminal. Test the line to the subscriber’s modem—no data out of the system. This 

is the default.
� Analog. Test the line by looping a signal out through the transmit side and in 

through the receive side.
� Send CRC. Test the line by forcing a single Cyclic Redundancy Check (CRC) error 

on the line towards the CPE.
� Tone. Test the line by causing the Link ID tone to be transmitted on the specified 

port, to allow remote test access to identify a given port.
� BERT B1, BERT B2, BERT 2B, BERT 2B+D. Perform a Bit Error Rate Test 

(BERT) on the loopback channel. Test result actuals can be seen by selecting the 
Actuals tab.

� Count Repeaters. A count of how many repeaters are between the D50 and the 
CPE. There are 0–7 intermediate elements possible for ISDN.

Figure 6-114: IDSL Port IDSL Tab
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Important! All diagnostic tests interrupt data flow through the system. Do not 
perform on a D50 System that is providing service. Only use diagnostic tests 
during commissioning procedures or in a lab environment to isolate trouble in 
the system.

Element Address: The D50 can address up to 6 intermediate equipment units between 
itself and the CPE, such as ISDN repeaters and Digital Loop Carriers (DLCs). Element 
Addresses 1 through 6 represent the intermediate elements, and 0 (the default) 
represents the CPE.

Note: If the D50 receives an Element Address greater than 6, it is read as 0 (the 
CPE).

Test Duration sets the interval in seconds that the system should wait before stopping 
the loopback test. The Loopback Duration default is 28800 seconds. The Test 
command buttons Start and Stop testing.

For additional information, see the volume titled Maintenance and Testing.
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IDSL Port DSL 
Thresholds Tab 
Page

Click the DSL Thresholds tab to display the following tab page.

The Failure Thresholds group allows you to specify 15-minute and daily interval 
thresholds for several parameters. The default is 0 for all values.

The Frame Thresholds group allows you to specify 15-minute and daily interval 
thresholds for Coding Violations and Errored Seconds for the near and far-end ATUC. 
The default is 0 for all values.

For tables of provisioning thresholds, see the volume titled Provisioning.

After making changes to any of the thresholds, the Apply Changes button becomes 
enabled. Click this button to apply the changes to the MIB.

Figure 6-115: IDSL Port DSL Thresholds Tab
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IDSL Port 
Channels Tab 
Page

Click the Channels tab to display the following tab page.

The Channels tab page allows you to provision individual Permanent Virtual Channels 
(PVCs). To display and work with detail information for a specific PVC, click the ID, 
then click the Display Channel command button. You can also display detail 
information when you double-click the ID. The title of the Channel <number> Data 
area changes to reflect the ID number for the selected channel. 

The following information can be viewed and worked with for the selected channel:

PVC VCI. This box displays a list of PVC VCIs (PVC Virtual Channel Identifier), 
along with the ID number and status (valid or invalid) for each. Valid values are 16 
through 1023. The trunk side VCI must make the frame relay DLCI for the connection 
to be valid.

Mapping. This group allows you to select a mapping option for the PVC. The mapping 
option selected depends on the IDSL mode specified on the IDSL port object view 
IDSL tab, as follows:
� B1. Used for any of the four IDSL modes: 2B + D Bonded, 2B Bonded, 2B Inde-

pendent, or ISDN Compatible. This is the default.
� B2. Used for IDSL mode 2B Independent or ISDN Compatible.
� D. Used for IDSL mode ISDN Compatible.

For details see IDSL Port IDSL Tab Page, page 6-128.

Inter-working Function (IWF). This group allows you to select an IWF option for the 
PVC. Each IDSL PVC must be configured to support one of the following types of 
protocols:
� PPP_LLC. PPP (Point-to-Point Protocol) over HDLC (High-Level Data Link Con-

trol), LLC (Logical Link Control) encapsulated. For this protocol, there is no frame 
relay DLCI on the IDSL port, so only one connection is supported with a default 
mapping.

Figure 6-116: IDSL Port Channels Tab
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� PPP_VCMux. PPP over HDLC, VC (Virtual Channel) multiplexed only. For this 
protocol, there is no frame relay DLCI on the IDSL port, so only one connection is 
supported with a default mapping.

� FRF.8. Frame Relay translated over HDLC, includes PPP over Frame Relay, LLC 
encapsulated. Translated protocols are supported for FRF.8 only. This is the default.

� FR_PPP_VCMUX. PPP over Frame Relay, without LLC encapsulation, VC multi-
plexed.

For Frame Relay IWF options, the trunk VPI/VCI is mapped to a specified Frame 
Relay DLCI on the IDSL port. Multiple connections can be supported by mapping 
trunk VPI/VCIs to a line card Data Link Connection Identifier (DLCI). The IDSL card 
can support a maximum of eight frame relay connections per port, and each card can 
support a maximum of twenty-four connections over all eight ports.

The Apply command button becomes active if any of the provisioning parameters are 
changed.

Note: Clicking this button applies the changes to the system. To return the 
parameters to their original values, close the dialog box without clicking the Apply 
button. The port status should be set to Locked before applying changes to the 
system.

IDSL Port 
Actuals Tab 
Page

Click the Actuals tab to display the following tab page.

The IDSL Port Actuals tab page displays ATUC connectivity data. This information is 
read-only. 

Figure 6-117: IDSL Port Actuals Tab
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The scrollable list includes the following IDSL actuals for the ATUC:

Click the Locally Reset Counters button to reset all values to 0 (zero) for the current 
view, as shown in the example. After being reset, the values will begin incrementing 
again based on data accumulated from the point at which the counters were reset. 
Resetting the counters only affects the current view. Data continues to accumulate 
“behind the scenes,” and if another view is opened, the new view displays values based 
on the entire reporting period.

Table 6-9: IDSL ATUC Actuals

TRANSMISSIO
N STATUS ERROR DATA TIME DATA

Received PDUs 
(Protocol Data 
Units)

Transmitted PDUs

Errored PDUs

Received Bytes

Transmitted Bytes

Repeater Count

% Successful BERT 
PDUs

BERT Result

LOF Failures

LOS Failures

LOF Seconds

LOS Seconds

Errored Seconds

Coding Violations

FE Errored Seconds

FE Coding Violations

LOF Retrains

Bad Prov. Status

Elapsed Time 
(Current 15 
minutes)

Elapsed Time 
(Current 24 hours)

Elapsed Time 
(Previous Day)
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IDSL Port 
Physical PM Tab 
Page

Click the Physical PM tab to display the following tab page.

The Physical PM (Performance Monitoring) tab page provides near and far-end 
performance monitoring information.

The Interval group allows you to specify either 15-minute or Daily intervals.

You can track up to 12 bins of performance data in 15-minute intervals. Bin number 1 
contains data for the current 15-minute interval. Bin number 2 contains data for the 
previous 15-minute interval and so on. In the Bin spin box, set the Bin value (1 to 12).

You can track 2 bins of data in daily intervals. Bin number 1 contains data for the 
current day. Bin number 2 contains data for the previous daily interval. In the Bin spin 
box, set the Bin value (1 or 2).

The Type group allows you to specify whether to monitor near or far-end ATUC data.

The PM Data for . . . group displays the title and value for each parameter. The title of 
this group changes to reflect the option selected in the Type group. This list includes 
values for the following parameters:
� LOF Seconds.
� LOS Seconds.
� LOF Retrains.
� Errored Seconds.
� Code Violations.
� Elapsed Time (current 15 minute).
� Elapsed Time (current 24 hours).
� Elapsed Time (previous day).
� Status.

The data will not automatically refresh. You must click the Refresh button to refresh 
the data manually. Click the Clear button to clear all the performance data for this port. 
Click the Graph button to display the data in graphical format.

Figure 6-118: IDSL Port Physical PM Tab
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The Status in the PM Data for . . . group will always be either Valid or Invalid. A 
value of Invalid indicates that the data has not been accumulated for the full time of a 
given interval because a bin has been reset. Invalid data should not be used in resolving 
performance issues.

IDSL Port ATM 
PM Tab Page

Click the ATM PM tab to display the following tab page.

The ATM PM (Performance Monitoring) tab page provides information on PDUs 
(Protocol Data Units) received, PDUs transmitted, PDU Errors, and the status.

The Intervals group allows you to specify either 15-minute or Daily intervals.

You can track up to 12 bins of performance data in 15-minute intervals. Bin number 1 
contains data for the current 15-minute interval. Bin number 2 contains data for the 
previous 15-minute interval and so on. In the Bin spin box, set the Bin value (1 to 12).

You can track 2 bins of data in daily intervals. Bin number 1 contains data for the 
current day. Bin number 2 contains data for the previous day. In the Bin spin box, set 
the Bin value (1 or 2).

The data will not automatically refresh. You must click the Refresh button to refresh 
the data manually. Click the Clear button to clear all the performance data for this port. 
Click the Graph button to display the data in graphical format. See Figure 6-120:  
Graph Window, ATM PM, page 6-136.

The Status in the PM Data for . . . group will always be either Valid or Invalid. A 
value of Invalid indicates that the data has not been accumulated for the full time of a 
given interval because the bin has been reset, or because at some time during the 
interval the port was in an LOS or LOF condition. Invalid data should not be used to 
resolve performance issues.

Figure 6-119: IDSL Port ATM PM Tab
Release 11.0 Page 6-135
© 2002 Nokia. Proprietary Data.



Volume 6, Section 6: Line Card Shelf and Cards
IDSL Port ATM PM Tab Page
The Graph window displays when you click the Graph button from a number of 
different tab pages. The options included on the Graph window vary slightly depending 
on the set of data that is being graphed. As an example, the ATM PM Graph window is 
shown below.

The information included in the Graph window is described in the following sections.

Graphing. This group includes a list of parameters that vary depending on the window 
from which the Graph window was accessed.

The Graph window includes a grid where the line graphs are displayed. The grid can 
display any combination of the available parameters. Each parameter displays in a 
different color to make it easier to view the information. The grid is divided into 15-
minute intervals, and labeled by bin number.

The following numeric data is displayed on the right side of the Graph window:
� Current data for the current 15-minute interval and current day.
� Historic data for the eleven previous 15-minute bins and for the previous day.

Click the Close command button to close the window, or the Refresh command button 
to refresh the display.

Figure 6-120: Graph Window, ATM PM
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IDSL Port Queue 
Manager Tab 
Page

Click the Queue Manager tab to display the following tab page.

The Queue Manager tab enables provisioning of the priority queuing Quality of 
Service (QoSV4) buffers.

The EPD/PPD group includes check boxes that allow provisioning of the EPD/PPD 
(Early Packet Discard/Partial Packet Discard):
� EPD/PPD Enable. This check box is used to enable EPD and PPD for the port. 

Only enable this option (the default) if the queue will be carrying connections sup-
porting ATM Adaption Layer (AAL) Type 5. EPD can also be provisioned at the 
connection level. If a queue will be carrying a combination of AAL5 and other pro-
tocols, EPD/PPD should be enabled at the port level, and enabled for the individual 
connections that will be carrying AAL5 traffic exclusively, and disabled for those 
connections not carrying AAL5 data.

� EPD Onset. Specifies the threshold above which packets will be discarded. The 
default is 75.0 (75%).

� EPD Abate. Specifies the threshold below which packets will be transmitted. The 
default is 65.0 (65%).

� PPD Thresh. Specifies the threshold above which partial packets will be discarded. 
The default is 95.0 (95%).

The EFCI group  allows you to provision the EFCI (Explicit Forward Congestion 
Indicator) features.
� EFCI Enable. This check box is used to enable/disable EFCI for the port.
� Enter the threshold above which EFCI will be applied to packets. The default is 65.0 

(65%).

Figure 6-121: IDSL Port Queue Manager Tab
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The Conditions box lists any conditions pertaining to the buffers.

Thresholds can be specified for each of these parameters, including:

The Select Queue group contains a Priority box and a Direction box.
� Select Low, Medium or High from the Priority box. Low Priority is the default.
� The Direction field is set to Egress and cannot be changed since it is the only valid 

value for this card.

Click the Queue Size command button to display a dialog box where the queue size 
can be viewed and changed. The number displayed in the Queue Size box reflects the 
current provisioning for the queue selected in the Priority list on the Queue Manager 
tab.

Note: This is a data affecting action. Changing the queue size is not recommended. 
You can click the OK button to proceed with the action or the Cancel button to 
cancel any changes to the Queue Size field.

The total buffering available for all three queues for one port of a IDSL card is 1024 
cells, so the total size of all three queues should not exceed 1024. The default 
allocations are as follows:
� Low priority = 694 cells.
� Medium priority = 298 cells.
� High priority = 32 cells.

Since the default sizes for the three queues use the entire available buffering, increasing 
the size of one queue requires that you decrease the size of another by at least the same 
number of cells to make the required buffering available. Before increasing a queue, 
you should decrease the size of another queue first, otherwise a provisioning error will 
occur. If the total size of all three queues exceeds the maximum available buffering, the 
condition will display in the Conditions list on the Queue Manager tab.

The Congestion Measurement group box includes a check box to enable (unchecked 
by default) congestion measurement. A Weight Factor between .001 and 1.000 can be 
specified (the default is .300). The weight factor is used to smooth data samples. A 
value of 1 means that no weighting is applied to the current sample to calculate the 
measure of congestion.

Figure 6-122: Low Priority Queue Default Size
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The Levels and Reporting Periods group box enables provisioning of thresholds for 
the following parameters:
� Severe level. Level at which an alarm will be reported if the level stays above the 

specified Abate level for the specified number of Active report seconds. The 
default is 90%.

� Abate level. Level below which an alarm will clear if the level stays below the 
specified Abate level for the specified number of Clear report seconds. The default 
is 70%.

� Intermediate level. Level at which a threshold report will be generated. Only one 
report will be generated per five-minute interval. The default is 40%.

� Active report. Time in seconds (default of 30) before an alarm is reported if:
– The level exceeds the specified Severe level, and
– Stays above the specified Abate level for the specified number of Active report 

seconds.
� Clear report. Time in seconds before an alarm clears if the level stays below the 

specified Abate level. The default is 30 seconds.

After changing the provisioning for a port, click the Apply Changes command button 
to save the provisioning information to the MIB.
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IDSL Port Queue 
Congestion PM 
Tab Page

Click the Queue Congestion PM tab to display the following tab page.

The Queue Congestion PM (Performance Monitoring) tab provides information on 
data congestion for each of the three queues (Low, Medium, and High). 

The Interval group is set to a value of 5-minutes and cannot be changed since it is the 
only valid value for this card.

You can view up to 12 five-minute bins of performance data. The data in Bin number 1 
always contains the data for the current interval. Bin number 2 contains the data for the 
previous interval and so on.

Use the Priority field to specify the queue for which you want to view data. The 
Direction field is not enabled for this tab.

In the Bin spin box, set the Bin value (1 to 12). The bin will contain the maximum and 
minimum smoothed values which occurred in that five-minute period.

The data will not automatically refresh. You must click the Refresh button to refresh 
the data manually. Click the Clear button to clear all the performance data for this port. 
Click the Graph button to display the data in graphical format.

The PM Data for . . . box displays the following items of data for bin 1:
� Current value for the period.
� Maximum value for the period.
� Minimum value for the period.
� Status of the queue.

For bins 2 through 12, only the following items of data display:
� Maximum value for the period.
� Minimum value for the period.
� Status of the queue.

Figure 6-123: DSL Port Queue Congestion PM Tab
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The advantage of displaying the current bin is that by selecting the Refresh button, 
both new and old data can be displayed so that the values can be compared.

Click any of the column headings and drag to resize them.

IDSL Port 
Connection Tab 
Page

Click the Connection tab to display the following tab page.

The Connection tab lists all connections on the port by ID, and shows the traffic 
descriptor assigned to each connection and the VPI/VCI addresses for the Link A and 
Link Z sides of the connection. Any conditions are also listed.

Select any connection and click the Open Connection button to display connection 
details. Click the New Connection button to add a new virtual connection. For details, 
see Chapter 9—“Connection Dialog Boxes,” page 6-143.

Figure 6-124: IDSL Port Connection Tab
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Chapter 9
Connection Dialog Boxes

Introduction To enable data transport using any of the line cards or broadband tributary cards, a 
connection must be set up between the trunk interface and the line card port or 
broadband tributary card port on which data will be sent and received. In addition, a 
Virtual Circuit (VC) cross-connection can be created to allow broadband tributary cards 
to function as trunk cards for virtual circuits to and from line cards, other broadband 
tributary cards, and trunk cards. The descriptions in this chapter assume that you are 
viewing either:
� The Connection tab for a card’s port interface, which includes a list of connections 

for that port.
� The system-wide Connections dialog box, which includes a list of all the connec-

tions in the system.
� The New Connection dialog box, which includes configuration information to cre-

ate a new virtual connection.

Creating a New 
Connection for 
DSL Line Cards

Click the New Connection button (on the Connection tab for line card ports) or select 
the New Connection... Tools menu item (for system-wide access) to display the New 
Connection dialog box.

Figure 6-125: New Connection Dialog Box
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Creating a New Connection for DSL Line Cards
Link A is the line card side of a PVC and Link Z is the trunk side of a PVC. To create 
a VC cross-connection, select a broadband tributary card from the Slot pull-down menu 
in the Link Z group. For details see “VC Cross Connections,” page 6-156. The 
VPI/VCI fields at the bottom of both Link A and Link Z’s group boxes specify the 
ATM circuit address for each end of the connection. The VPI (Virtual Path Identifier) 
identifies the route to be used by the ATM cell. A virtual path may include multiple 
virtual channels. The VCI (Virtual Circuit Identifier) identifies the specific virtual 
channel to which the cell belongs. The VPI and VCI are translated at each ATM switch 
and are unique only for a given physical link. This information is read-only.

The Shelf, Slot, and Port fields specify the address where the line card side of the PVC 
terminates. For a PVC that connects a line card and a trunk, these fields are only 
meaningful for Link A.

Enter a Traffic Descriptor Index number or click on the "..." button to select a Traffic 
Descriptor from the traffic desciptor dialog box shown in Figure 6-126:  Traffic 
Descriptors Dialog Box.

Select a Traffic Descriptor index number from the table, then click Close. For details 
on traffic descriptors, see Section 3—D50 Multiplexer, Chapter 1—“Network 
Element,” page 3-1.

The following rules apply to traffic descriptors:
� A traffic descriptor must exist before creating connections.
� Traffic descriptors cannot be deleted unless all the associated connections are 

deleted.
� Traffic descriptors cannot be modified once created.
� An existing connection can be moved from one traffic descriptor to another by first 

deleting the connection, and then re-creating the connection and associating it with 
the desired traffic descriptor.

Select VP Connection to set up a Virtual Path (VP) without setting up individual 
Virtual Circuits within the VP. For example, if you have multiple PCs connected to a 
single ADSL router at the remote end CPE, use the VP Connection option to configure 
the same parameters for all nodes attached to the router.

Figure 6-126: Traffic Descriptors Dialog Box
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The Topology radio buttons specify the direction in which the PVC sends data:
� Duplex. Transmits data both directions through this port.
� Simplex AZ. Transmits data up from the port only.
� Simplex ZA. Transmits data down to the port only.

The Administration State radio buttons specify whether the connection is available 
for service. Unlocked makes the connection usable if there are no other conditions 
blocking its use. Locked makes the connection unavailable for service. The 
administration state should be set to Locked when configuring or deleting a 
connection.

Click Create to create the new link. Click Cancel to exit with out making any changes.

DS1 Line Card 
Connections

Unlike the DSL cards, the DS1 card uses the Frame Relay standard instead of the ATM 
standard. The New Connection dialog box is shown in Figure 6-126:  Traffic 
Descriptors Dialog Box. The differences in how to create a connection are described 
below. 

Frame Relay uses DLCI (Data Length Connection Identifier) as the identifier. The 
value for this field must be between 16 and 991.

The Shelf, Slot, and Port fields specify the address where the line card side of the PVC 
terminates. For a PVC that connects a line card and a trunk, these fields are only 
meaningful for Link A.

Use LMI Tunneling to pass the LMI traffic to the other end of the connection instead 
of terminating LMI locally in the DS1 card. It can only be used with FRF.5 function 
types. LMI monitors the availability of the Frame Relay link and the DLCIs (Data Link 

Figure 6-127: DS1 New Connection Dialog Box
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Connection Identifier) on that link. LMI Tunneling is not available in an ATM over 
DS1 connection. For details see “ATM Over DS1 Connections,” page 6-149.

The DLCI is a 10 bit number in the Frame Relay header. It identifies the virtual circuit 
number with local significance at the UNI that corresponds to a specific destination. 
DLCIs are specified at Link A, while VPI/VCI values are specified at the Link Z side. 
The value for this field must be between 16 and 991.

Note: This parameter is not specified if the interworking function type is PPP LLC, 
or PPP VcMux.

Note: This parmeter is replaced by a Link A VCI parameter when an ATM 
Interworking Traffic Descriptor is used.

Enter a Traffic Descriptor Index number or click on the "..." button to select a Traffic 
Descriptor from the traffic desciptor dialog box shown in Figure 6-126:  Traffic 
Descriptors Dialog Box.

Select a Traffic Descriptor index number from the table, then click Close. For details 
on traffic descriptors, see Section 3—D50 Multiplexer, Chapter 1—“Network 
Element,” page 3-1.

The following rules apply to traffic descriptors:
� A traffic descriptor must exist before creating connections.
� Traffic descriptors cannot be deleted until all associated connections are deleted.
� Traffic descriptors cannot be modified once created.
� An existing connection can be moved from one traffic descriptor to another by first 

deleting the connection, and then re-creating the connection and associate it with the 
desired traffic descriptor.

VP Connection is not selectable.

The Topology radio buttons specify the direction in which the PVC sends data:
� Duplex. Transmits data both directions through this port.
� Simplex AZ. Transmits data up from the port only.
� Simplex ZA. Transmits data down to the port only.

The Administration State radio buttons specify whether the connection is available 
for service. Unlocked makes the connection usable if there are no other conditions 
blocking its use. Locked makes the connection unavailable for service. The 
administration state should be set to Locked when configuring or deleting a 
connection.
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Enter a IWF Descriptor Index number or click on the "..." button to select a IWF 
Descriptor from the IWF desciptor dialog box shown in Figure 6-128:  Frame 
Relay/ATM Interworking Function Descriptors Dialog Box.

Select a IWF Descriptor index number from the table, then click Close.

Select New to create a new Frame Relay/ATM Interworking function descriptor.

The Interworking Function Type group is used to set the function type of the IWF 
descriptor.

Note: Do not configure a PPP and FRF connection on the same port.

Figure 6-128: Frame Relay/ATM Interworking Function Descriptors Dialog Box

Figure 6-129: New IWF Descriptor Dialog Box
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The options are:
� PPP LLC – Point-to-Point Protocol Logical Link Control. On the far end (CPE 

side), it is treated as PPP over HDLC. On the ATM side, this frame is placed into 
AAL5 with LLC encapsulation per RFC 1483 Multiprotocol Encapsulation over 
AAL5. The hardware at the far end must support LLC encapsulation for this type 
interworking type. 

� PPP VCMUX – Point-to-Point Protocol Virtual Connection Multiplex. On the 
ATM side, a PPP frame is directly placed into the AAL5 frame without any encap-
sulation. This type can be used if the hardware at the far end does not support LLC 
encapsulation.

� FRF.8 – Frame Relay Forum Standard 8. This is used when the ATM network con-
nects a single Frame Relay network. It describes a one-to-one mapping between 
Frame Relay and ATM connection per the standard.

� FRF.8 Transparent – Frame Relay Forum Standard 8. This is used when the ATM 
network connects a single Frame Relay network. On the Frame Relay side, the 
Frame Relay header is removed and the payload (with possible encapsulation) is 
placed unaltered in an AAL5 frame. On the ATM to Frame Relay side, the Frame 
Relay frame is created by attaching a frame header to the AAL5 payload with possi-
ble encapsulation.

� FRF.5 One-To-One – Frame Relay Forum Standard 5. Use when the ATM network 
connects two Frame Relay networks, where a single Frame Relay connection is 
mapped to a single ATM connection per the standard.

� FRF.5 Many-To-One – Frame Relay Forum Standard 5. Use when the ATM net-
work connects two Frame Relay networks, where multiple Frame Relay connec-
tions are mapped to a single ATM connection per the standard.

Note: In cases where FRF.5 One-To-Many is selected for any of the DLCIs 
provisioned on a DS1 port, LMI mode has to be set to None on that port (i.e LMI 
cannot be used).

� FRF PPP VCMUX – Frame Relay Forum Point-to-Point Protocol Virtual Connec-
tion Multiplex. In this case, the PPP frame is placed in the Frame Relay frame with 
normal encapsulation on the far end (CPE side). On the ATM side, a PPP frame is 
directly placed into the AAL5 frame without any encapsulation. Use when PPP over 
Frame Relay traffic is forwarded without any encapsulation in the AAL5 frame.

� ATM – This Interworking Function Type enables the DS1 card to receive ATM 
cells using existing T1 lines. Data and packetized voice can be transported over 
existing T1 lines to an ATM network through the D50.

See the volume titled Provisioning for more information. 

The Frame Relay End-Points group is used to set the Committed Burst Size, Excess 
Burst Size, and Committed Information Rate.

In the Translation Mode Mappings group, enter:
� The Loss Priority Frame Relay to ATM. The options for this list box are:

– DE to CLP. Places the DE value in the CLP bit without alteration. Each ATM cell 
that is generated as a result of segmenting each Frame Relay frame contains this 
DE/CLP value.
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– Const0 to CLP. The CLP bit is set to a constant of “0” for all ATM cells gener-
ated as a result of segmentation in the connection regardless of the DE value.

– Const1 to CLP. The CLP bit is set to a constant of “1” for all ATM cells gener-
ated as a result of segmentation in the connection regardless of the DE value.

� The Loss Priority ATM to Frame Relay. The options for this list box are:
– CLP to DE. If one or more cells belonging to the AAL5 frame has the CLP bit 

set, the dE bit will be set in a corresponding Frame Relay frame.
– Const0 to DE. The DE bit is set to a constant of “0” for the generated Frame 

Relay frame.
– Const1 to DE. The DE bit is set to a constant of “1” for the generated Frame 

Relay frame.
� Forward Congestion Indicator Frame Relay to ATM EFCI (Ingress Direction)

– FECN to EFCI. The FECN bit is placed into the EFCI bit without alteration.
– Constant to EFCI. The EFCI bit is provided a constant value of “0.” 

Note: Translation Mode parameters are not available for ATM over DS1 
connections. For more information, see ATM Over DS1 Connections, page 6-149.

Click Create to create the new IWF descriptor. Click Cancel to exit with out making 
any changes.

For a detailed explanation of these parameters, refer to Volume 4—Provisioning, 
Chapter 6—“DS1 Provisioning.”

ATM Over DS1 
Connections

ATM over DS1 is a method for transmitting ATM cells using existing T1 lines. ATM 
over DS1 allows features such as packetized voice to be transported over DS1 and onto 
an ATM network via the Nokia D50.

Figure 6-130: ATM for DS1 Connection Provisioning
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The field descriptions for the ATM over DS1 New Connection dialog box are the same 
as in the New Connection dialog boxes described previously except:
� The LMI Tunneling field is not avaliable.
� The DLCI field is replaced with a Link A VCI field.

To view the descriptions of the fields, see Creating a New Connection for DSL Line 
Cards, page 6-143.

Select Index 4 as the IWF descriptor to automatically select ATM over DS1 for the 
new connection. The LMI Tunneling and DLCI fields will no longer be available as 
shown in Figure 6-130:  ATM for DS1 Connection Provisioning.

Note: You can manually create an IWF Descriptor that has an Interworking 
Function Type of ATM to create an ATM over DS1 connection.

Current 
Connections 
Interface

To display information about a current connection, click on the connection ID in the list 
box, then click the Open Connection button (on the Connection tab for line cards) or 
the Show Connection button (on the system-wide Connections dialog box) to display 
the Connection dialog box (you can also double-click on the connection ID with the left 
mouse button to display this dialog box). This dialog box includes the following tab 
pages:
� Status.
� Connection.
� IWF Stats (only on DS1 line cards).

Status Tab Page The Status tab displays initially.

The Conditions list box displays conditions associated with the selected object. Data in 
the Conditions list box is refreshed periodically by the system. The data can also be 
updated by clicking the Refresh icon on the toolbar.

Figure 6-131: Open Connection Status Tab
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The Administration State group allows you to control whether or not the connection is 
available for service. Unlocked makes the connection available if there are no other 
conditions blocking its use. Locked makes the connection unavailable for service; 
connections should be locked when being configured, when making hardware 
upgrades, or when testing.

Note: If a connection is locked, any alarms for that connection will not display in 
the Active Alarms list, but they will display in the Conditions box on the 
connection’s Status tab. If an alarm condition exists and the unlocked option is 
selected, an alarm will then be displayed in the Active Alarms list. For descriptions 
of alarm conditions, see the volume titled Maintenance and Testing.

The Create button is not available.

Click the Delete command button and a warning message displays indicating that the 
connection is about to be deleted from the system. You can either click the OK button 
to proceed, or the Cancel button to cancel the operation.

Note: You must delete all of a card’s connections and lock the port and the card 
before you can delete the card.

Connection Tab 
Page

Click the Connection tab to display the following tab page.

The Link A and Link Z groups display address information for the selected 
connection.

The Topology radio buttons specify the direction in which the PVC sends data:
� Duplex. Transmits data both directions through this port.
� Simplex AZ. Transmits data up from the port only.
� Simplex ZA. Transmits data down to the port only.

Figure 6-132: Open Connection Tab
Release 11.0 Page 6-151
© 2002 Nokia. Proprietary Data.



Volume 6, Section 6: Line Card Shelf and Cards
Show A and Show Z Tab Pages
The Cell Counts box displays the ingress and egress cell counts for the connection. 
Click the Local Reset button to set the count back to 0.

Click the Show A or Show Z command buttons to display the tab pages for the A or Z 
side of the connection.

Show A and 
Show Z Tab 
Pages

The Show A/Show Z interface includes the following tab pages:
� Status.
� Link Config.
� OAM Config.

Show A/Z Link 
Status Tab Page

The Status tab displays initially.

The Conditions list box displays conditions associated with the connection. Data in the 
Conditions list box is refreshed periodically by the system. The data can also be 
updated by clicking the Refresh icon on the toolbar.

Note: If a connection on a DS1 card is being viewed, the OAM Config tab will be 
replaced with a IWF Stats tab. See DS1 IWF Stats Page, page 6-155.

Figure 6-133: Show A/Z Status Tab
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Show A/Z Link 
Configuration 
Tab Page

Click the Link Config tab to display the following tab page.

The IDs group displays the VPI and VCI addresses for the selected connection.

Traffic Descriptors. The traffic descriptors indicate a specific set of connectivity 
characteristics based on standard traffic management contracts.
� Receive: Specifies traffic characteristics (traffic management parameters and ser-

vice category) for the virtual connection.
� Transmit: Specifies traffic characteristics (traffic management parameters and ser-

vice category) for the virtual connection.

Note: The Link Config tab for a DS1 card also contains the IWF descriptor ID 
number.

Show A/Z OAM 
Configuration 
Tab Page

Click the OAM Config tab to display the following tab page.

Figure 6-134: Show A/Z Link Configuration Tab

Figure 6-135: Show A/Z OAM Configuration Tab
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The OAM Configuration group allows you to specify whether Operations And 
Maintenance (OAM) ATM cells are sent on the PVC connection.

The End Point Configuration group allows you to specify the type of processing this 
virtual link applies to ATM loopback cells.
� None. Performs no ATM loopback cell processing.
� Segment. Functions as a segment-type loopback cell node. Segment loopback cells 

loop back to the other end of the ATM connection.
� End to End. Functions as an end-to-end-type loopback cell node. End-to-end loop-

back cells loop back to the other end of the ATM connection.
� Both. Functions as both a Segment and End-to-End loopback cell node. Both types 

of loopback cells loop back to the other end of the ATM connection.

The Loopback Cell Types group allows you to specify the type of ATM loopback cell 
that will be looped back to the other end of the connection.

The Location ID field allows you to specify a 16-byte character string indicating 
where the OAM loopback cell should go. You normally identify a destination ID if the 
loopback point is not a segment or an end-to-end endpoint.

The Loopback Result box is a read-only list box that shows the results of the ATM 
loopback test.
� Unknown. Loopback result is not known.
� Timeout. Loopback cells were sent, but did not return within the timeout interval.
� Error. Unknown loopback failure detected.
� Succeeded. Loopback cell successfully returned.
� Invalid. Invalid destination specified for the loopback cell, or the loopback cell 

could not reach its intended destination.

� Already Active. Loopback is already active, cannot start another one until current 
loopback completes.

� Resources. No more loopbacks available on this multiplexer.
� No OAM. OAM cell traffic not enabled for this connection.
� Non-Default. This link is an intermediate point, and you are attempting to use a 

default NE ID value for the loopback.

Note:  If the Loopback Test result is Succeeded, The Loopback Result field will 
display the result "Succeeded" along with the OAM Cell Delay value. This value is 
the difference between the cell sent and the cell received. OAM Cell Delay will only 
be displayed if the Loopback Test has Succeeded.
The Cell Delay value is displayed in the ss:ms (seconds : milliseconds) format.

Click the Loopback Activate button to activate diagnostic testing for the connection.
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DS1 IWF Stats 
Page

When you open a connection on an DS1 line card, a IWF Stats tab page will be 
included. Click the IWF Stats tab to display the following tab page. 

This tab page is for viewing the Frame relay/ATM values. To reset the counters, click 
Reset Counters.

Figure 6-136: Open IWF Stats Tab
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VC Cross 
Connections

Four types of VC cross-connections are supported in addition to trunk card routing as 
shown in Table 6-10:  VC Cross-Connection Types below.

These cross-connection types are discussed in detail in Chapter 14—“VC 
Cross-Connection Provisioning,” in the volume titled Provisioning. VC 
cross-connections are provisioned exactly like the regular line card to trunk card 
connections using Craft Terminal with one exception. To facilitate VC 
cross-connections, Link Z can either be a trunk card or a Broadband Tributary card.

Table 6-10: VC Cross-Connection Types

Link A Link Z

Line Card to Broadband Tributary Card

Broadband Tributary Card to Broadband Tributary Card

Broadband Tributary Card to Trunk Card

Line Card1

1 This connection is the standard connection type.

to Trunk Card
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Appendix A
Craft Terminal Troubleshooting Tips

Craft Terminal 
Troubleshooting 
Tips

Follow the Recommended Actions listed below to correct error conditions or problems 
for installing and running Craft Terminal:

Table 7-1: Craft Terminal Troubleshooting Tips

#
IF THE CONDITION IS 

THIS... THEN DO THIS...

1 “MgmtApi.dll not found” error 
message appears immediately on 
starting the Craft Terminal 
application.

In Windows NT or Windows 2000, 
turn on SNMP services in Network 
Services.

2 “The ordinal <6467> could not be 
located in dynamic library 
MFC42.DLL” error message 
appears on starting the Craft 
Terminal application.

Reinstall latest Windows NT service 
pack.

3 “Remote Access Services are not 
turned on...”

In Windows NT or Windows 2000, 
turn on RAS services in Network 
Services.

4 “Error connecting to D50” is 
displayed in the error bar of Craft 
Terminal GUI.

� Check all port settings (baud 
rate, stop bits, etc.) against instal-
lation details.  

� Check modem settings against 
installation details.

� Check that cable is properly 
attached to serial port connector, 
and/or try another cable.

� Reboot NMP by pulling/resetting 
NMP card.

� Test serial port with oscilloscope. 
Contact the manufacturer if 
problem continues.

� Reinstall latest Windows NT ser-
vice pack.
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5 “Connected” then “Timeout” 
messages appear in the error bar of 
Craft Terminal (and no data is 
shown).

� Reinstall latest Windows NT ser-
vice pack.

� Reboot NMP by pulling/resetting 
the NMP card.

6 “An earlier version of this 
application is required to 
communicate with this system.”

� Craft Terminal does not manage 
D50s running previous system 
software that is older than 
Release 5.1. An earlier version of 
Craft Terminal can be loaded 
onto the same platform as the 
current version, but must be 
installed into a different direc-
tory.

� Craft Terminal cannot find the 
D50. Check the IP address, net-
work connections, etc.

Table 7-1: Craft Terminal Troubleshooting Tips (continued)

# IF THE CONDITION IS 
THIS...

THEN DO THIS...
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Glossary and Acronyms

10BaseT. A 10 Mbps Ethernet network that uses unshielded twisted pair cable in a star 
topology with a central hub.

2B1Q (Two Binary, One Quaternary). A line encoding technique used in ISDN BRI, 
IDSL and SDSL. It is a four-level PAM (Pulse Amplitude Modulation) technique, 
which maps two bits of data into one quaternary symbol, with each symbol 
comprising one of four variations in amplitude and polarity over a circuit.

AAL (ATM Adaptation Layer). ATM Adaptation Layer is located above ATM and 
converts non-ATM bit streams into ATM cells. The AAL protocol supports higher-
layer service requirements.

ADSL (Asymmetric Digital Subscriber Line). Asymmetrical data signals for Internet 
access that share twisted pairs with POTS and that use modern signal modulation 
techniques to accomplish the data communications task. The downstream rates are 
much faster than the upstream rates.

AIS (Alarm Indication Signal). A downstream signal in a digital network that 
replaces the normal traffic signal when a maintenance alarm indication has been 
activated (indicating an upstream failure detection − error or alarm on the network). 
It is used in the OSI network management model. 

Alarm. A signal used to indicate that an abnormality, a fault, or a failure has been 
detected. Alarms may be distinguished by type and by the severity of the event that 
caused the alarm. 

ANSI (American National Standards Institute). Founded in 1918, ANSI is a U.S. 
voluntary standards setting board.

API (Application Programming Interface). Software that an application program 
uses to request and carry out lower-level services performed by an operating system.

ASCII (American Standard Code for Information Interchange). A computer 
coding method for converting alphanumeric and punctuation characters and control 
codes into digital (binary) form.

ATM (Asynchronous Transfer Mode). A multiplexed information transfer and 
switching process (cell-switched technology) in which data is organized into fixed 
length (53 octet) cells and transmitted according to each application’s requirement. 
ATM is generally deployed in enterprise networks, which often connect LANs over 
wide areas that require large amounts of data to be transported over great distances.

Attenuation. Attenuation is the loss of signal strength over distance. Attenuation is 
measured in decibels.
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ATUC (ADSL Transmission Unit – Central Office). Special electronics located in 
the Central Office to support a high rate of data transmission over UTP copper 
wires. This is the “downstream” direction. Works in conjunction with ATUR (see 
below).

ATUR (ADSL Transmission Unit – Remote). Special electronics located at the 
customer’s premises to support a high rate of data transmission over UTP copper 
wires. This is the “upstream” direction. Works in conjunction with ATUC (see 
above).

AutoBaud. A set of drivers available on SDSL devices to promote inter-operability.

Auxiliary Common Systems Interface Panel (CSIP). Each Auxiliary CSIP connects 
and distributes Central Office power to up to four Line Card Shelves (LCSs). 
Auxiliary CSIPs are required for D50’s with over five LCSs.

AWG (American Wire Gauge). A standard classification for measuring non-ferrous 
conductors such as copper wire.

Backbone. The part of a network that carries the heaviest traffic. It is one basis for the 
design of an overall network service. For example, the D50 operates on an ATM 
backbone.

Bandwidth. The capacity of a communications channel. For digital communications, 
bandwidth is usually measured in bits per second.

BER (Bit Error Rate). A measurement of transmission quality expressed as a ratio 
(ratio of error bits to the total number of bits transmitted − erroneous bits per 
million). The BER indicates how many bits are incorrectly transmitted in a given bit 
stream. The BER depends on the type and length of transmission.

BNC (Bayonett Neill Concelman). A bayonet-locking cabling interconnection 
standard, used in thin coaxial cable Ethernet applications. 

BPS (Bits Per Second). A measurement of transmission speed – number of bits 
transmitted each second.

Bridge. A communications device used to interconnect networks or network nodes 
with a common set of higher level protocols.

Broadband. A communications method in which multiple channels are formed by 
dividing the transmission medium on a shared communications path. Generally 
describes communications above 1.5 Mbps.

Burst. A short flow of packets, often followed by idle periods where there is no 
transmission activity. 

CAC (Connection Admission Control). Procedures carried out by an ATM network 
at connection set-up to determine whether a requested virtual connection can be 
supported or should be rejected. 

CAM (Complimentary Analysis Module). A Nokia Broadband Systems product. A 
card that is used to provide the pathway to perform continuity testing from the LCS 
to the MDF when using a Low Pass Filter Shelf (LPFS8). Plugs into the LPFS8 
backplane in the same manner as a Low Pass Filter card. Works with the PAM (Pair 
Analysis Module) card.
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CAP (Competitive Access Provider). An alternative competitive local exchange 
carrier.

CBR (Constant or Continuous Bit Rate). An ATM service category that supports a 
constant or guaranteed rate to transport services such as video or voice as well as 
circuit emulation requiring rigorous timing control and performance parameters.

CCA (Congestion Control and Avoidance). A resource and traffic management 
mechanism to correct, avoid and/or prevent excessive situations such as buffer 
overflow or insufficient bandwidth that can cause the network to collapse.

CDV (Cell Delay Variance). A component of Cell Transfer Delay, induced by 
buffering and scheduling.

CDVT (Cell Delay Variance Tolerance).  Specifies the acceptable tolerance to cell-
by-cell variations of the CDV (jitter).

CE. Products sold into the European Economic Community since January 1996 are 
required to carry the CE Mark. The CE Mark represents that the product meets all 
Electromagnetic Compatibility Directives.

Cell. The smallest data component in an ATM stream. The ATM Cell has a 5-byte 
header and contains 48 bytes of payload.

CEV (Controlled Environment Vault). An environmentally conditioned room for 
housing optical and electronic equipment.

Channel. A point-to-point link in a communications system. 

Circuit. A transmission path for sending and receiving data and/or voice between two 
points in a telecommunications system.

Circuit Emulation. A virtual circuit service offered to end users where the 
characteristics of an actual, digital bit-stream line (for example, video traffic) are 
emulated.

CLEC (Competitive Local Exchange Carrier). These carriers compete with the local 
exchange service to provide telephone service to customers who may choose voice 
and/or data services. Additionally, a CLEC may lease existing lines or provide their 
own local loop.

CLEI (Common Language Equipment Identifier) Codes. Assigned to all 
telecommunications equipment that may be installed in a RBOC facility (or other 
facilities if required). The codes are assigned by Bellcore (now SAIC).

Client/Server Model. In the client-server model, the server program offers a service 
reachable over the network (or within a stand-alone system). A server receives a 
request, performs the service, and returns the result to the requester. The client 
program sends a request to the server and waits for a response.

CLP (Cell Loss Priority). A 1-bit field in the ATM cell header that corresponds to the 
loss priority of a cell. Lower priority (CLP=1) cells can be discarded under a 
congestion situation.

CLR (Cell Loss Ratio). A QoS parameter that gives the ratio of the lost cells to the 
total number of transmitted cells on a given VCC in cells per second.
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CMIP (Common Management Information Protocol). An OSI network 
management/service interface protocol created and standardized by ISO. Based on 
the basic data storage concept in which management information is collected and 
stored for subsequent retrieval by a management application. Provides for the 
transmission of event notifications and the transmission of operations directed 
toward managed objects.

CO (Central Office). Houses the Local Exchange switch that terminates individual 
local telephone subscriber lines for switching and connection to the public network 
(locally and long distance).

Coding Violation (CV). A violation detected in the coding of a signal. 

Common Systems Interface Panel (CSIP) Alarm Board. All D50 alarm connections 
are made at the CSIP Alarm Board; Central Office visual, audible, remote Bay 
Alarm and remote input alarms. The Alarm Board has LEDs to display D50 alarm 
status.

Common Systems Interface Panel (CSIP) Power and Distribution Board. The 
CSIP Power and Distribution Board is located in the Master Control Shelf (MCS). 
Central Office power is terminated at the CSIP and is distributed to the MCS and up 
to four Line Card Shelves (LCSs).

CORBA (Common Object Resource Broker Architecture). An Object Request 
Broker (ORB) standard developed by the Object Management Group (OMG). It is 
an object-oriented technology which provides a scalable, open platform for both 
service provider and large enterprise network environments.

COT (Central Office Terminal or Termination). The termination of a local loop 
facility. Located at the Central Office facility. See Digital Loop Carrier for further 
information about how this is used.

CPE (Customer Premises Equipment). Refers to telephone and related equipment 
located on the customer’s premises (office or home).

Craft Terminal (DiamondCraft®). Craft Terminal, previously known as 
DiamondCraft, is the D50’s stand-alone craft interface application. It communicates 
directly with a D50 through a serial port connection using Point-to Point Protocol 
(PPP) or an Ethernet connection.

CRC (Cyclical Redundancy Checking). A data error-detecting mathematical process 
designed to ensure that errors don’t occur undetected in a block of data. Systems 
using CRC will request that data be retransmitted if errors are detected.

Cross-connect. A connection between two or more elements of a telecommunications 
system.

CTD (Cell Transfer Delay). A QoS parameter that measures the maximum or worst-
case time for a cell to be transferred from its source to its destination over a virtual 
connection. It is the sum of buffering, propagation, processing and queuing delays.

D50 Multiplexer. The D50 Multiplexer is classified as a Digital Subscriber Line 
Access Multiplexer (DSLAM). The D50 Multiplexer uses Digital Subscriber Line 
(DSL) and Asynchronous Transfer Mode (ATM) technologies to deliver high speed 
data rates over the existing copper network.
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D50 RAM (Remote Access Module). The D50 RAM is a small, versatile DSL remote 
line card shelf supporting up to three 8-port D50 line cards, one Line Card Shelf 
Multiplexer card, and three low pass filter cards, for up to 24 lines. It is equivalent 
to a small LCS.

Data Rate. The rate at which a channel carries data – measured in bits per second.

dB (Decibel). The decibel is a unit used to measure the power of sound or voltage. It is 
expressed as the ratio of two values. In telephony, the decibel (a logarithmic 
measurement) is used as a measure of relative power between circuits or 
transmission level points. As a reference: a change in level of 1 dB is barely 
perceptible under ideal conditions; however, increases or reductions of 3 dB result 
in doubling or halving, respectively, the power in a circuit. The corresponding 
figure for doubling or halving voltage is 6 dB.

DLC (Digital Loop Carrier). Network transmission equipment used to provide a pair 
gain function. DLC equipment is deployed in situations in which the cost of the 
equipment is more than offset by the savings in copper distribution accomplished by 
eliminating need for as many copper pairs. Digital loop carrier systems consist of 
two parts—a Central Office Terminal (COT) and a Remote Terminal. The COT 
provides the multiplexing/demultiplexing function of individual voice signals to the 
composite multiplexed signal at the interface between the switching equipment and 
the DLC. The Remote Terminal provides the multiplexing/demultiplexing function 
at the interface between the individual subscriber pairs and the DLC equipment.

DMT (Discrete Multi-Tone). Modulation technique which uses Frequency Division 
Duplex multiplexing to transmit data in the 35 kHz to 1.1 MHz frequency spectrum. 
It divides the frequency range into 256 discrete bands, each with 4 kHz bandwidth. 
Each band is independently modulated.

Downstream. The communications path going from the CO or DSLAM to the 
client/end user.

DS1 (Digital Signal Level One). 1.544 Mbps digital signal.

DS3 (Digital Signal Level Three). 44.736 Mbps digital signal − equivalent of 28 T-1 
channels (also referred to as T-3).

DS3L. A DS3 rate broadband tributary card that provides a standard ATM UNI/NNI 
interface that supports provisionable VPI/VCI mappings to the D50 trunk card, 
allowing ATM cells to be aggregated from standard ATM network equipment.

DSL (Digital Subscriber Line). The generic name for a family of digital services 
provided by the local telephone companies to their local subscribers. The high 
speeds of transmission (up to 8 Mbps) are accomplished over the existing twisted 
pair copper wires.

DSLAM (Digital Subscriber Line Access Multiplexer). An ATM access 
mux/concentrator that grooms traffic from multiple low rate lines into a high rate 
trunk (DS1, DS3, OC3, OC12).

Duplex. Simultaneous, two-way independent transmission of data. Both ends of the 
communication can send and receive data at the same time. Also referred to as full-
duplex.
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EFCI (Explicit Forward Congestion Indication). A field in the ATM cell header 
indicating congestion or impending congestion. When EFCI is set, it indicates that a 
network element is either in a congested state or there is a potential congested state 
problem. The ATM end-system receiving cells with EFCI set can use this indication 
to adaptively decrease the cell rate of the connection to avoid congestion.

Egress.  Outgoing direction to a network or network device. The term refers to data 
being sent out of a device or system, as opposed to information being sent into a 
network or network device (ingress).

EMI (Electromagnetic Interference). Unwanted electrical noise from an external 
source that can interfere with transmissions over copper cables.

EML (Element Management Layer). A layer representing the management and 
monitoring of components, at their lowest level, in a telecommunications network. 
In short, an abstraction of the functions provided by systems that manage each 
network element on an individual basis.

EMS (Element Management Systems). Software used to manage and monitor 
components of a telecommunication system at the lower levels of the 
Telecommunications Management Network.

EOC (Embedded Operations Channel). A control and signaling channel used for 
operations, administration and maintenance of the transmission line. 

EPD (Early Packet Discard). A congestion control technique that selectively drops 
all but the last ATM cell in a Classical IP over ATM packet.

Error Rate. The ratio of incorrect elements sent to the total number of elements 
transmitted.

ES (Errored Seconds). The number of seconds in which at least one coding violation 
was detected.

ESD (Electrostatic Discharge). Transfer of an electrostatic charge on a surface 
through a conductive path to ground.

ETSI (European Telecommunications Standards Institute). ETSI is the European 
counterpart to ANSI, the American National Standards Institute. ETSI was founded 
in 1988.

Fault. Performance degradation that impacts the ability of the network element from 
properly performing.

FEBE (Far End Block Error). FEBE is used to monitor bit error performance of a 
communication link. An indication returned to the source that the far-end receiver 
has detected one or more errors in its received signal from the source.

FEC (Forward Error Correction). A transmission method in which extra bits or 
characters transmitted with the payload so that transmission errors can be corrected 
on the receiving end without forcing a retransmission.

FM (Fault Management). A data collection and reporting mechanism for component 
fault analysis.
Page 7-8 Release 11.0
© 2002 Nokia. Proprietary Data.



Frame. In Time Division Multiplexing (TDM), a frame is one complete cycle of 
events. The frame consists of a fixed-size block of bits, which contains one (or 
more) time slots for each channel, plus synchronization and other overhead bits. 

Frame Relay. Frame Relay is a packet mode switching interface defined by the ITU-T. 
Frame relay is provided on fractional T-1 or full T-carrier system carriers.

FRF. Frame Relay Forum.

FRF.5. Frame Relay/ATM PVC Network Interworking Implementation Agreement. 
FRF.5 provides the standard for ATM to become a high speed backbone for Frame 
Relay PVCs.

FRF.8. Frame Relay/ATM PVC Network Interworking Implementation Agreement. 
FRF.8 provides the standard for Frame Relay PVCs and ATM PVCs to 
communicate.

GFC (Generic Flow Control). A four bit field in the ATM header which can be used 
to provide local functions (e.g. flow control). The GFC is used to ensure that all 
nodes obtain access to the transmission medium. It can also be used to prioritize 
transmissions by data type.

GUI (Graphical User Interface). Generic name for the computer interface that 
presents graphics (icons) and characters. The GUI permits users to directly 
manipulate graphical objects displayed on the monitor. 

HDLC (High Level Data Link Control). An ITU-TSS link layer protocol standard 
for point-to-point and multi-point communications. HDLC includes functions for 
link establishment, sequencing, flow control and error recovery.

HDSL (High bit rate Digital Subscriber Line). HDSL provides a T1 on two copper 
wire pairs (without the loop engineering and repeaters required for a standard T1 
system).

HEC (Header Error Control). An 8-bit field (the last byte) of the ATM-cell header, 
whose purpose is to allow a receiver to detect, and possibly correct, transmission 
errors in the cell header. It is used for checking integrity only.

HTML (Hyper Text Markup Language). HTML is the software programming 
language used to create World Wide Web pages.

IAD (Integrated Access Device). An integrated-access device that can multiplex 
voice and data on one line. 

IDF (Intermediate Distribution Frame). A metal rack designed to connect cables 
and located in an equipment room or closet. Consists of bits and pieces that provide 
the connection between inter-building cabling and the intra-building cabling (i.e. 
between the Main Distribution Frame (MDF) and individual phone wiring).

IDSL (ISDN Digital Subscriber Line). Delivers speeds up to 128/144 Kbps on 
copper loops as long as 18,000 feet. Dedicated service for data communications 
applications only. 2B1Q interface. In most cases, users can use their existing ISDN 
CPE equipment.
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IEEE (Institute of Electrical and Electronics Engineers). An international 
engineering organization that defines standards related to networking and other 
areas.

IETF (Internet Engineering Task Force). One of two technical engineering bodies of 
the Internet Architecture Board. The IETF is responsible for solving short-term 
engineering needs and standards of the Internet.

ILEC (Incumbent Local Exchange Carrier). The local carrier that is (typically) the 
primary carrier for local calls in a given area. ILECs are telephone companies that 
were part of the Bell System.

In-Band. Using the same circuit to transport both the information (e.g., data or voice) 
along with the signaling information.

Ingress. Incoming direction to a network or network device. The term refers to data 
being sent into a network element or system, as opposed to information being sent 
out (egress).

Interleave. A process or technique that reduces the number of undetected error bursts 
and improves burst error performance. Interleave mode provides the most robust 
service and more reliable service under long reach conditions for DSL service that 
supports the Interleave process.

Inverse Multiplexer (IMUX). A device that combines multiple links (usually T1s or 
E1s) a single shared digital channel. Circuits can be added and dropped without 
losing ATM cells.

IP (Internet Protocol). A component of the TCP/IP protocol suite. IP operates at 
Layer 3 of the OSI Reference model.

ISDN (Integrated Services Digital Network). ISDN is a digital telecommunications 
standard for transmitting digital voice, data and video on the same transmission 
facility. ISDN has two basic access interfaces; BRI (Basic Rate Interface) and PRI 
(Primary Rate Interface). Both interfaces provide circuit-switched access to public 
networks. BRI provides a throughput of 144 Kbps and PRI has a throughput of up to 
2 Mbps.

ISO (International Standards Organization). The International Standards 
Organization is an international organization founded in 1946 to facilitate the 
development of international data communication standards. 

ISP (Internet Service Provider). A vendor who provides access to the Internet and 
the World Wide Web.

ISU (Integrated Services Unit). A digital device that consists of a CSU (Channel 
Service Unit) and DSU (Digital Service Unit).

ITU (International Telecommunications Union). An organization established by the 
United Nations. The ITU sets telecommunications standards and allocates 
frequencies to various uses worldwide.

IWF (Interworking Function). A function used on an interface between networks 
which use dissimilar technologies.
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IXC (Interexchange Carrier). Long distance carrier such as AT&T, MCI WorldCom, 
Sprint, and some smaller carriers.

Java. A programming language developed by Sun Microsystems for platform 
independent, object-oriented application development.

JDBC (Java DataBase Connectivity). A Java based driver which provides a database 
independent interface between a Java application or applet and the database. It 
provides a Java API on one side and an SQL interface on the other.

JDK (Java Developer’s Kit). A (platform specific) development environment for 
creating Java based applications and applets.

Kbps (Kilo Bits Per Second). A measurement of transmission speed – one thousand 
bits transmitted each second.

kHz (Kilohertz). A unit of frequency equal to one thousand (1,000) cycles per second 
(Hz).

LAN (Local Area Network). A privately owned and administered network for data 
communications, usually within a building or campus environment, used to connect 
computers and peripheral devices. Communication is typically accomplished by 
broadcasting on a connectionless basis over a shared medium.

Latency. The amount of time between the moment a device generates a request for data 
and the instant at which the requested channel is available for transmission.

Leaky Bucket Algorithm. Officially called the Generic Cell Rate Algorithm. A 
method of explaining by means of a hole in a bucket, how an ATM switch measures 
the PCR and SCR conformance of each CBR and VBR connection.

Line Card. A line card serves as the interface between a line and a communications 
device. 

Line Card Shelf (LCS). The D50 is made up of one Master Control Shelf and up to 
twelve Line Card Shelves. Each LCS has 24 mounting slots for line cards, one slot 
for a Line Card Shelf Multiplexer (LSM) card, and one slot for an optional LSM 
card for Remote Line Card Shelf protection group application.

Line Card Shelf Multiplexer (LSM) card. The LSM card communicates with the 
Master Line Card Adapter (MLA) card. The LSM multiplexes and demultiplexes 
ATM cell streams for up to 24 line cards in a Line Card Shelf.

Link A. The virtual connection path between the D50 and the CPE (or line card) side 
of the network.

Link Z. The virtual connection path between the D50 and the ATM side of the 
network.

LISP (Local Internet Service Provider). See ISP (Internet Service Provider).

Local Loop. The twisted pair cable connecting the subscriber to the Central Office. 

LOF (Loss of Frame). A condition that can occur in digital transmissions when the 
receiving equipment loses frame alignment data (used to determine channel 
assignments and channel boundaries).
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Loopback. Type of diagnostic test in which the transmitted signal is returned to the 
sending device after passing through a data communications link or network. The 
returned signal is then evaluated (either by a technician or diagnostic equipment) to 
get some sense of the condition of the line. Typically used in troubleshooting a data 
circuit or network.

LOS (Loss of Signal). An alarm sent by the receiving end to indicate that the 
transmission signal has been lost.

Low Pass Filter Shelf (LPFS8). Data plus voice frequency signals are received from 
the customer at the Low Pass Filter Shelf. The LPF8 card “splits” the low frequency 
voice signal from the high frequency ADSL signal. The voice signal is sent to the 
voice switch unimpeded; the data signal is received by the line card.

Master Control Processor (MCP) card. The MCP card is the central control and 
communications path for the D50; it stores program and provisioning database 
information. The D50 has two MCP cards in a 1:1 protection group.

Master Control Shelf (MCS). The MCS contains the central control and 
communication functions for the D50 and serves as the ATM network interface.

Master Line Card Adapter (MLA) card. Each MLA card provides the broadband 
interface to one Line Card Shelf. There are up to twelve MLA cards in a Master 
Control Shelf providing the broadband interface for up to twelve Line Card Shelves 
and up to 288 line cards.

Mbps (Mega Bits Per Second). A measurement of transmission speed – one million 
bits transmitted each second.

MBS (Maximum Burst Size). An ATM traffic parameter that specifies the maximum 
number of cells in a burst that can be transmitted at the peak rate assuming that, at 
the beginning of the burst, the receiving buffers are empty.

MDF (Main Distribution Frame). A wiring arrangement which connects the 
telephone/data lines coming from outside on one side and the internal lines on the 
other.

MDU (Multiple Dwelling Unit). Refers to high-rise apartment buildings or sometimes 
office buildings. Newer MDUs are often being built with fiber optic cables and 
other equipment (such as DSLAMs) installed so the occupants have easy access to 
high-speed data services.

MHz (Megahertz). A unit of frequency equal to one million (1,000,000) cycles per 
second (Hz).

MIB (Management Information Base). The MIB contains all the provisioning 
information for the D50 Multiplexer. (The MIB contains data available to a network 
management program. The network manager queries the MIB.)

MTBF (Mean Time Between Failure). Reliability metric for electronic equipment 
that represents the average amount of time (expected or predicted) between 
breakdowns.

Multi-mode Fiber. Fiber whose core diameter is larger than single mode fiber, which 
allows many modes of light to propagate down the multiple fiber optic paths. Each 
of these paths has a slightly different length, depending upon how often the light 
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bounces off the reflective boundary of the core region. Multi-mode fiber is used for 
short-distance data links.

Multiplexer. Equipment that aggregates two or more channels onto a single 
transmission channel. 

MUX. Abbreviation for Multiplexer.

NE (Network Element). Processor controlled entities of the telecommunications 
network that primarily provide switching and transport network functions and 
contain network operations functions.

NEBS (Network Equipment Building System). NEBS is the Network Equipment 
Building System specification authored by Bellcore. NEBS compliance is required 
by many carrier customers; the D50 shipping today is already NEBS-compliant.

Network Management Processor (NMP) card. The NMP card controls the D50’s 
network management interfaces and provides the protocol support for 
communication for D50 Craft Terminal.

NIC (Network Interface Card). An electronic circuitry board that usually fits into an 
expansion slot of a PC whose purpose is to connect to a Local Area Network. A NIC 
is designed to comply with both a specific LAN Medium Access Control procedure 
(CSMA/CD for Ethernet) and a specific physical medium (e.g. twisted pair wire, 
coax, or multi-mode fiber). Associated with the NIC is a unique address called the 
MAC address. It works with the network software and computer operating system 
to transmit and receive messages on the network.

NID (Network Interface Device). The Nokia Broadband Systems’ NID ADSL 
Splitter divides the ADSL and POTS signals and works in conjunction with the 
router at the subscriber end. The splitter installs on the outside of a home or 
building, and is enclosed in a weatherproof wall mount enclosure. It features 
primary lighting and AC power fault protection, and is a passive device, requiring 
no power or management from the Central Office or subscriber.

NISP (National Internet Service Provider). See ISP (Internet Service Provider).

NNI (Network Node Interface). An Asynchronous Transfer Mode (ATM) interface 
between two public network pieces of equipment (contrast that to UNI, which 
stands for User Network Interface).

Node. Connection point in a network.

Noise. Unwanted electronic signals or disturbance that degrades line performance.

OAM (Operations And Maintenance). A group of network management functions 
that provide network fault indication, performance information, and data diagnosis 
functions.

OC-1 (Optical Carrier Level-1). A SONET line rate of 51.840 Mbps. Direct 
electrical-to-optical mapping of the STS signal with frame synchronous scrambling.

OC-12. SONET channel of 622.08 Mbps.

OC-3 (Optical Carrier Level-3). A SONET line rate of 155.520 Mbps. 3 x OC-1. 
Direct electrical-to-optical mapping of the STS signal with frame synchronous 
scrambling.
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OC3L. A OC3 rate broadband tributary card that provides a standard ATM UNI/NNI 
interface that supports provisionable VPI/VCI mappings to the D50 trunk card, 
allowing ATM cells to be aggregated from standard ATM network equipment.

ODF (Optical Distribution Frame). Connection and distribution point for fiber optic 
cables. It is similar, in function, to an MDF for copper wires.

Optical Cross-Connect Panel. A cross-connect unit used for circuit administration 
and built from modular cabinets. It provides for the connection of individual optical 
fibers with optical fiber patch cords.

Oracle8®. An Object Relational Database Management System developed by Oracle.

ORB (Object Request Broker). An object-oriented system consisting of middleware 
which manages message traffic between application software and 
computer/software platforms.

OSI (Open System Interconnection Reference Model). An internationally accepted 
set of standards for communication between various systems manufactured by 
different vendors. The OSI Reference Model is a seven-layer model developed by 
the ISO (International Standardization Organization) to describe how to connect any 
combination of devices to communicate.

OSS (Operations Support System). A management operations center system which 
supports the daily operation of a telecommunications network.

Packet. A block or group of data organized in such a way as to be treated as a single 
unit within a communication network. It consists of the data (payload) and its 
control information.

Pair Bonding. This SHDSL feature enables the user to bond 2 ports to effectively 
double the maximum single-port bandwidth of 2.3 Mbps to provide up to 4.6 Mbps 
of symmetrical service.

PAM (Pair Analysis Module) card. A Nokia Broadband Systems’ product. The PAM 
card plugs into the LCS backplane just like a line card and is used to test continuity 
of cable pair wiring from the LCS to the MDF. The PAM card is powered by AA 
batteries or -48V Central Office battery. The D50 does not have to be powered up to 
use the PAM card.

Payload. The data being transmitted, less its control and error-correction information.

PCI (Peripheral Component Interconnect). Bus of an Intel PC. PCI transfers data 
between the PC's main microprocessor and peripherals at up to 132 Mbps.

PCR (Peak Cell Rate). Specifies an upper bound on the rate at which traffic can be 
submitted to an ATM connection. Enforcement of this bound allows the network to 
allocate sufficient resources to ensure that the network performance objectives can 
be achieved.

PDF (Portable Document Format). File format of documents that can be viewed with 
Adobe Acrobat® Reader. PDF files are widely used to view files on the Internet.

PDU (Protocol Data Unit). In data communication protocols, a unit of data created by 
a given protocol layer at one place and logically transferred to the same layer at 
another place called a peer. This is the OSI terminology for “packet.”
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PLCP (Physical Layer Convergence Protocol). The part of the physical layer that 
adapts the transmission facility to handle DQDB (Distributed Queue Dual Bus) 
functions as defined in IEEE 802.6-1990.

PM (Performance Monitoring). A data collection and reporting mechanism for 
Quality of Service analysis.

PNNI (Private Network-to-Network Interface). PNNI is a standard of the ATM 
Forum that provides a multilevel hierarchical routing model for scalability in large 
and complex networks using ATM switches from multiple vendors.

POP (Point-of-Presence). The physical place within a LATA (Local Access and 
Transport Area; the long distance carrier’s local office) where the IEC (Inter-
Exchange Carrier) provides services to the LEC (Local Exchange Carrier), and 
perhaps directly to end-users. 

POTS (Plain Old Telephone Service). A term used to describe analog, voice-only 
basic telephone service. All POTS lines work on loop start signaling.

PPP (Point-to-Point Protocol). A layer 2 protocol (relative to the OSI reference 
model) that allows a computer to use TCP/IP with a standard telephone line and a 
high-speed modem.

Profile. A set of pre-defined configuration variables which can be applied to one or 
more objects (of the same type) during the provisioning process. The use of profiles 
decreases configuration time and increases accuracy.

PSD (Power Spectral Density). PSD is the total power in the specified bandwidth 
divided by the specified bandwidth. PSD is measured in watts per hertz.

PSTN (Public Switched Telephone Network). Refers to the worldwide telephone 
system accessible to anyone with a telephone.

PTT (Post Telephone & Telegraph administration). The PTTs, usually controlled by 
their governments, provide telephone and telecommunications services in most 
countries outside of the USA.

PVC (Permanent Virtual Circuit). A permanent association between two DTEs 
(Data Terminal Equipment) established by configuration (established 
administratively via a service order process). A PVC uses a fixed logical channel to 
maintain a connection between the DTEs. After a PVC is defined, it requires no 
setup operation before data is sent and no disconnect operation after. The concept of 
a PVC is included in Networks supporting X.25, Frame Relay and ATM. 

QoS (Quality of Service). In ATM networks, a set of parameters for describing a 
transmission. These parameters include values such as allowable cell loss ratio. The 
parameters apply to virtual channel connections and virtual path connections.

RADSL (Rate Adaptive Digital Subscriber Line). Transmission technology that 
supports both asymmetric and symmetric applications on a single twisted pair 
telephone line. Transmission rates are dynamically adjusted as the performance of 
the loop varies during a session.

RBOC (Regional Bell Operating Company). These are the major local service 
providers in the USA today. In 1984 ATT was broken up into 7 RBOCs. Today, 
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because of mergers, there are 4 RBOCs: BellSouth, Bell Atlantic, SBC 
Communications, and US WEST (recently merged with Qwest Communications).

Redundancy. This refers to various designs that provide a backup system (or part of a 
system) in case of a failure. As an example, the D50 has redundant power input 
terminals so that if one power source fails the backup source can continue to provide 
power to the system.

Reed-Solomon. A coding technique used to handle Forward Error Correction (FEC).

Remote Line Card Shelf (RLCS). An RLCS allows customers served over long loops 
— beyond 5.5 kilometers from the Central Office — access to DSL service. The 
RLCS is located remotely from the Central Office in an outside cabinet and 
connected to the Central Office Master Control Shelf via fiber optic, coax or copper 
cable extensions.

Remote Low Pass Filter (RLPF). The RLPF is a remote passive low pass filter 
“splitter” device. It splits the high frequency ADSL data signal from the voice 
signal at the customer end just like the Low Pass Filter card in the Central Office. 
There are two types of RLPF − a retrofit RLPF available in a standard Network 
Interface Device housing and a stand-alone RLPF.

RFC (Request for Comments). In the Internet community, a series of documents that 
contain protocol and model descriptions, experimental results, and reviews. All 
Internet standard protocols are written up as RFCs.

SCR (Sustainable Cell Rate). An ATM traffic parameter in cells per second that 
characterizes a bursty source and specifies a maximum average rate at which cells 
can be sent over a given ATM virtual connection. 

SDH (Synchronous Digital Hierarchy). SDH is a high-speed, fiber-optic system, 
which provides an interface and mechanism for optical transmission of digital 
information. At the interface, signals are converted from electrical to optical form 
(and back to electrical form at the destination). SDH is an ETSI standard and is used 
in most of the world outside North America, where SONET is used. Transmission 
rates range from 155.520 Mbps to 9.953 Gbps.

SDSL (Symmetric Digital Subscriber Line). Also referred to as Single-Line Digital 
Subscriber Line, SDSL supports symmetrical T1 transmissions. It uses a single 
copper-pair wire and has a maximum operating range of 10,000 feet. It is capable of 
accommodating applications that require identical downstream and upstream 
speeds, such as video conferencing.

Serial Port. A hardware input/output port in which only one pin is available for data 
transmission in a given direction − bits are transmitted in sequence (one bit at a 
time). The wiring for a port is associated with a particular physical interface (i.e., 
RS-232). A serial port is most commonly used for a modem or a mouse.

Service Provider. A service provider is an organization or individual that provides 
telephone access to a network or to another service, such as the Internet.

SHDSL (Single line high bit rate DSL). Nokia octal line card supporting 8 ports of 
symmetric bit-rate transmission using multi-level Trellis Coded Pulse Amplitude 
Modulation (TC PAM).
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Simplex. Simplex communication means that data can only be sent in one direction at a 
time. Also referred to as half-duplex.

Single Mode Fiber. Single mode fiber only provides one path for light pulses to travel 
through the fiber optic cable. There is very little loss of light pulses transmitted on 
single mode fiber. Therefore single mode fiber can be used for much longer 
distances than multi-mode fiber.

Smart Jack. According to the Newton’s Telecom Dictionary, a “Smart Jack” is an 
industry term for a device that tests the integrity of T-1 circuits remotely from the 
central office. Installed on the customer premises in the form of a semi-intelligent 
demarcation point, a Smart Jack is completely passive until activated by code.

SNMP (Simple Network Management Protocol). The network management protocol 
used within TCP/IP-based internets. Defines the protocol for managers (clients) to 
communicate with agents (servers). The agent interfaces directly with the 
networking layers on the monitored network device to obtain the network 
management information. An agent is installed on every network device that will be 
managed or monitored. A client is an application program that is installed at the 
network operations center. It communicates with the SNMP agents to collect 
information in the form of MIB variables. SNMP is a request/reply protocol that 
uses the operations of Set or Get on data items in an agent’s MIB.

SNR (Signal-to-Noise Ratio). In transmission, SNR is the ratio between the signal and 
noise levels at a given point, usually at the receiving end of the transmission. The 
SNR value is generally expressed in decibels (dB). The SNR can be used to 
determine how long a cable segment can be before the signal loss is unacceptably 
high. The SNR also helps determine whether a particular type of cable is 
appropriate for the intended use.

SONET (Synchronous Optical NETwork). SONET is a high-speed, fiber-optic 
system, which provides an interface and mechanism for optical transmission of 
digital information. At the interface, signals are converted from electrical to optical 
form (and back to electrical form at the destination). SONET is an ANSI standard. 
Transmission rates range from 51.84 Mbps to 13.22 Gbps.

Splitter. A device used in DSL to split the incoming bit stream into voice and data.

Subnet. A physically independent network segment. A subnet usually identifies all of 
the nodes in one geographical area or building. Nodes on a subnet can share a single 
network address.

SVC (Switched Virtual Circuit). A virtual connection set up on demand via a signal 
protocol connection, established for a specific communications session and then 
terminated after the session is over. This is in contrast to a permanent virtual circuit 
(PVC), which is a connection that is always established.

T1. DS1 rate electrical signal (two pair). T1 is suited for voice, data and image 
transmissions. T1 has a bandwidth of 1.544 Mbps, which comes from two dozen 64 
Kbps channels, together with one 8 Kbps framing channel.

Tagging. The marking of a non-conforming cell that can be later discarded along its 
route through the ATM network if severe congestion conditions are experienced or 
the cell is still in violation of the traffic contract.
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TCM (Trellis Coding Modulation). A method of forward error correction in which 
each signal element is assigned a value based on phase and amplitude to help the 
receiving modem determine if the element is received in error. Allows the user to 
meet performance margin requirements for long loops, or increase the transmission 
throughput under a specified performance margin; provides increased gain against 
background and crosstalk noise.

TCP/IP (Transmission Control Protocol / Internet Protocol). TCP/IP is a common 
suite of several networking protocols developed for use on the Internet. 

Telnet. Telnet is the terminal-remote host protocol developed for ARPAnet in 1974. On 
the Internet, it is a service program that allows you to connect to other computers at 
another site permitting you to interact with applications as if by a local terminal. 

Threshold. Level or value of a particular signal where an event or alarm will be 
generated.

TMN (Telecommunications Management Network). Reference model for 
telecommunications network management. 

Transmission rates. The speed at which data is transmitted, measured in bits per 
second (bps).

Table 7-2: Transmission Rates

DS level E level OC level STM 
equivalents

Line bit 
rate

DS-0 64 Kbps

DS-1 (T-1) 1.544 Mbps

E-1 2.048 Mbps

DS-2 6.312 Mbps

E-2 8.448 Mbps

E-3 34.368 Mbps

DS-3 (T-3) 44.736 Mbps

OC-1 51.840 Mbps

OC-3 STM-1 155.52 Mbps

OC-9 466.56 Mbps

OC-12 STM-4 622.08 Mbps

OC-18 933.12 Mbps

OC-24 STM-8 1.244 Gbps

OC-36 STM-12 1.866 Gbps

OC-48 STM-16 2.488 Gbps
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� DS. Digital Signal hierarchy: standard signals used in the U.S. telecommunications 
industry.

� E. Standard signals used in the European telecommunications industry.
� OC. Optical Carrier; a SONET optical signal.
� STM. Synchronous Transport Module; depends on information occurring in regular 

and fixed patterns with respect to a reference such as a frame pattern.

Trap. A method used to isolate an abnormal condition or operation.

Trunk. A communication circuit or link that interconnects two entities, usually 
switching systems. 

Trunk Card. An interface card used to connect a D50 multiplexer to the ATM 
backbone facility.

Tunneling. Refers to the encapsulation of a protocol within another protocol format 
that provides a datalink or path. Tunneling can be used as part of a private secure 
network via the Internet. 

Twisted Pair. The term used to describe common copper telephone wire. The two 
wires are called Tip and Ring. Also called Unshielded Twisted Pair (UTP).

UBR (Unspecified Bit Rate). In ATM networks, a UBR connection transmits at 
variable rates. With UBR, specific bandwidth allocation is not guaranteed.

UBR+. Unspecified Bit Rate with minimum cell rate guarantee that allows a 
connection to burst up to peak cell rate.

UNI (User Network Interface). In ATM networks, one of three levels of interface.   A 
UNI specification which defines Layer 1 and Layer 2 protocols required for CPE 
and carrier equipment to interoperate. UNI specifications provide physical media 
and line rate implementation options.

UNIX. A multi-task, multi-user operating system developed by Ken Thompson of 
AT&T Bell Labs. UNIX is a registered trademark of Santa Cruz Operations.

UPC. The traffic control entity that monitors and enforces a virtual circuit’s 
conformance with the source’s traffic contract and parameters. 

Upstream. Description of the communications path coming from the client/end user to 
the CO or DSLAM.

USB (Universal Serial Bus). The Universal Serial Bus is used in newer PCs. The bus 
is 12 Mbps and designed to be “plug and play.” It supports multiple PC peripherals, 
including Nokia D50-compatible CPE with USB.

OC-96 4.976 Gbps

OC-192 9.953 Gbps

Table 7-2: Transmission Rates (continued)

DS level E level OC level STM 
equivalents

Line bit 
rate
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VBR (Variable Bit Rate). In ATM networks, a VBR connection transmits in bursts, at 
variable speeds.

VC Topology. Used in the Nokia D50’s Craft Terminal software to set the direction and 
mode of communication for duplex, simplex egress, and simplex ingress PVC 
connections.

VCI (Virtual Channel Identifier). An identifier (value) in an ATM cell that identifies 
the data of one Virtual Channel connection from the data of another connection.

VDSL (Very-high-speed Digital Subscriber Line). VDSL provides DSL service at a 
data rate in excess of 10 Mbps (up to 52 Mbps). VDSL has a maximum operating 
range from 1,000 feet to 4,500 feet on 24-gauge wire.

VF. Voice Frequency – In telephony, the usable voice-frequency band ranges from 
approximately 300 Hz to 3400 Hz. Also, the bandwidth allocated for a single voice-
frequency transmission channel is usually 4 kHz. 

VoDSL (Voice over Digital Subscriber Line). An end-to-end voice transport 
technique integrating voice and data over DSL using special gateways that are 
designed to connect packetized voice traffic to Class 5 circuit switches. 

VoIP (Voice over Internet Protocol). A technique for transmitting voice information 
in digital form in packets rather than the circuit-switch protocol of the public 
switched telephone network.

VPI (Virtual Path Identifier). An identifier (value) in an ATM cell that identifies the 
data of one Virtual Path connection from the data of another connection. 

WAN (Wide Area Network). A WAN is a network of computers and related 
communications equipment whose elements may be in dispersed sites with 
distances great enough to require common carrier provided communication lines.

xDSL (all forms of Digital Subscriber Lines). The “x” represents the various types of 
digital subscriber lines: ADSL, RADSL, SDSL, HDSL, SHDSL, IDSL, or VDSL.
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